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技术许可 
本文档中描述的硬件和 / 或软件仅在得
到许可的情况下提供并且只能根据此类
许可的条款进行使用或复制。

美国政府权利

本软件属于联邦采购法规（“ FAR ”）
2.101 定义的“商用计算机软件”。按
照 FAR 12.212 和 27.405-3 以及国防部 FAR 
补充条款（“ DFARS ”） 227.7202 ，美
国政府根据按惯例向公众提供商用计算
机软件的相同条款采购本软件。相应 
地，是德科技依据其最终用户许可协议 
(EULA) 中所述的标准商业使用许可向美
国政府客户提供本软件，您可以从以下
网址获取该许可协议的副本： 
http://www.keysight.com/find/sweula 。

EULA 中所述的许可表示美国政府使用、
修改、分发或披露本软件所具有的专属
权利。除了其他事项之外， EULA 及其
所述的许可证不要求或不允许是德科 
技： (1) 提供按惯例并未向公众提供的
与商业计算机软件或商业计算机软件文
档相关的技术信息；或 (2) 超出按惯例
向公众提供的使用、修改、复制、发 
布、执行、显示或披露商业计算机软件
或商业计算机软件文档的权利，向政府
让与或以任何其他方式向政府提供额外
权利。超出 EULA 规定范围的任何其他
政府要求均不适用，除非 FAR 和 DFARS 
明确要求所有商业计算机软件提供商都
必须使用这些条款、权利或使用许可，
而且 EULA 的其他地方以书面形式具体
规定了这些条款、权利或使用许可。是
德科技对更新、修订或以任何其他方式
修改本软件不承担任何责任。对于 FAR 
第 2.101 条定义的任何技术数据，根据 
FAR 第 12.211 条和第 27.404.2 条以及 
DFARS 第 227.7102 条的规定，美国政府
所获得的权利不会超出 FAR 第 27.401 条
或 DFAR 第 227.7103-5 (c) 条所定义的适
用于任何技术数据的“有限权利”。

担保说明

本文档中包含的材料“按原样”提供，
在以后的版本中如有更改，恕不另行通
知。此外，在适用法律允许的最大范围
内，是德科技不承诺与本手册及其包含
的任何信息相关的任何明示或暗示的保
证，包括但不限于对适销性和特定用途
适用性的暗示担保。对于因提供、使用
或运用本文档或其包含的任何信息所导
致的错误或者意外或必然损害，是德科
技概不负责。如果是德科技和用户另有
书面协议，并且其中的某些保修条款涉
及了本文档中与这些条款冲突的资料，
则以此协议中的担保条款为准。

开放软件许可证 
本产品中的部分软件依据《通用公用许
可证版本 2 》（ “GPLv2” ）条款许可。 
您可在以下网址中找到许可文本和源 
代码：

www.keysight.com/find/GPLV2

符合性声明

可以从 Web 上下载本产品以及其他是
德科技产品的合规性声明。有关详细信
息，请访问 http://www.keysight.com/go/
conformity 。然后，可以按产品编号进
行搜索，以找到最新的合规性声明。

最新信息

要获得最新的固件 / 软件 / 电子版手册 /
规范 /支持信息，请转至 www.keysight.com 
并在页面顶部的“搜索”字段中输入产
品编号。

http://www.keysight.com/go/conformity
http://www.keysight.com/go/conformity




符合德国噪声要求

特此声明，此产品符合德国机械噪声规定声明 
(Lärmangabe nach der Maschinenlärminformation-Verordnung -3.GSGV Deutschland)。

• Herstellerbescheinigung

GERÄUSCHEMISSION

Lpa < 70 dB

am Arbeitsplatz

normaler Betrieb

nach DIN 45635 T. 19

• 制造商声明

声学噪声排放

Lpa < 70dB

操作员位置

正常操作

符合 ISO 7779

韩国 EMC 声明

用户须知信息：

本设备已经过合规性评估，可在商业环境下使用。在居住环境下，本设备可能会
引起无线电干扰。 

(*) 本 EMC 声明仅适用于在商业环境下使用的该设备。

(*)



安全信息概述

在本仪器的操作、服务和维修的各个阶段中，必须遵循下面的常规安全预防措
施。如果不遵守这些注意事项或本手册中其他地方出现的特定警告，可能会削弱
本仪器所提供的保护。此外，还会违反仪器的设计标准、制造和用途。是德科技
对因用户不遵守这些规定而导致的故障不承担任何责任。

也可以在 Web 上找到产品手册。转至 www.keysight.com 并在页面顶部的 “搜索”
字段中输入产品型号。许多产品都有以 CD-ROM 或印刷形式提供的手册。

请严格按照制造商规定的方法使用本仪器。如果没有按照操作说明的规定使用本
仪器，则会削弱仪器的保护功能。

本仪器只能在室内使用。

本仪器符合 IEC 61010-1 中定义的针对电源输入的“过压类别 II”以及“污染度 2”。

如果仪器带有标记 CAT I （IEC 测量类别 I），或没有测量类别标记，则不能将其测
量端子连接到线路电压电源。

系统组装者应对设备中组装的任何系统的安全性负责。

如果 Interlock 端子闭合， High Force、 Guard 和 High Sense 端子上可能存在最
高为仪器最大电压的危险电压。在接触 High Force、 Guard 和 High Sense 端子
时，请断开 Interlock 端子。施加于端子的电压上限值为 ±42 V。

请勿为了使输出电压达到安全水平而故意使用联锁功能。高电压指示灯亮起时，
测量端子上会出现由输出电压或残余电荷导致的危险电压。

• 危险步骤警告

应遵守所有警告内容，如前一页的 “警告”部分。按照本手册中的步骤操作
可避免发生危险。必须遵守警告中所含的说明。

• 通电前

验证是否采取了所有安全预防措施。在应用电源之前进行仪器的所有连接。
请留意在 “安全符号”下面介绍的仪器外部标识。

• 仪器接地

这是安全等级 I 仪器。为了避免发生电击危险，必须将仪器机箱和机柜接地。
电源端子和电源线必须符合国际电工委员会 (IEC) 安全标准。

http://www.keysight.com


• 请勿在爆燃性空气中进行操作

请勿在存在易燃气体或烟雾的环境中操作仪器。在这种环境中操作任何电气
仪器都会造成安全隐患。

• 切勿卸下外壳

分析仪内部没有操作人员可以进行维修的部件。请求助合格的维修人员进行
修理。为防止电击，请勿卸下盖板。

• 如果发生损坏

仪器一旦出现损坏或故障迹象，应立即停止操作并防止意外操作，等待合格
的维修人员进行修理。请将仪器退还至是德科技销售与维修处进行维修，以
确保安全功能部件得到维护。

• 请仅使用特定配件

特定附件满足使用仪器所要求的具体特性。为确保安全，请使用特定的附件、
电缆、适配器等。



安全标志

下面列出了在设备或手册中使用的安全标志的一般定义。

直流电。

交流电。

接地端子。

保护导体端子。防止在出现故障时发生电击。与现场布线端子一起使用，表示 
在操作设备之前必须接地的端子。

框架或机箱端子。与设备的框架 （机箱）的连接，通常包括所有裸露的金属 
结构。

接地端子表示地电势。

电源打开。

电源关闭。

待机电源。带有此标志的设备的电源开关处于待机位置时，表示没有完全从 AC 
电源断开。

双稳态按钮开关开启。

双稳态按钮开关关闭。

危险电压并存在电击危险。在设备电源打开时，不要接触带有此符号的端子。 

高温表面。避免接触。表面温度较高，接触表面可能会造成人身伤害。

小心，请参阅随附的文档。如有必要，会用该符号标记设备，以便于用户参考说
明手册。

请阅读操作员手册。表示在继续操作之前应阅读操作员手册或卡片。 

IEC 测量类别 I

CE 标记表示产品符合所有适用的欧洲规定。 

CSA 标记是加拿大标准协会的注册商标。 

RCM 标记是澳大利亚通讯局的注册商标。它表示符合根据 《无线通信法案》的条
款制订的 Australian EMC Framework 规定。

CAT I



本 ISM 设备符合加拿大的 ICES-001 标准。
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

本 ISM 设备符合加拿大的 ICES-001 A Class A 标准。
Cet appareil ISM est conforme à la norme NMB-001 classe A du Canada.

这是工业、科研和医疗， 1 组 A 级产品的标志。 (CISPR 11)

韩国安全声明和 EMC 标志

中国 RoHS - 环保产品标签

中国 RoHS - 含有有毒物质的产品 40 yr EPUP

纸质包装材料的中文标记；纸板和瓦楞纸板

塑料材料编码标识

“警告 ”声明表示存在危险。它提醒用户注意某一操作过程、操作方法或类似情
况。如果不能正确执行或遵守规则，可能会造成人身伤害或死亡。在没有完全理
解指定的条件且不满足这些条件的情况下，请勿继续执行 “警告 ”声明没有指示
的任何不当操作。

“小心 ”声明表示存在危险。它提醒用户注意某一操作过程、操作方法或类似情
况。如果不能正确执行或遵守规则，可能会对产品造成损坏或丢失重要数据。在
没有完全理解指定的条件且不满足这些条件的情况下，请勿继续执行 “小心 ”声
明没有指示的任何不当操作。

 



电源和测量安全

• 电源安全

此仪器可输出高电流和电压。请确保待测试的负载或设备能够安全地处理此
输出电流和电压。此外，请确保连接导线能够安全地承受预期的电流，且在
预期的电压下保持绝缘。

仪器输出的连接相对于接地浮动。绝缘或浮动电压额定值标在仪器上的输出
端子或机箱接地端子附近。触摸浮动的测量端子有触电的危险。请牢记这一
点以确保自己安全。这是使用推荐配件的原因之一。

• 电压 / 电流测量安全

能够测量高电压和电流的万用表和其他仪器应符合它们可能连接的电路的特
定安全规定。要安全地使用这些仪器，您需要了解仪器输入端子附近的标记，
包括保护限值和 IEC 测量类别。

• 保护限值

Keysight 万用表和其他电压测量仪器提供了电路保护功能，只要不超过保护限
值，即可防止仪器损坏和电击危险。要确保对仪器进行安全操作，请不要超
过输入端子上显示的保护限值。



• 源 / 测量端子

源 / 测量单元 （简称 SMU）可同时执行直流电压或电流输出和测量。典型的 
SMU 具有 Force、Sense 和 Guard 端子，如下所示。通常，Force、Sense 和 Guard 
具有相同的电势。端子旁边标记的电压表示保护限值。

Force 和 Sense 端子必须连接到被测设备 (DUT) 的端子以实现四线制连接
（Kelvin 连接），使用该连接可有效地进行高电流测量和低电阻测量。要进行
二线制连接的简单连接，只需连接 Force 端子。请勿连接 Sense 端子。它必须
是断开的。

Guard 端子应连接到保护屏蔽，它覆盖 DUT 高端接线，可减少由于线路造成的
泄漏电流。否则， Guard 必须是断开的。

机箱接地线 （绿色端子）必须连接到接地屏蔽，它覆盖 DUT，包括保护屏
蔽，以降低噪声影响。否则，机箱接地线必须是断开的。

下图是 Keysight B2900 的源和测量端子。对于 B2900，High Force、High Sense 和 
Guard 具有相同的电势。 Low Force 和 Low Sense 具有相同的电势。

High Sense

High Force

Low Force

Low Sense



高电压电击危险

Keysight B2900 可在 High Force、 Guard 和 High Sense 端子上强制产生危险电压 
(±210 V)。为了防止发生电击危险，在使用 Keysight B2900 期间必须遵守以下安全
预防措施。

• 使用三芯交流电源线连接到器具耦合器 （接入口），并将仪器连接到电气接
地线 （安全接地线）。

• 准备一个屏蔽盒，其中有连接到被测设备的接口，并配备有联锁电路，当仪
器门打开时，该电路将断开。

• 在执行测量之前，将联锁电路连接到本仪器的 Interlock 端子。

• 定期检查以确认联锁功能可正常运行。

• 在接触 High Force、 Guard 和 High Sense 端子的连接之前，请关闭仪器电源，对
测量路径的任何电容器放电。如果没有关闭仪器电源，不管仪器的任何设置
如何，请完成下列所有项目。

• 按 On/Off 开关终止源输出，确认 On/Off 开关已关闭。

• 确认 HV （高电压）状态指示灯没有点亮。

• 打开屏蔽盒检修门 （断开 Interlock 端子）。

• 如果电容连接到此仪器，则对任何电容器放电。

• 警告仪器附近的工人可能存在危险状态。



Gefahr durch Hochspannung

Von den Geräten Keysight B2900 können Spannungen an den Anschlüssen “High Force”, 
“Guard” und “High Sense” von bis zu 210 V ausgehen. Um elektrischem Schlag vorzubeugen, ist 
bei der Benützung der Geräte Keysight B2900 folgendes zu beachten.

• Verwenden Sie ein dreiphasiges AC-Stromkabel für die Gerätsteckvorrichtung (Eingang) 
und schließen Sie das Instrument an eine Erdung an (Sicherheitserdung).

• Bereiten Sie das Abschirmungsgehäuse vor, dass die Oberfläche eines zu testenden Geräts 
abdeckt und mit einem Verriegelungsstromkreis ausgestattet ist, der bei geöffneter Tür 
unterbrochen wird.

• Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem Interlock-Anschluss 
dieses Instruments.

• Prüfen Sie in regelmäßigen Abständen, dass die Verriegelungsfunktion ordnungsgemäß 
funktioniert.

• Bevor Sie die Verbindungen zu den Anschlüssen “High Force”, “Guard” und “High Sense” 
berühren, schalten Sie das Instrument aus und entladen alle Kondensatoren des Messwegs. 
Wenn Sie das Instrument nicht ausschalten, führen Sie, unabhängig von den 
Instrumenteinstellungen, alle folgenden Schritte durch.

• Beenden Sie die Messung, indem Sie auf die Taste “On/Off” drücken.Stellen Sie sicher, 
dass die Statusanzeige “On/Off” nicht leuchtet.

• Stellen Sie sicher, dass die Anzeige “HV” nicht leuchtet.

• Öffnen Sie die Tür des Abschirmungsgehäuses (öffnen des Interlock-Anschlusses).

• Entladen Sie alle Kondensatoren, wenn die Kapazität mit das Instrument verbunden ist.

• Warnen Sie Mitarbeiter in der Umgebung des Instruments vor den Gefahren.



Danger de choc dû à une haute tension

Une tension dangereuse  (max. ± pour; 210 Vdc) émanant du dispositif Keysight B2900 peut 
être sortie aux bornes High Force, Guard et High Sense, d'appareil de protection ou de 
détection. Les précautions suivantes doivent être obserées contre commotion électrique 
accidentelle.

• Utilisez un câble d’alimentation CA à trois conducteurs vers le coupleur secteur (entrée) et 
branchez l’instrument sur une mise électrique à la terre (prise de terre de sécurité).

• Préparez le boîtier de protection qui couvre l’interface avec le dispositif à tester et 
équipez-le d’un circuit de sécurité qui s’ouvre lors de l’ouverture d’une porte.

• Avant de procéder aux mesures, connectez le circuit de sécurité à la borne Interlock de 
l’instrument. 

• Vérifiez régulièrement le bon fonctionnement de la fonction de sécurité.

• Avant de toucher les connexions des bornes High Force, Guard et High Sense, mettez 
l’instrument hors tension et déchargez tout condensateur du chemin de mesure.Si vous ne 
mettez pas l’instrument hors tension, effectuez « toutes » les opérations ci-dessous, quels 
que soient les paramètres de l’instrument.

• Terminez les mesures en appuyant sur la touche On/Off ; vérifiez que l’indicateur d’état 
On/Off est éteint.

• Vérifiez que le témoin HV est éteint.

• Ouvrez la trappe d’accès au boîtier de protection (ouvrez la borne Interlock).

• Déchargez les éventuels condensateurs si la capacité est connectée à l’instrument. 

• Informez les personnes travaillant à proximité de l’instrument des conditions.



高電圧感電注意

Keysight B2900 の High Force、Guard、High Sense 端子には、危険電圧が出力される
ことがあります（最大 ±210 Vdc）。感電事故防止のため、必ず以下の事柄を
守ってください。

• 3 極電源ケーブルを使用して本器を接地してください。

• ドアを開くことによって開放されるインターロック回路を装備し、被測定
デバイスとのインタフェースを覆うことのできるシールド・ボックスを用
意してください。

• 測定を開始する前にはインターロック回路を本器の Interlock 端子に接続して
ください。

• インターロック機能が正常であることを定期的に確認してください。

• High Force、Guard、High Sense 端子に繋がる接続部に触れる前には、本器の電
源を切断してください。また、測定系のキャパシタを放電してください。
電源を切らない場合は、以下の事項を全て実施してください。

• On/Off スイッチを押して On/Off スイッチが消灯したことを確認してくだ 
さい。

• 高電圧警告インジケータ（HV）が消灯していることを確認してくださ
い。

• シールド・ボックスのドアを開けてください（Interlock 端子を開放して
ください）。

• 本器にキャパシタが接続されているならば、キャパシタを放電してくだ
さい。

• 周囲のほかの作業者に対しても、高電圧危険に対する注意を徹底してくだ
さい。



产品管理

• 废弃电子电气设备 (WEEE) 指令 2002/96/EC

此产品符合 WEEE 指令 (2002/96/EC) 标记要求。此附加标签说明不得将此电气 /
电子产品丢弃在家庭垃圾中。 

产品类别：根据 WEEE 指令附件 1 中说明的设备类型，将此产品归为“监测和
控制仪器”产品类别。 

请勿作为家庭废弃物处理。 

要退回不再需要的产品，请与您当地的 Keysight 办事处联系，或访问以下网站
以获得更多信息。

http://about.keysight.com/en/companyinfo/environment/

• LCD 荧光灯

Keysight 销售的某些产品包含液晶显示器 (LCD) ； LCD 的背光由含汞的荧光灯
提供，必须按照所有适用法律、法令和规定对荧光灯进行管理、回收利用和 /
或处置。 

有关如何回收利用或处置您产品中包含的荧光灯的信息，请访问以下网站。

http://about.keysight.com/en/quality/env_compliance.shtml

如果您在美国，也可访问以下网站。

http://www.lamprecycle.org

http://www.eiae.org

如果您有其他问题，请访问以下网站。

http://www.keysight.com/go/contactus

• 高氯酸盐信息

高氯酸盐物质 - 应进行特殊处理。请访问以下网站。

http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

仪器的实时时钟电池或纽扣电池可能包含高氯酸盐，在加利福尼亚州进行回
收利用或处置时，可能需要进行特殊处理。

http://about.keysight.com/en/companyinfo/environment/


本手册内容 

本手册介绍 Keysight Technologies B2900 精密源 / 测量单元 （简称 SMU）的前面板
操作、安装和功能。本手册包含以下章节。

1. “入门指南”

本章简要介绍 Keysight B2900 的前面板操作。

2. “简介”

本章介绍 Keysight B2900 的概述、附件和选件。

3. “安装”

本章介绍如何安装 Keysight B2900，以及如何将被测设备连接到测试夹具。

4. “前面板参考”

本章提供 Keysight B2900 前面板键和图形用户界面的参考信息。

5. “前面板操作”

本章介绍如何在本地模式下使用 Keysight B2900。

6. “功能详细信息”

本章介绍 Keysight B2900 的多种功能和初始设置。

有关 B2900 的规格，请参见数据表。

要获取最新的数据表，请访问 www.keysight.com/find/b2900 并单击 “技术支持”和
“规格”。

这些信息可能会因未来的改进而变更，恕不另行通知。 

B2900 上的实际屏幕图像可能与本手册中的有所不同。
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本章介绍了 Keysight B2900 的基本操作。在了解 B2900 的详细信息之前，我们
先简要介绍 B2900 源 / 测量单元的使用。这些操作只需要使用 B2900 和电源线。
要开始操作，请打开测量端子。

打开 B2900 电源

1. 将电源线从 B2900 后面板的 AC 输入连接器 （插座）连接到现场的 AC 电源
插座。

2. 按前面板上的待机开关 。接通电源后，开关下方的 LED 指示灯会变为 
绿色。 

B2900 将启动并执行自检。在 B2900 正常启动后，前面板 LCD 将显示以下视
图。这是单通道型号的单视图以及双通道型号的双视图。

D Dual 1 Single 
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连接 DUT

如果您要连接被测设备，请参阅第 80 页上的 “连接 DUT”。
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应用 DC 输出

B2900 可用作 DC 电压源或电流源。以下过程可将 B2900 配置为电压源，并施加 
+500 mV 的电压。

步骤 1. 设置源模式 （电压输出）

1. 按单通道型号上的 Mode 辅助键或双通道型号上的 Ch1 Mode 辅助键。

字段指针将显示在 Source 模式上，并且状态变为 EDIT （绿色）。状态信息将
显示 。

2. 按 VOLTS (V) 辅助键，或使用旋钮或箭头键  和  来指定模式，
然后按下此旋钮以固定该设置。

状态变为 MOVE （蓝色）。状态信息将显示 。

步骤 2. 设置 Source 值 （电压输出值）

1. 按单通道型号上的 Source 辅助键或双通道型号上的 Ch1 Source 辅助键。
或使用旋钮或箭头键将字段指针移到 Source 值上，然后按此旋钮。字段指针
将显示在 Source 值上，并且状态变为 EDIT （绿色）。

2. 顺时针旋转旋钮以增大该值，或逆时针旋转旋钮以减小该值。设置所需的值。 

在按箭头键时，数字指针将出现在某个数字上。旋转旋钮以更改数字的值；
如果指针在小数点上，则可移动该小数点。 

3. 按下旋钮以固定该值。状态变为 MOVE （蓝色）。

也可以使用数字 / 字母键和单位辅助键来设置 Source 值，这与下一步显示的 
Limit 值的设置方式相同。
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此示例将 Source 值设置为 +500 mV。

步骤 3. 设置 Limit 值 （一致电流）

1. 按单通道型号上的 Limit 辅助键或双通道型号上的 Ch1 Limit 辅助键。或使
用旋钮或箭头键将字段指针移到 Limit 值上，然后按此旋钮。字段指针将显示
在 Limit 值上，并且状态变为 EDIT （绿色）。

 

2. 使用旋钮、箭头键或数字 / 字母键设置该值。

3. 按单位辅助键之一设置单位并固定该值。状态变为 
MOVE （蓝色）。

此示例将 Limit 值设置为 1 mA。

步骤 4. 启用通道

按 Ch 1  开关以启用通道 1。这将使开关变为绿色。通道 1 开始施加由 
Source 值指定的电压。

步骤 5. 禁用通道

按 Ch 1  开关可禁用通道 1。这会关闭开关灯。
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执行单点测量

B2900 可用作 DC 电压和电流表。以下步骤执行一个点电流测量。

步骤 1. 设置测量模式 （电流测量）

按单通道型号上的 Measure 辅助键或双通道型号上的 Ch1 Measure 辅助键。然
后按 AMPS (I) 辅助键。

也可以使用旋钮和箭头键来设置测量模式，其方式与 “应用 DC 输出”中用于设
置 Source 模式的方式相同。

步骤 2. 启用通道

按 Ch 1  开关以启用通道 1。这将使开关变为绿色。通道 1 开始施加由 
Source 值指定的电压。

步骤 3. 启动测量

• 按  键开始单次 （一次）测量。执行单点测量一次。

• 按  键可开始重复 （连续）测量。重复执行单点测量。

测量结果显示在 LCD 的左侧部分。 

以下示例显示了通道 1 的 High Force 和 Low Force 端子之间连接的 1 k 电阻器
的测量结果。

步骤 4. 禁用通道

按 Ch 1  开关可禁用通道 1。这会关闭开关灯。
Keysight B2900B/BL 系列用户指南，第 2 版 29
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执行扫描测量

B2900 支持扫描测量。以下示例将施加阶梯扫描电压并测量每个步进电压处的 
电流。

步骤 1. 按  键以显示 Single 视图。

步骤 2. 设置 Source 模式、 Limit 值和测量模式，如“应用 DC 输出”和“执行单点测
量”中所示。

此示例将设置电压输出、 10 mA 限值以及电流和电压测量。

步骤 3. 设置扫描参数

1. 按 More 辅助键，更改辅助键。

2. 按 Show Sweep 辅助键，显示 Sweep 设置参数。

3. 按旋钮，使状态变为 EDIT （绿色）。

4. 按 LINEAR SINGLE 辅助键，设置线性单次扫描模式。 

源形状指示符显示阶梯图标，并且状态变为 MOVE （蓝色）。
30 Keysight B2900B/BL 系列用户指南，第 2 版
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执行扫描测量
5. 使用旋钮、箭头键或数字 / 字母键以设置 Start （扫描开始值）、 Stop （扫描
停止值）和 Step （扫描步进值）或 Points （扫描步进数）。

此示例将 Start 设置为 1 V，将 Stop 设置为 2 V，将 Points 设置为 11。

步骤 4. 按  键可显示 Graph 视图。

步骤 5. 启用通道

按 Ch 1  开关以启用通道 1。这将使开关变为绿色。通道 1 开始施加由 
Source 值指定的电压。

步骤 6. 按  键开始单次 （一次）测量。执行扫描测量一次。测量结果将显示在
图形上。 

步骤 7. 按 Auto Scale 辅助键，使迹线适应图形比例。

以下示例显示了通道 1 的 High Force 和 Low Force 端子之间连接的 1 k 电阻器
的测量结果。

步骤 8. 禁用通道

按 Ch 1  开关可禁用通道 1。这会关闭开关灯。

G: Graph View
Keysight B2900B/BL 系列用户指南，第 2 版 31



入门指南
操作提示
操作提示

本节介绍有关 B2900 的键操作和状态信息。

• “更改 View 模式”

• “编辑设置”

• “状态信息”

图 1-1 更改 View 模式

有关 View 模式的详细信息，请参阅第 107 页上的 “显示屏和辅助键”。
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图 1-2 编辑设置

有关前面板键的详细信息，请参阅第 104 页上的 “硬键和旋钮”。

如果在 Source 字段或 Limit （合规性）字段中，字段指针处于 EDIT （绿色）状
态，转动旋钮可实时更改源通道的设置值。

图 1-3 状态信息

有关状态信息的详细信息，请参阅第 125 页上的 “状态信息”。

1 2

34

MOVE EDIT 

1
MOVE 

2
EDIT 

3 4

/

LXI LAN 
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操作摘要

本节概要介绍了 B2900 的前面板操作。

• “基本操作”

• “通道设置”

• “源设置”

• “测量设置”

• “显示设置”

• “文件操作”

• “其他功能”

• “界面设置”

• “系统设置和操作”

有关前面板操作的详细信息，请参见第 4 章，“前面板参考”。
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操作摘要
表 1-1 基本操作

表 1-2 通道设置

任务 相关前面板键

打开 / 关闭 B2900 待机开关

更改显示模式 View 键

启用 / 禁用指定的通道 Ch 1 On/Off 开关或 Ch 2 On/Off 开关

取消上一个设置操作 Cancel/Local 键

返回功能键或软键的上一级菜单 Cancel/Local 键

从远程状态返回本地状态 Cancel/Local 键

启动单次 （一次）输出 / 测量 Trigger 键

启动重复 （连续）测量 Auto 键

移动字段指针 旋钮或箭头键

移动数字指针 旋钮或箭头键

切换 EDIT/MOVE 状态 设置字段中的旋钮

选择设置值 辅助键、旋钮或箭头键

保存 / 调用 B2900 的所有设置信息 Config > Save 或 Recall 功能键

任务 相关前面板键

启用 / 禁用指定的通道 Ch 1 On/Off 开关或 Ch 2 On/Off 开关

选择感测类型：2 线或 4 线 Config > Source > Connection 功能键

选择低端子状态；接地或浮动 Config > Source > Connection 功能键

启用 / 禁用高电容模式 Config > Source > Connection 功能键

启用 / 禁用过电压 / 电流保护 Config > Source > Connection 功能键

启用 / 禁用电阻补偿 Config > Measure > R Compen 功能键

启用 / 禁用 2 通道同步操作 Config > Common > Group 功能键
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表 1-3 源设置

表 1-4 测量设置

任务 相关前面板键

启用 / 禁用源输出 Ch 1 On/Off 开关或 Ch 2 On/Off 开关

选择源输出模式 Mode、 Ch1 Mode 或 Ch2 Mode 辅助键

设置源输出值 Source、 Ch1 Source 或 Ch2 Source 辅助键

设置限值 / 合规性值 Limit、 Ch1 Limit 或 Ch2 Limit 辅助键

设置恒定源量程调整模式 Speed 辅助键或 Single 视图中的 Hide Sweep/Pulse/Trigger 
辅助键

设置扫描源 Single 视图中的 Show Sweep 辅助键

设置列表扫描源 LIST 扫描 Start/Stop/Points 字段的 EDIT 状态中的 Edit 
辅助键

设置扫描源量程调整模式 Config > Source > Sweep 功能键

设置扫描方向 Config > Source > Sweep 功能键

设置扫描后的源输出值 Config > Source > Sweep 功能键

设置脉冲源 Single 视图中的 Show Pulse 辅助键

设置源等待时间 Config > Common > Wait 功能键

设置输出滤波器 Config > Source > Filter 功能键

设置输出关闭状态 Config > Source > Connection 功能键

启用 / 禁用自动输出开 Config > Source > Connection 功能键

启用 / 禁用自动输出关 Config > Source > Connection 功能键

任务 相关前面板键

启用 / 禁用指定的通道 Ch 1 On/Off 开关或 Ch 2 On/Off 开关

选择测量模式 Measure、 Ch1 Measure 或 Ch2 Measure 辅助键
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表 1-5 显示设置

表 1-6 文件操作

设置测量速度 Single 视图中的 Speed 辅助键

设置测量范围模式 Speed 辅助键或 Single 视图中的 Hide Sweep/Pulse/Trigger 辅
助键

定义自动范围操作 Config > Measure > Ranging 功能键

设置测量等待时间 Config > Common > Wait 功能键

任务 相关前面板键

更改显示模式 View 键

更改颜色设置 Display > Color 功能键

启用放大 Display > Zoom > ON 功能键

禁用放大 放大显示状态的 Zoom Out 辅助键

更改数据位 Display > Digits 功能键

启用 / 禁用远程条件中的前面板显示 Display > Remote 功能键

任务 相关前面板键

将测量结果数据保存到 USB 存储器 File > Save > Measure 功能键

将数学运算结果数据保存到 USB 存储器 File > Save > Math 功能键

将限值测试结果数据保存到 USB 存储器 File > Save > Limit Test 功能键

将迹线缓冲区数据保存到 USB 存储器 File > Save > Trace 功能键

将系统设置数据保存到 USB 存储器 File > Save > Config 功能键

将图形屏幕转储保存到 USB 存储器 Graph 或 Roll 视图中的 Dump Screen 辅助键

任务 相关前面板键
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表 1-7 其他功能

从 USB 存储器加载系统设置数据 File > Load > Config 功能键

从 USB 存储器加载列表扫描数据 LIST 扫描 Start/Stop/Points 字段的 EDIT 状态中的 
Load 辅助键

任务 相关前面板键

启用 / 禁用 Limit (Compliance) for Each 
Polarity

Display > Pref. 功能键

使用数字指针和旋钮启用 / 禁用 
Source/Limit 实时更新

Display > Pref. 功能键

查看测量结果 Result > Measure 功能键

使用数学表达式 Function > Math 功能键

查看数学运算结果 Result > Measure 功能键

设置限值测试 Function > Limit Test 功能键

查看限值测试结果 Result > Limit Test 功能键

设置迹线缓冲区 Function > Trace 功能键

查看迹线统计结果 Result > Trace 功能键

选择程序存储器 Program > Catalog 功能键

控制程序存储器 Program > Control 功能键

轻松设置触发参数 Single 视图中的 Show Trigger 辅助键

设置详细触发参数 Function > Trigger > Config 功能键

控制触发系统 Function > Trigger > Initiate/Abort/Immediate 功能键

任务 相关前面板键
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表 1-8 界面设置

表 1-9 系统设置和操作

任务 相关前面板键

指定测量数据元素 I/O > Format > Measure 功能键

指定数学和限值测试数据元素 I/O > Format > Math/Limit 功能键

指定迹线统计数据元素 I/O > Format > Trace 功能键

选择数据输出格式 I/O > Format > Data Type 功能键

启用 / 禁用二进制数据的字节交换 I/O > Format > Data Swap 功能键

设置 LAN 配置 I/O > LAN > Config 功能键

查看 LAN 接口状态 I/O > LAN > Status 功能键

重置所有 LAN 连接 I/O > LAN > Reset 功能键

将 LAN 设置设置为默认设置 I/O > LAN > Default 功能键

启用 / 禁用用于 Easy File Access 的媒体传

输协议

I/O > USB 功能键

查看 USB 接口状态 I/O > USB 功能键

设置 GPIB 地址 I/O > GPIB 功能键

查看 GPIB 接口的状态 I/O > GPIB 功能键

设置 Digital I/O 的配置 I/O > DIO > Config 功能键

读取 / 将值设置写入 Digital I/O I/O > DIO > R/W 功能键

任务 相关前面板键

设置电源线频率 System > PLC 功能键

恢复出厂状态 System > More > Factory 功能键

应用初始设置 System > Reset 功能键
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执行自我校准 System > Cal/Test > Self-Cal 功能键

执行自检 System > Cal/Test > Self-Test 功能键

检查错误 System > Error > Log 功能键

清除错误日志 System > Error > Clear 功能键

清除时间戳 System > Timestamp > Clear 功能键

设置时间戳的自动清除 System > Timestamp > Auto CLR 功能键

设置启动操作 System > More > Start-up 功能键

启用 / 禁用蜂鸣声和声音 System > More > Sound 功能键

选择远程控制命令集 System > More > Language 功能键

启用 / 禁用恢复本地状态的触发模式

设置的功能

Display > Pref. 功能键

设置日期和时间 System > More > Info. > Date/Time 功能键

执行固件更新 System > More > Info.> Update > Firmware 功能键

执行演示 System > More > Info.> Demo. 功能键

任务 相关前面板键
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Keysight B2900 系列
Keysight B2900 系列

Keysight B2900 是一系列精密 SMU （源 / 测量单元）。 B2900 提供 LCD、前面
板键和旋钮来施加电压 / 电流或测量电压 / 电流 / 电阻。 B2900 还支持多个功
能，如扫描输出、脉冲输出、任意波形生成、限值测试、迹线缓冲区、数学表达
式和图形打印。因此， B2900 可以用作 DC （恒定）电压 / 电流源、扫描电压 /
电流源、脉冲发生器、任意波形发生器和万用表。

Keysight B2900 系列的产品阵容包括以下产品。

表 2-1 Keysight B2900 系列

B2900 是 LAN eXtended Interface Core 兼容的仪器。

型号
SMU 

通道数

有效设置和测量值

最小分辨率
最大电流 最大电压

 设置 测量

B2901BL 1 1 pA、
1 V

1 pA、
0.1 V

DC：  1.5A  21 V

B2910BL 1 0.1 pA、
1 V

0.01 pA、
0.1 V

 210 V

B2901B 1 1 pA、
1 V

0.1 pA、
0.1 V

DC： 3.03 A 
脉冲： 10.5 AB2902B 2

B2911B 1 0.01 pA、 0.1 V

B2912B 2
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前视图
前视图

此部分介绍 Keysight B2900 系列的前视图。

• 待机开关

开启或关闭仪器。接通电源后，开关下方的 LED 指示灯会变为绿色。 

• 显示屏

显示电源设置、测量结果、状态信息等。有关详细信息，请参见第 4 章，“前
面板参考”。

• Trigger 键

启动单次 （一次）输出 / 测量或启动触发系统。如果正在进行重复测量，需
停止进行。

对为通道设置的 DC 偏置输出、阶梯扫描输出、脉冲偏压输出、脉冲扫描输
出执行单次测量。一个单次测量可以最多包含 100000 个测量点。

单次测量启动时，会清除数据缓冲区 （最多 100000 条数据），并且将最后的
单次测量结果存储在缓冲区中。测量结果会显示在 Single 视图、 Dual 视图、
Graph 视图或 Roll 视图上。
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前视图
如果未正确执行测量，请检查触发设置。必须将触发类型设置为 AUTO，或者必
须正确地设置触发计数 (Count)。请参见第 118 页上的“触发参数”。

• Auto 键

启动重复 （连续）测量。如果正在进行重复测量，需停止进行。

对 Source 值的 DC 偏置输出进行重复测量。测量结果会显示在 Single 视图、
Dual 视图或 Roll 视图上。重复测量结果不会存储在缓冲区中。

• USB-A 连接器

用于连接 USB 存储器。断开 USB 存储器连接后，等待 10 秒钟，然后再次连
接它或连接新存储器。

如果在 USB 存储器处于访问状态时关闭仪器，则可能会损坏设备。 

• 功能键

显示屏下方有 6 个功能键。它们指定给软件、 Config、 Function、 Trigger、
Result、 File、 Program、 I/O、 System 和 More。有关详细信息，请参阅 
第 4 章，“前面板参考”。

• 辅助键

显示屏右侧有 5 个辅助键。它们已指定给多个软键，如 Mode、 Source、
Limit、 Measure 和 More。软键指定取决于显示模式 （Single、 Graph、 
Roll 或 Dual）。有关详细信息，请参阅第 4 章，“前面板参考”。

• View 键

更改显示模式。按该键可更改模式，如下所示。

• B2901B、 B2901BL 和 B2910BL

Single  Graph （返回 Single）

• B2902B

Dual  Single （对于通道 1） Single （对于通道 2） Graph 
（返回 Dual）

• B2911B

Single  Graph  Roll （返回 Single）
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• B2912B

Dual  Single （对于通道 1） Single （对于通道 2） Graph  
Roll （返回 Dual）

• Cancel/Local 键

如果仪器处于本地状态，则取消设置操作。如果仪器处于远程状态，则使其
返回本地状态。

• 数字 / 字母键

用于输入设置参数的值，如字段指针指定的源输出值、限值 （合规性值）和
消息。

• 旋钮

如果字段指针处于 MOVE （蓝色）状态，转动旋钮可移动指针。按旋钮可固
定指针位置，并使指针状态变为 EDIT （绿色）。

如果字段指针处于 EDIT （绿色）状态，转动旋钮可更改由指针指定的设置参
数的值。按旋钮可固定该值，并使指针状态变为 MOVE （蓝色）。

• 向左和向右键

如果字段指针处于 MOVE （蓝色）状态，按这些键可移动指针。

如果字段指针处于 EDIT （绿色）状态，按下该键可更改由指针指定的设置参
数的值。

如果字段指针在数值输入字段中处于 EDIT （绿色）状态，按下该键可将指针
变成数字指针。

• On/Off 开关

用于启用或禁用 SMU 通道。如果通道处于输出状态，则将其关闭，即使它处
于远程状态也是如此。单通道型号上有一个开关，双通道型号上有两个开关。

如果通道已启用，开关将变为绿色。

如果通道处于高电压状态，开关将变为红色。

• 通道 1 源 / 测量端子

SMU 通道 1 的端子：High Force、 Low Force、 High Sense、 Low Sense、
Guard 和机箱接地。有关详细信息，请参见第 80 页上的 “连接 DUT”。
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请勿将 Guard 端子连接到任何输出，包括公共电路、机箱接地线或任何其他保护
端子。否则会损坏 B2900。

不要将电流加载到机箱接地端子。否则会损坏 B2900。
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后视图

此部分介绍 Keysight B2900 系列的后视图。

• 通道 2 源 / 测量端子

仅在双通道型号上。 SMU 通道 2 的端子：High Force、 Low Force、 High 
Sense、Low Sense、Guard 和机箱接地。有关详细信息，请参见第 80 页上的
“连接 DUT”。

请勿将 Guard 端子连接到任何输出，包括公共电路、机箱接地线或任何其他保护
端子。否则会损坏 B2900。

不要将电流加载到机箱接地端子。否则会损坏 B2900。

• GPIB 接口连接器

使用 Keysight 82357A/B USB/GPIB 接口或 Keysight 10833A/B/C/D GPIB 电缆
连接外部计算机或设备。

• 冷却风扇

• AC 输入连接器

AC 电源电缆连接到此插座。
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• LAN 接口连接器

连接到 10/100 Base-T 接口。左侧 LED 指示活动状态。右侧 LED 指示链路的
完整性。

• USB-B 连接器

连接到 USB 接口。

• Digital I/O 连接器

D-sub 25 针母连接器，用于通用 I/O (GPIO)。可以用作触发输入 / 输出端子
或用作处理设备或类似设备的接口。有关详细信息，请参见第 100 页上的
“使用 Digital I/O”。

针 16 和 24 以及针 17 和 25 保留用于联锁功能。如果端子已打开，则仪器输
出将限制为 42 V。在执行测量之前，确保将端子连接到 Keysight 16442B 测
试夹具或其他 DUT 接口。如果不使用 16442B，则需要安装联锁电路。有关
如何安装联锁电路的详细信息，请参阅第 90 页上的 “安装联锁电路”。

如果联锁端子关闭，则 High Fource、 High Sense 和 Guard 端子上可能出现危险
电压、仪器的最大输出电压。

Une tension dangereuse, une tension de sortie maximale de l'appareil peut 
apparaître aux bornes High Force, High Sense et Guard si la borne Interlock est 
fermée.

序列号

在使用 Keysight Technologies 电话帮助程序时需要仪器的序列号。序列号标签附
在仪器底部。
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源 / 测量单元

源 / 测量单元 （简称 SMU）可施加电压或电流，并可测量电流或电压。

图 2-1 所示为简化的 SMU 电路图。 SMU 可执行以下操作。

• 施加电压并测量电流

• 施加电流并测量电压

• 施加电压并测量电压

• 施加电流并测量电流

图 2-1 简化的 SMU 电路图

High Force

V

A

High Sense

4 

Low Sense

Low Force

High Force

V
A

Low Force

2 
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测量参数

B2900 支持以下测量参数。

• 电流

• 电压

• 电阻

• 功率

电阻数据根据 Resistance = Vmeas/Imeas 得出。

功率数据根据 Power = VmeasImeas 得出。

在上面的公式中， Vmeas 是电压测量数据， Imeas 是电流测量数据。

要使用电阻补偿，请参见第 205 页上的 “电阻补偿”。

限值 / 合规性

B2900 具有合规性功能，可限制输出电压或电流以防止损坏被测设备。在 SMU 
施加电压时，可以指定电流限值 / 合规性。在 SMU 施加电流时，可以指定电压
限值 / 合规性。有关限值 / 合规性的详细信息，请参阅第 192 页上的 “限值 / 合
规性”。
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输出和测量量程

此部分介绍 Keysight B2900 系列的典型规格。

• 最大电压和电流：请参见图 2-2。

• 最大功率：31.8 W

• 输出 / 测量值和分辨率：请参见表 2-2 到表 2-9。

图 2-2 最大电压和电流 （B2901B、 B2902B、 B2911B 和 B2912B）
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图 2-3 最大电压和电流 （B2901BL 和 B2910BL）
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表 2-2 电流输出范围 （B2901B、 B2902B、 B2911B 和 B2912B）

量程值

设置分辨率 DC 输出电流或

脉冲峰值 / 基极

电流 a b

最大电压

脉冲宽度 t cB2901B 
B2902B

B2911B 
B2912B DC 输出

脉冲
输出

10 nA d  10 fA 0  |I|  10.5 nA 210 V 210 V 50 s  t  tmax

100 nA 1 pA 100 fA 0  |I|  105 nA

1 A 10 pA 1 pA 0  |I|  1.05 A

10 A 100 pA 10 pA 0  |I|  10.5 A

100 A 1 nA 100 pA 0  |I|  105 A

1 mA 10 nA 1 nA 0  |I|  1.05 mA

10 mA 100 nA 10 nA 0  |I|  10.5 mA

100 mA 1 A 100 nA 0  |I|  105 mA

1 A 10 A 1 A 0  |I|  105 mA

105 mA < |I|  1.05 A 21 V 21 V

0  |I|  1.05 A  200 V 50 s  t  2.5 ms

 180 V 50 s  t  10 ms

1.5 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

0  |I|  1.515 A  200 V 50 s  t  2.5 ms

0  |I|  1.05 A  180 V 50 s  t  10 ms

3 A 100 A 10 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

1.515 A < |I|  3.03 A 6 V 6 V

10 A 0  |I|  10.5 A  ±6 V 50 s  t  1 ms

0  |I|  1.515 A  200 V 50 s  t  2.5 ms

0  |I|  1.05 A  180 V 50 s  t  10 ms
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表 2-3 电流输出范围 （B2901BL 和 B2910BL）

a.表 2-6 显示将通道 1 和 2 用于直流输出或脉冲输出时的限制，50 s  t  tmax (=99.9999 ks)。
b. 50 s  t  1 ms 时，脉冲的最大基极电流为 500 mA，50 s  t  2.5 ms 或 50 s  t  10 ms 时，为 50 mA。
c. 50 s  t  tmax 时，脉冲的最大占空比为 99.9999 %，50 s  t  1 ms、50 s  t  2.5 ms 或 50 s  t  10 ms 时为 2.5 %。
d. 适用于 B2911B 和 B2912B。不适用于 B2901B 和 B2902B。

量程值
设置分辨率

DC 输出电流 
最大电压

B2901BL B2910BL B2901BL B2910BL

10 nA a

a. 适用于 B2910BL。不适用于 B2901BL。

 100 fA 0  |I|  10.5 nA  210 V

100 nA a  1 nA 0  |I|  105 nA 

1 A 10 pA 10 pA 0  |I|  1.05 A 21 V

10 A 100 pA 100 pA 0  |I|  10.5 A

100 A 1 nA 1 nA 0  |I|  105 A

1 mA 10 nA 10 nA 0  |I|  1.05 mA

10 mA 100 nA 100 nA 0  |I|  10.5 mA

100 mA 1 A 1 A 0  |I|  105 mA

1 A 10 A 10 A 0  |I|  105 mA

105 mA < |I|  1.05 A 21 V

1.5 A 0  |I|  105 mA 210 V

105 mA < |I|  1.515 A 21 V
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表 2-4 电压输出范围 （B2901B、 B2902B、 B2911B 和 B2912B）

量程值

设置分辨率
DC 输出电压或脉冲

峰值 / 基极电压

最大电流 a

a.表 2-6 显示将通道 1 和 2 用于直流输出或脉冲输出时的限制，50 s  t  tmax (=99.9999 ks)。

脉冲宽度 t b

b. 50 s  t  tmax 时，脉冲的最大占空比为 99.9999 %，50 s  t  1 ms、50 ms  t  2.5 ms 或 50 s  t  10 ms 时为 2.5 %。

B2901B 
B2902B

B2911B 
B2912B DC 输出 脉冲输出

0.2 V 1 V 0.1 V 0  |V|  0.21 V 3.03 A 3.03 A，50 s  t  tmax

10.5 A，50 s  t  1 ms2 V 10 V 1 V 0  |V|  2.1 V

20 V 100 V 10 V 0  |V|  6 V

6 V < |V|  21 V 1.515 A 1.515 A，50 s  t  tmax

200 V 1 mV 100 V 0  |V|  6 V 3.03 A 3.03 A，50 s  t  tmax

10.5 A，50 s  t  1 ms

6 V < |V|  21 V 1.515 A 1.515 A 50 s  t  tmax

21 V < |V|  210 V 105 mA 105 mA

0  |V|  180 V  1.05 A 50 s  t  10 ms

0  |V|  200 V  1.515 A 50 s  t  2.5 ms
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表 2-5 电压输出范围 （B2901BL 和 B2910BL）

表 2-6 使用通道 1 和 2 的限值

量程值
设置分辨率 DC 输出电压或脉冲

峰值 / 基极电压

最大电流 

B2901BL B2910BL B2901BL B2910BL

0.2 V 1 V 1 V 0  |V|  0.21 V 1.515 A 1.515 A

2 V 10 V 10 V 0  |V|  2.1 V

20 V 100 V 100 V 0  |V|  6 V

6 V < |V|  21 V

200 V a

a. 适用于 B2910BL。不适用于 B2901BL。

 1 mV 0  |V|  6 V 

6 V < |V|  21 V

21 V < |V|  210 V 105 mA

通道 1 电压 V1 通道 2 电压 V2 电流限值 a

a. I1：通道 1 电流，I2：通道 2 电流

0 < |V1|  6 V 0 < |V2|  6 V I1 + I2  4 A

6 V < |V2|  21 V I1 + I2  1.6  4 A

6 V < |V1|  21 V 0 < |V2|  6 V I1 + I2  0.625  2.5 A

6 V < |V2|  21 V I1 + I2  2.5 A
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表 2-7 电流测量量程

量程值 电流测量值 分辨率

10 nA a

a. 适用于 B2910BL、B2911B 和 B2912B。不适用于 B2901BL、B2901B 和 B2902B。

0  |I|  10.6 nA 10 fA

100 nA b

b. 适用于 B2901B、B2902B、B2911B、B2912B 和 B2910BL。不适用于 B2901BL。

0  |I|  106 nA 100 fA

1 A 0  |I|  1.06 A 1 pA

10 A 0  |I|  10.6 A 10 pA

100 A 0  |I|  106 A 100 pA

1 mA 0  |I|  1.06 mA 1 nA

10 mA 0  |I|  10.6 mA 10 nA

100 mA 0  |I|  106 mA 100 nA

1 A 0  |I|  1.06 A 1 A

1.5 A 0  |I|  1.53 A

3 A c

c. 适用于 B2901B、B2902B、B2911B 和 B2912B。不适用于 B2901BL 和 B2910BL。

0  |I|  3.06 A 10 A

10 A b d

d. 适用于脉冲模式。不适用于 DC 模式。

0  |I|  10.6 A
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表 2-8 电压测量量程

表 2-9 电阻测量量程1

量程值 电压测量值 分辨率

0.2 V 0  |V|  0.212 V 0.1 V

2 V 0  |V|  2.12 V 1 V

20 V 0  |V|  21.2 V 10 V

200 V a

a. 适用于 B2910BL、B2901B、B2902B、B2911B 和 B2912B。不适用于 B2901BL。

0  |V|  212 V 100 V

量程值 电阻测量值 显示分辨率 测试电流

2  0 < R  2  1  1 A

20  2  < R  20  10  100 mA

200  20  < R  200  100  10 mA

2 k 200  < R  2 k 1 m 1 mA

20 k 2 k < R  20 k 10 m 100 A

200 k 20 k < R  200 k 100 m 10 A

2 M 200 k < R  2 M 1  1 A

20 Ma

a. 适用于 B2910BL、B2901B、B2902B、B2911B 和 B2912B。不适用于 B2901BL。

2 M < R  20 M 10  100 nA

200 M a 20 M < R  200 M 100  10 nA

1. 该电阻测量量程适用于设置为 AUTO 模式的电阻测量，该模式可通过 :SENS:RES:MODE 命令进行选择。
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操作和功能

前面板接口

4.3 英寸彩色 TFT WQVGA （480272，带 LED 背光），提供具有以下功能的图形
用户界面 (GUI)。

• 4 种视图模式 （Single、 Dual、 Graph、 Roll 视图）

• 易于进行键操作

• 易于访问基本和高级源 / 测量功能

Single 视图

Single 视图提供从仪器的前面板选择的通道的基本和高级设置并显示其功能。不
需要其他控制器或软件。

Dual 视图

Dual 视图提供通道 1 和 2 的基本设置并显示其功能。在 Dual 视图模式中最多可
以显示 6½ 个数字。此模式仅适用于 B2902B 和 B2912B。

Graph 视图

Graph 视图最多显示 2 个通道上的 XY 图形 （如 I-V 和 I-t/V-t 曲线）的测量结
果。该视图可用于快速评估设备特征，特别是从扫描测量获得的特征。

Roll 视图

Roll 视图绘制的 I-t 或 V-t 曲线类似于条形图表记录器绘制的曲线。在进行测量
时，可以显示和更新最多 1000 个采集的数据点。 Roll 视图的连续测量功能对于
监视低频现象特别有用。 Roll 视图仅适用于 B2911B 和 B2912B。
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易于进行键操作

• 数字 / 字母键、辅助键和旋钮可便于进行操作。

• 使用数字 / 字母键可以直接输入字母数字值。

• 辅助键可指导前面板上的操作。

易于访问源 / 测量功能

• 设置：

• V/I 源模式

• 源值

• 限制 （合规性）值

• 扫描参数

• 脉冲参数

• 测量速度

• 量程设置

• 触发设置

• 结果显示：

• 在 Single 和 Dual 视图模式中最多均可以显示 6½ 个数字

• Graph 视图和 Roll 视图中的特征

• 数据列表

• 高级功能：

• 通过使用组件处理程序的用户可定义限值来限制测试

• 用于累积测量 （或数学运算）结果并收集其统计信息的迹线存储器

• 文件操作 （USB 存储器）：

保存：

• 系统配置

• 测量 / 数学运算结果

• 限值测试结果

• 迹线数据
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• 图形屏幕转储

加载：

• 系统配置

• 列表扫描数据

源 / 测量功能

扫描测量

• 扫描的步阶数： 

B2901BL：1 至 10000

B2910BL、 B2901B、 B2902B、 B2911B 和 B2912B：1 至 100000

• 扫描模式：线性、对数 (log) 或列表

• 扫描方向：单向或双向

• 类型： 

B2901BL 和 B2910BL：DC

B2901B、 B2902B、 B2911B 和 B2912B：DC 或脉冲

• 创建列表扫描波形的最小可编程值：

B2901BL：200 s，分辨率为 1 s

B2910BL：50 s，分辨率为 1 s

B2901B 和 B2902B：20 s，分辨率为 1 s

B2911B 和 B2912B：10 s，分辨率为 1 s

数字化 / 采样测量

可通过适当地设置测量速度和触发间隔来执行数字化或采样测量。

最小触发间隔 （最大测量速度）：

B2901BL：200 s （5000 点 / 秒）

B2910BL：50 s （20000 点 / 秒）

B2901B 和 B2902B：20 s （50000 点 / 秒）

B2911B 和 B2912B：10 s （100000 点 / 秒）
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数据缓冲区

数据缓冲区是测量元素的阵列。每个元素都保留以下值。

• 测量的电压

• 测量的电流

• 测量的电阻

• 事件戳

• 测量状态

• 源设置

最大缓冲区大小：

B2901BL：10000 点 / 通道

B2910BL、 B2901B、 B2902B、 B2911B 和 B2912B：100000 点 / 通道

程序和接口功能

编程语言

B2900 支持 SCPI （可编程仪器的标准命令）。

• 默认命令集：支持 B2900 的所有高级功能。

• 传统命令集：支持实现基本兼容性的行业标准传统 SCPI 命令集。

程序存储器

使用程序存储器可以将 SCPI 命令行的长字符串一次存储在内置易失型存储器
中，然后在程序使用单个 SCPI 命令执行时调用这些字符串多次。在将命令字符
串存储在存储器中后，就不需要花费时间通过通信总线发送这些相同的命令了。
对于使用许多重复代码 （如子例程）的测试，使用程序存储器可极大地减少测试
时间。

• 程序名称的最大字符数：32 个，包括字母、数字、连字符和下划线

• 最大存储器大小：100 KB （通常为 2500 行）
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LXI

LXI 核心一致性。B2900 遵循指定的 LAN 协议，并遵守 LXI 要求，如内置 Web 控
制服务器和 IVI-COM 驱动程序。

• 以太网：10/100Base-T

• USB2.0：USB-TMC488 协议 （后部  1）

• GPIB：符合 IEEE-488.2

USB 文件系统

USB 2.0 高速大容量存储 (MSC) 级设备 （前部  1）

Digital I/O 接口

• 连接器：25 针母接头

• 输入 / 输出针：14 开漏 I/O 位

• 绝对最大输入电压：5.25 V

• 绝对最小输入电压： 0.25 V

• 逻辑低最大输入电压：0.8 V

• 逻辑高最小输入电压：2.0 V

• 最大源电流：1 mA， Vout = 0 V

• 最大反向电流：50 mA， Vout = 5 V

• 5 V 电源针：

限制为 600 mA，固态保险丝保护

• 安全联锁针：

一个有源高针和一个有源低针。激活两个针将使输出电压 > 42 V。
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软件和驱动程序

• 图形 Web 界面

Graphical Web Interface 是基于 Web 浏览器的仪器控制面板。使用它可以通
过内置的 Web 服务器快速轻松地从 Web 浏览器设置和执行测量。还可以通
过 LAN 连接控制一个 B2900 单元。

• IVI-C 或 IVI-COM 驱动程序

与 Windows 8 （64 位 /32 位）、 10 （64 位 /32 位） IO Libraries 17.0 或更高
版本兼容。支持 Keysight VEE、Microsoft Visual Studio（Visual Basic、Visual 
C++、 Visual C#）、 National Instruments LabWindows 和 LabVIEW。

• LabVIEW 驱动程序 (VI)

National Instruments LabVIEW 8.5/2010 或更高版本。LabVIEW 驱动程序可在 
NI.COM 上找到。

有关最新的系统要求，请访问 www.keysight.com/find/b2900 获取相关信息。 
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附件

Keysight B2900B/BL 带有以下附件。

• 快速启动海报，每个设备 1 套。

• 快速参考，每个设备 1 套。

• EasyEXPERT 的使用许可

• 电源线，每个设备 1 根。

• USB 电缆，每个设备 1 根。

可用附件

有关 Keysight B2900 系列的可用附件，请参阅产品目录 Keysight B2900B/BL 精
密仪器系列附件。 

要获取最新产品目录，请访问 www.keysight.com/find/b2900 并单击 “技术支
持”和 “目录”。
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表 2-10 列出了 Keysight B2900 的选件。

表 2-10 选件

选件 描述 

1A7 校准、不确定因素和保护带 （未经认证）

A6J ANSI Z540 合规性校准

UK6 包含测试数据的商业校准证书
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本章介绍如何安装 Keysight B2900 和附件。

为避免电击和仪器损坏，请在连接或断开测量电缆之前关闭仪器电源。

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.



安装
此仪器的 High Force、 High Sense 和 Guard 端子可能存在危险电压 (210 V)。 
为了防止发生电击，在使用仪器期间必须采取以下安全防范措施。

• 使用三芯交流电源线将机柜 （如果使用）和仪器连接到电气接地线 （安全接
地线）。

• 如果测试夹具或连接接口中没有安装联锁电路，则必须安装并连接联锁电路，
在打开屏蔽盒检修门时，它将打开联锁端子。

• 如果改变了连接接口、测试夹具、探测仪等，请将联锁电缆与实际使用的电
缆连接起来。

• 定期检查以确认联锁功能可正常运行。

• 在接触 High Force、 High Sense 和 Guard 端子上的连接之前，应关闭仪器并
将所有电容放电。如果没有 关闭仪器电源，请完成下列所有 项目，不管仪器
的设置如何。

• 按 On/Off 开关，并确认该开关已关闭。

• 确认 On/Off 开关没有变为红色。

• 打开夹具盖或屏蔽盒检修门 （打开联锁）。

• 将连接到通道的任何电容器放电。

• 警告在仪器周围工作的人员存在危险情况。
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Une tension dangereuse (max.  pour; 210 Vdc) émanant du dispositif 
l'instrument peut être sortie aux bornes High Force, High Sense et Guard. Les 
précautions suivantes doivent être obserées contre commotion électrique 
accidentelle.

• Utilisez un cordon d'alimentation CA à trois connecteurs pour connecter la 
cabine (si utilisée) et l'instrument à la mise électrique à la terre (sol de 
sécurité).

• Si un circuit de sécurité n'est pas installé dans votre test d'installation ou 
dans votre interface de connexion, vous devez installer et connecter le circuit 
de sécurité qui ouvre la borne d'enclenchement lorsque la porte d'accès à la 
protection de la boîte est ouverte.

• Si vous changez l'interface de connexion, un test d'installation, la sonde, ou 
toute autre élément, connectez un cordon d'enclenchement à celui utilisé 
actuellement.

• Vérifiez régulièrement que la fonction de verrouillage fonctionne 
normalement.

• Avant de toucher les connexions des bornes High Force, High Sense et Guard, 
éteignez l'instrument et déchargez tous les condensateurs. Si vous n'éteignez 
pas l'appareil, complétez tous les éléments suivants, indépendamment des 
réglages de l'appareil.

• Appuyez sur le bouton On/Off, et confirmez que le signal lumineux est 
éteint.

• Vérifiez que le bouton On/Off ne devienne pas rouge.

• Ouvrez le couvercle d'appareil ou la protection du boîtier de la porte 
d'accès (verrouillage ouvert).

• Déchargez tous les condensateurs connectés au réseau.

• Informez les personnes se trouvant à proximité de l'appareil à propos des 
conditions dangereuses.
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检查装运物品 

在 Keysight B2900 及附件运达您的地点时，进行以下检查。

1. 在打开任何组件的包装之前，检查所有包装箱是否在运输过程中损坏，如：

• 凹痕

• 刮痕

• 切痕

• 水痕

如果您怀疑有任何损坏，请联系离您最近的 Keysight 销售和支持办事处。

2. 打开装有 B2900 和附件的包装箱时，应对照包装箱附带的物品列表清点 
物品。

如果缺少某项物品，请联系离您最近的 Keysight 销售和支持办事处。

3. 按照 “检查 Keysight B2900 的运行情况”中的说明检查 B2900 的运行情况。

如果出现任何问题，请联系离您最近的 Keysight 销售和支持办事处。

检查 Keysight B2900 的运行情况

1. 确保待机开关设置为关闭。

2. 将电源线从 B2900 的后面板 AC 输入连接器 （插座）连接到现场的 AC 电源
插座。

3. 按下待机开关打开仪器。 

B2900 前面板显示屏上将显示初始化屏幕，并且会自动执行开机自检。 

如果 B2900 运行正常，前面板 LCD 将如图 3-1 或 3-2 所示。
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图 3-1 1 通道型号的显示示例

图 3-2 2 通道型号的显示示例

检查错误

按如下所述检查错误。

1. 按 More > System > Error > Log 功能键。这将打开 Error Log 对话框。

2. 检查该对话框中显示的错误。

如果没有检测到错误，则显示 “0, No Error”。

3. 按 OK 软键关闭该对话框。
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此部分介绍在安装 Keysight B2900 时必须注意的信息。

• “安全注意事项”

• “环境”

• “连接电源线”

• “设置电源线频率”

• “设置日期和时间”

• “工作台安装”

• “机架安装”

安全注意事项

请参阅本指南开头部分的 “安全摘要”页面以了解一般安全信息。在安装或操作
之前，请检查 B2900 并查看本指南以了解安全警告和说明。与特定步骤相关的安
全警告分散在本指南的各相应章节。

环境

请勿在多尘环境或存在易燃气体、腐蚀性气体或烟雾的环境中操作仪器。

Ne pas utiliser l’appareil dans un endroit poussiéreux, ou en présence de gaz 
inflammables, corrosifs ou de fumée.

B2900 的环境条件如下所述。 B2900 设计为仅供室内使用。

• 温度范围

运行中 0 C 到 55 C

储存 -30 C 到 70 °C

• 湿度范围

运行中 30 % 至 80 % RH （无凝结）

储存 10 % 至 90 % RH （无凝结）
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• 海拔高度

运行中 0 米到 2000 米 （6561 英尺）

储存 0 米到 4,600 米 （15,092 英尺）

• 电源要求：100-240 V (10 %)、 50/60 Hz

• 最大伏安 (VA)：250 VA

• 尺寸

不带手柄和支架： 88 mm (H)  213 mm (W)  450 mm (D)

工作台配置 （带手柄和支架）：180 mm (H)  260 mm (W)  480 mm (D)

风扇可从侧面抽气，然后从背面排气，以此冷却仪器。仪器必须安装在侧面和后
面具有足够空间的位置以便空气可以充分循环。

连接电源线

火灾危险：仅使用仪器附随的电源线。使用其他类型的电源线可能会导致电源线
过热，从而导致发生火灾。

电击危险：此电源线可通过第三根导线提供机箱接地。请确保连接到针脚正确接
地的三导线类型的电源插座。

RISQUE D’INCENDIE : utilisez uniquement le câble d'alimentation fourni avec 
votre appareil. L’utilisation d’autres types de câble d’alimentation peut provoquer 
une surchauffe du câble d’alimentation et provoquer un incendie.

RISQUE DE CHOC ÉLECTRIQUE: le câble d’alimentation fournit la masse du 
châssis par le biais d’un troisième conducteur. Assurez-vous de connecter la 
prise d'alimentation de type trois conducteurs avec la broche correcte mise à la 
terre.

可拆卸的电源线可以用作紧急断开装置。拔下电源线将断开到仪器的 AC 输入 
电源。
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900 选件

• 插头：BS 1363/A，
250 V、 10 A

• PN：8120-4420

901 选件

• 插头：AS/NZS 
3112， 250 V、 
10 A

• PN：8120-4419

902 选件

• 插头：IEC 
60277-1， 250 V、
10 A

• PN：8121-1226

903 选件

• 插头：NEMA 
5-15P， 125 V、 
10 A

• PN：8120-6825

904 选件

• 插头：NEMA 
6-15P， 250 V、 
10 A

• PN：8120-3996

906 选件

• 插头：SEV 1011，
250 V、 10 A

• PN：8120-4416

912 选件

• 插头：SB 
107-2-D1， 250 V、
10 A

• PN：8121-1655

917 选件

• 插头：IS 1293 和 
IS 6538， 250 V、 
10 A

• PN：8121-1690
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将电源线连接到仪器后面的 IEC 60320 连接器。如果仪器附带的电源线不正确，
请联系是德科技。

仪器后面的 AC 输入是通用的 AC 输入。它接受 100 至 240 VAC 范围内的标称线
电压。

918 选件

• 插头：JIS C 8303，
125 V、 12 A

• PN：8121-0743

919 选件

• 插头：Israel SI 32，
250 V、 10 A

• PN：8121-0724

920 选件

• 插头： IRAM 2073, 
250 V, 10 A

• PN：8121-0725

921 选件

• 插头： CEI 23-16, 
250 V, 10 A

• PN：8121-0722

922 选件

• 插头：GB 1002 
图 3，250 V，10 A

• PN：8120-8376

923 选件

• 插头：SANS 
164-1， 250 V、 
10 A

• PN：8121-0564

927 选件

• 插头：NEMA 
WD-6，250 V、10 A

• PN：8120-0674

930 选件

• 插头：NBR 14136，
250 V、 10 A

• PN：8121-1809

931 选件

• 插头：CNS 
10917-2， 125 V、
10 A

• PN：8121-1635

932 选件

• 插头：CS 0017，
250 V、 10 A

• PN：8121-1638
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设置电源线频率

必须在您的站点为 AC 电源正确设置电源线频率。按以下功能键将频率设置为 
50 Hz 或 60 Hz。

• 要设置为 50 Hz： More > System > PLC > 50 Hz

• 要设置为 60 Hz：More > System > PLC > 60 Hz

设置日期和时间

可以在 Date and Time 对话框中设置日期和时间，该对话框的打开方式为按 
System > Info.> Date/Time 功能键。

工作台安装

请勿阻挡 B2900 侧面进气和后面排气。进行工作台操作时，应距离侧面至少 
5 毫米，距离背面至少 100 毫米。

为了便于查看和检查测量端子，可以转动手柄使仪器的前部倾斜。要调整手柄位
置，请抓住手柄的边缘，向外拉出。然后，将手柄旋转到所需位置。
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机架安装

使用机架安装包 (34190A) 以机架方式安装 Keysight B2900。

可将 Keysight B2900 安装在 19 英寸的 EIA 机架上。它设计为安装在两个机架单
元 (2U) 的空间中。

在将 B2900 安装在机架上之前，卸下前面和后面的橡胶减震器和手柄。

请勿阻挡 B2900 侧面进气和后面排气。

卸下减震器

拉紧橡胶减震器的一角并将其滑出。 

卸下手柄。

1. 抓住手柄的边缘，向外拉出。这可让您旋转手柄。

2. 将手柄转到垂直位置。然后，水平放下仪器。

3. 向外拉出手柄，然后向上提起。

在重新连接手柄时，请注意其方向。连接不正确可能会损坏硬件。

1 1

2

3
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应定期维护 Keysight B2900，使其保持良好的状态。如果发生任何问题，请联系
离您最近的 Keysight 销售和支持办事处。

• “清洁”

• “自检”

• “自我校准”

• “校准”

清洁

电击危险：为防电击，请在清洁之前拔下 B2900 的插头。

Risques de choc électrique : afin d’éviter tout choc électrique, débranchez le 
B2900 avant d’effectuer le nettoyage.

使用干布或用水稍微沾湿的布清洁外部箱体部分。请勿使用清洁剂或化学溶剂。
请勿清洁仪器内部。

自检

Keysight B2900 提供自检功能以检查其运行状况。打开仪器时将自动执行自检。
建议在下列情况下或出于以下目的执行自检：执行自检之前，关闭通道输出， 
从端子断开测试引线和电缆连接。

• 如果通道由于过温而处于锁定状态

在此情况下， Emergency 对话框将显示在灰色背景屏幕上，然而，如果远程
显示屏设置为 OFF，则不会在远程状态下显示此对话框。 ERR 指示器将打
开， On/Off 开关将不起作用。 

执行自检以解除通道锁定。如果自检没有报告任何问题，则很快可以使用 
通道。 

• 如果您认为仪器可能有缺陷

• 进行预防性维护
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执行自检 以下步骤说明如何执行自检。

1. 如果处于远程状态，则按 Cancel / Local 键。

2. 按 On/Off 开关，并确认开关已关闭。

3. 从通道端子断开测试引线和电缆连接。

4. 按以下功能键。

More > System > Cal/Test > Self-Test

将打开 Confirmation 对话框。

5. 按 OK 键。这将启动自检。

自我校准

Keysight B2900 提供自我校准功能以保持测量性能。如果环境温度变化在 3 C 
或更大范围内，则执行自我校准。这样可通过将热漂移效应降至最低来获得准确
的测量结果。自校准必须在预热 60 分钟后执行。执行自我校准之前，关闭通道
输出，从端子断开测试引线和电缆连接。

执行自我校准 以下步骤说明如何执行自我校准。

1. 如果处于远程状态，则按 Cancel / Local 键。

2. 按 On/Off 开关，并确认开关已关闭。

3. 从通道端子断开测试引线和电缆连接。

4. 按以下功能键。

More > System > Cal/Test > Self-Cal

将打开 Confirmation 对话框。

5. 按 OK 键。这将启动自我校准。

校准

必须定期进行校准和调整，使仪器符合规格并保持良好的状态。建议至少一年进
行一次校准。要进行校准和调整，请联系离您最近的 Keysight 销售和支持办事
处。经过培训的维修人员将执行校准和调整。
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此部分介绍如何将被测设备（简称 DUT）连接到 Keysight B2900 源 / 测量端子。

在改变连接时，将通道输出设置为关闭。否则可能会损坏 DUT。

要将通道输出设置为关闭，请按 On/Off 开关，并确认开关 LED 已关闭。

此部分包括以下说明。

• “二线制连接或四线制连接”

• “浮动”

• “使用测试引线”

• “使用 N1295A 测试夹具”

• “使用 16442B 测试夹具”

• “保护”

• “执行低电流测量”

连接联锁电路

B2900 提供了联锁功能，以防止用户受到超过 42 V 的高压电击。如果 Digital 
I/O 联锁端子已打开，则 B2900 无法 施加高压。

对于高电压测量，可将联锁端子连接到联锁电路，如第 90 页上的 “安装联锁电
路” 中所示。

环境条件 （例如电磁环境）通常会对仪器的性能产生负面影响。使用同轴电缆和
屏蔽技术可将影响降至最低。
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为避免 DUT 接触延长电缆的末端或端子区域，请用绝缘材料覆盖导线。此外，
使用接地屏蔽罩等物品保护端子区域也很重要。

为防止电击和 DUT 损坏，请勿在仪器施加电压或电流时连接或断开 DUT。

针对残余电荷和热量采取相应的防范措施，以防止在测量后接触 DUT 时受到电
击和烧伤。使用手套和任何工具，还需为放电和散热留出足够的时间。

Afin d'éviter de toucher l'extrémité du câble d'allongement ou l'aire de la borne 
avec l'appareil mis sous tension (AST), couvrez les conducteurs avec l'isolant. En 
outre, il est important de protéger la zone de la borne en utilisant le couvercle 
d'écran à la mise à terre, ou tout autre élément.

Afin d’éviter toute décharge électrique et dommage MST, ne branchez ou 
déconnectez pas la sortie MST alors que la source de sortie est appliquée.

Lorsque vous touchez le MST après la mesure, élaborez une contre-mesure de la 
charge résiduelle et du chauffage afin d'éviter tout choc électrique et toute 
brûlure. Utilisez des gants et des outils. Prévoyez également du temps pour la 
décharge et la radiation.

二线制连接或四线制连接

连接 DUT 时，可以选择二线制连接类型或四线制连接类型。

如果要简化连接，可通过仅连接 Force 端子并打开 Sense 端子来使用二线制连
接。可使用 Force 端子施加和测量 DC 电压或电流。

要进行四线制连接、远程感应 （称为 Kelvin 连接），请同时使用 Force 和 Sense 
端子。将 Force 和 Sense 线同时连接到 DUT 的端子可以最大程度地减少由测试
引线或电缆的残余电阻造成的测量误差。此连接对于低电阻测量和高电流测量 
有效。

要指定连接类型 （感应类型），请执行以下步骤。

1. 按 Config > Source > Connection 功能键。这将打开 Output Connection 对 
话框。

2. 在此对话框中设置感应类型。对于二线制连接，请选择 2-WIRE，对于四线 
制连接，请选择 4-WIRE。

3. 按 OK 软键。对于四线制连接，以下指示器显示在 Single 视图或 Dual 视 
图中。

四线制连接指示器： 
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图 3-3 Dual 视图，通道 1 的四线制连接设置

浮动

在默认设置中， Low Force 端子连接到机箱接地线。但是，为了产生浮动条件，
可在内部断开它与接地线的连接。此设置用于以串联方式连接源通道。

要指定低端子状态，可执行以下步骤。不保存设置。关闭仪器会将状态设置为 
接地。

1. 按 Config > Source > Connection 功能键。这将打开 Output Connection 对 
话框。

2. 在此对话框中设置低端子状态。对于浮动状态，它必须是 FLOATING，或者，
对于接地状态，它必须是 GROUNDED。

3. 按 OK 软键。

对于浮动状态，以下指示器显示在状态信息区域中。然后可将 Low Force 和 
Low Sense 端子连接到最大为 250 V 的电压。

通道 1 浮动状态指示器：

通道 2 浮动状态指示器： 
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图 3-4 Dual 视图，通道 1 和 2 的浮动状态

不要将电流加载到机箱接地线。否则会损坏 B2900。

为防止触电，在进行浮动测量时，任何时候都不要触摸任何测量电路。还应使用
符合 IEC 61010-031 的附件。必须通过使用绝缘帽、绝缘套等来隔离所有端子和
延长导线。

Afin d’éviter toute décharge électrique, ne touchez aucune mesure de circuit à 
tout moment lorsque la mesure de flotte est en cours. Utiliser également des 
accessoires qui sont conformes à la norme IEC 61010-031. Toutes les bornes et 
les conducteurs prolongés doivent être isolés en utilisant des bouchons 
d'isolation, des manchons, etc.
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使用测试引线

B2900 源 / 测量端子使用香蕉插孔。要连接 DUT，可使用以下测试引线。图 3-5 
显示了双端子设备测量的连接情况。

• Keysight U8201A 组合测试引线套件

一对测试引线、测试探头、弹簧夹、 SMT 夹具、尖针测试探头和香蕉插头，
CAT III 1000 V，最小 15 A

四线制连接需要两个套件。

• Keysight 11059A Kelvin 探头组

用于四线制连接的测试引线，最大 42 V

图 3-5 连接双端子设备

High Sense

High Force

Low Force

Low Sense

DUT

High Force

Low Force

DUT

2 4 
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使用 N1295A 测试夹具

Keysight N1295A 是一个测试夹具，有 4 个三轴连接器，并支持 2 个双线连接。

要求 • Keysight N1295A 测试夹具带有针夹线 （每个夹具 4 个）和针插头线 
（每个夹具 2 个）。

• Keysight N1297A 香蕉插头至三轴适配器，可进行二线制连接

• 三轴电缆，每个插头 2 根，用于 1 个两线制连接

连接 1. 将香蕉插头连接到三轴适配器，再连接到 B2900 源 / 测量端子。请参见 
图 3-6。如果如 “不良连接”所示有一些空隙，则表明接触不良。

2. 连接适配器和 N1295A 之间的三轴电缆，如图 3-7 所示。

3. 连接端子 1 和 2 之间的 DUT，如图 3-7 中的示例所示。

图 3-6 将香蕉插头连接到三轴适配器

图 3-7 Keysight N1295A 连接示例

1

1

2

3

4

3

2
4

± 42V     1.05 A Max

Low Force

High Force

DUT
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屏蔽

N1295A 带有盖子。为了尽可能降低环境噪声的影响，请在执行测量时合上 
盖子。

最大电压和电流

必须在以下限制条件下使用测试夹具和适配器，以防止造成损坏。

Keysight N1297A：最大 250 V，连接 N1295A 时最大 42 V

Keysight N1297B：最大 250 V，连接 N1295A 时最大 42 V

Keysight N1295A：42 V，最小 1.05 A

使用 16442B 测试夹具

Keysight 16442B 是一个测试夹具，它有六个三轴连接器用于源 / 测量单元 （简
称 SMU），GNDU 连接器用于参数 / 设备分析仪的接地单元，Intlk 连接器用于联
锁控制，以及六个同轴连接器用于其他仪器。有关 16442B 的附件的详细信息，
请参阅 Keysight 16442B 用户指南。

要求 • Keysight 16442B 测试夹具带有针夹线、针插头线等。

• Keysight N1297A 香蕉插头至三轴适配器，可进行二线制连接

• Keysight N1297B 香蕉插头至三轴适配器，可进行四线制连接

• 三轴电缆，对于两线制连接每个夹具 2 根，对于四线制连接每个夹具 3 根

屏蔽

16442B 带有盖子。为了尽可能降低环境噪声的影响，请在执行测量时合上 
盖子。
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最大电压和电流

必须在以下限制条件下使用测试夹具和适配器，以防止造成损坏。

Keysight N1297A：最大 250 V，连接 16442B 时最大为 200 V

Keysight N1297B：最大 250 V，连接 16442B 时最大为 200 V

Keysight 16442B：200 V，对于 SMU 输入最大为 1 A

连接 1. 将香蕉插头连接到三轴适配器，再连接到 B2900 源 / 测量端子。请参见 
图 3-6。如果如 “不良连接”所示有一些空隙，则表明接触不良。

2. 连接适配器和 16442B 之间的三轴电缆。图 3-8 显示了一个连接示例。

3. 通过使用 16442B 的适用于 DUT 的已安装附件、套接口模块、空板和电线，
连接 16442B 接线板上的 DUT。

图 3-9 显示图 3-8 的连接示例。

对于两线制连接，将 SMU 1 Force 端子连接到 DUT 端子，并将 SMU 2 Force 
端子连接到其他 DUT 端子。

对于四线制连接，将 SMU 1 Force 和 Sense 端子连接到 DUT 端子。在将适配
器的 Low Force/Low Sense 连接器连接到 SMU 3 Sense 连接器时，请将 SMU 
3 Sense 和 Guard 端子连接到其他 DUT 端子。 Low Force 信号显示在 Guard 
端子上。

图 3-8 N1297A 和 16442B 间连接的示例

2  
N1297A 

4  
N1297B 

 SMU 2
       Force

 SMU 1 Force  SMU 1 Force SMU 1 Sense

 SMU 3 Sense
(  GNDU)

Low Force/ 
Low Sense

High Sense High Force

Low Force

High Force
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图 3-9 16442B 接线面板的连接示例

执行高电压测量

当 Digital I/O 联锁端子打开时， B2900 不能施加超过 42 V 的高电压。要执行高
电压测量，必须将 B2900 连接到 16442B 中安装的联锁电路。 

准备 N1297A 或 N1297B 联锁电缆，并将其连接在 B2900 Digital I/O 连接器和 
16442B 联锁连接器之间。在测试夹具合上时， B2900 可以施加高电压。

夹具盖合上时，在 High Force、 High Sense 和 Guard 端子上可能会出现危险电
压，即仪器最大输出电压。为了防止发生电击，请勿 将这些线暴露在外。

Une tension dangereuse, une tension de sortie maximale de l'appareil peut 
apparaître aux bornes High Force, High Sense et Guard si le couvercle de 
l'équipement est fermé. Afin d’éviter toute décharge électrique, n’exposez pas 
ces lignes.

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

DUT

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

2 4 

DUT

 GNDU Sense  GNDU Force
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保护 
保护可减少仪器和 DUT 之间的漏电流。在测量低电流时，此功能很重要。

图 3-10 显示保护的原理。缓冲区放大器 (1) 可使 Guard 导线的电势与 High 
Force 导线的电势保持相同，这样在 High Force 和 Guard 导线之间就不会有电
流。因此，由于没有漏电流，仪器测量的电流与 DUT 端子上的电流相同。

对于图 3-7 和 3-8 中显示的连接示例，使用三轴电缆将保护延伸至测试夹具输入
连接器。

图 3-10 保护

请勿将 Guard 端子连接到任何输出，包括公共电路、机箱接地线或任何其他保护
端子。否则会损坏 B2900。

执行低电流测量

在缺省设置下，不使用 10 nA 和 100 nA 测量量程。要进行低电流测量，必须更
改测量量程设置。

更改测量量程 1. 按 View 键以显示 Single 视图。

如果 Single 视图的下半部分没有显示 Range 参数，则按 More、Hide Sweep、
Hide Pulse 或 Hide Trigger 辅助键以显示 Range 参数。

2. 更改 Range 参数的 Measure Amps 字段的设置。

对于自动量程，设置 AUTO ；对于固定量程，设置 FIXED。

对于最小或固定测量量程，设置 10 nA 或 100 nA。

A High Force DUT
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安装联锁电路 

联锁电路是如图 3-11 所示的简单电路。该电路在检修门打开时打开，在检修门
关闭时才关闭。

当 Digital I/O 联锁端子打开时， B2900 无法施加超过 ±42 V 的高电压。要执行高
电压测量，必须将 B2900 联锁端子连接到测量环境 （如屏蔽盒）中安装的联锁
电路。在用户接触测量端子时，联锁电路是防止发生电击的重要而必要的手段。

夹具盖合上时，在 High Force、 High Sense 和 Guard 端子上可能会出现危险电
压，即仪器最大输出电压。为了防止发生电击，请勿 将这些线暴露在外。

Une tension dangereuse, une tension de sortie maximale de l'appareil peut 
apparaître aux bornes High Force, High Sense et Guard si le couvercle de 
l'équipement est fermé. Afin d’éviter toute décharge électrique, n’exposez pas 
ces lignes.

图 3-11 联锁电路

LED D-sub 

B2900
Digital I/O

15, 19

14

17, 18

16

24, 25

Dsub 

15, 19

22, 23

16, 17

24

14

22
R

R 500 W  1 kW 

25
R
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要求 • LED （Keysight 部件号 1990-0486 或等同产品），每个仪器 1 个。

• 机械开关 （Keysight N1254A-402 或等同产品），每个仪器 2 个。

• 电阻， 500  至 1 k（选择较低的值可获得更高的 LED 输出），每个仪器 
1 个。

• 25 针 D-sub 连接器 （用于连接线路，安装在屏蔽盒中），每个仪器 1 个。

• 连接线

• 25 针 D-sub 电缆，每个仪器 1 根。

步骤 1. 将两个机械开关安装在屏蔽盒上，这样检修门关闭时开关将关闭，检修门打
开时开关将打开。关于开关的尺寸，请参见图 3-13。

2. 将 LED 安装在屏蔽盒上。有关 LED 尺寸，请参阅图 3-12。

LED 可用作高电压指示器，它会在 B2900 处于高电压输出状态时点亮。

3. 将 D-sub 连接器安装在屏蔽盒上。

4. 使用电线并使 D-sub 连接器的下列针脚短接。有关连接示例，请参阅 
图 3-11。

对于负逻辑：针脚 24 和 25

对于正逻辑：针脚 16 和 17

5. 使用电线并将 D-sub 连接器的以下针脚之间的两个开关串联起来。有关 
Digital I/O 针脚分配，请参阅表 3-1。

对于负逻辑：针脚 16 和某些接地针脚

接地针脚是针脚 15 和 17 至 21。

对于正逻辑：针脚 24 和某些 5 V 针脚

5 V 针脚是针脚号 22、 23 和 25。

6. 使用电线连接针脚 14 和 D-sub 连接器的某些接地针脚之间的 LED。然后 
将针脚 14 设置为 HIGH VOLTAGE LAMP。请参见第 149 页上的 “DIO 
Configuration 对话框”。

7. 在针脚 14 和未使用的 5 V 针脚之间连接一个电阻。
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图 3-12 LED （Keysight 部件号 1990-0486） 的尺寸 

图 3-13 联锁开关的尺寸 (Keysight N1254A-402) 
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连接到接口

接口连接器附近超过 1 kV 的静电放电可能会使单元重置，因此需要操作员干预。

B2900 支持 GPIB、 LAN 和 USB 接口。所有三个接口在接通电源时均处于加电状
态。将接口电缆连接到适当的接口连接器。有关配置接口的信息可在本部分的后
面找到。

在连接和配置 LAN 端口后，前面板的 LAN 指示器将点亮。

B2900 提供以太网连接监视功能。通过以太网连接监视，将持续监视仪器的 LAN 
端口并自动进行重新配置。

GPIB/USB 接口

有关 GPIB 和 USB 接口连接的详细信息，请参阅随 Keysight IO Libraries 一起安
装的连接指南。

以下步骤将帮助您快速将仪器连接到 GPIB （通用接口总线）。下图说明了典型
的 GPIB 接口系统。

 PC 
 GPIB 

 GPIB 

PC
GPIB 
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1. 如果尚未安装，请从产品附带的 CD 安装 Keysight IO Libraries Suite。

2. 如果计算机上尚未安装 GPIB 接口卡，则请关闭计算机并安装 GPIB 卡。

3. 使用 GPIB 接口电缆将仪器连接到 GPIB 接口卡。

4. 使用 Keysight IO Libraries Suite 中的 Connection Expert 实用程序配置已安装
的 GPIB 接口卡的参数。

5. B2900 出厂时其 GPIB 地址设置为 23。要查看或更改 GPIB 地址，请按 More 
功能键，然后按 I/O > GPIB 软键。将显示 GPIB Configuration 对话框。

要更改 GPIB 地址，请使用旋钮或箭头键，然后按 OK 设置值。

6. 现在可以使用 Connection Expert 中的 Interactive IO 与仪器通信，或使用各种
编程环境对仪器进行编程。

以下步骤将帮助您快速将支持 USB 的仪器连接到 USB （通用串行总线）。下图
说明了典型的 USB 接口系统。

1. 如果尚未安装，请从产品附带的 CD 安装 Keysight IO Libraries Suite。

2. 将仪器后面的 USB 设备端口连接到计算机的 USB 端口。

3. 当 Keysight IO Libraries Suite 的 Connection Expert 实用程序运行时，计算机
将自动识别仪器。这需要几秒钟时间。识别出仪器后，计算机将显示 VISA 别
名、 IDN 字符串和 VISA 地址。

您还可以从前面板查看仪器的 VISA 地址。按 More 功能键，然后按 I/O > USB 
软键。 VISA 地址显示在 USB Status 对话框中。

4. 现在可以使用 Connection Expert 中的 Interactive IO 与仪器通信，或使用各种
编程环境对仪器进行编程。

 PC 
 USB 

 USB PC

USB 
94 Keysight B2900B/BL 系列用户指南，第 2 版



安装
连接到接口
LAN 接口

有关 LAN 接口连接的详细信息，请参阅随 Keysight IO Libraries 一起安装的连接
指南。

以下步骤将帮助您快速在局域网上连接和配置仪器。

连接到站点 LAN

站点 LAN 是这样一种局域网，其中支持 LAN 的仪器和计算机通过路由器、集线
器和 / 或交换机连接到网络。它们通常是大型、集中管理的网络，并提供如 
DHCP 和 DNS 等服务。

1. 如果尚未安装，请从产品附带的 CD 安装 Keysight IO Libraries Suite。

2. 将仪器连接到现场 LAN。仪器在出厂时， LAN 设置已配置为使用 DHCP 服务
器 （启用 DHCP）从网络自动获取 IP 地址。请注意，这可能需要 1 分钟。
DHCP 服务器将通过动态 DNS 服务器注册仪器的主机名。随后，可以使用此
主机名和 IP 地址与仪器通信。在成功配置 LAN 端口后前面板 LAN 指示灯将
变成绿色，或如果配置失败，该指示灯将变成红色。

如果您需要手动配置任何仪器 LAN 设置，请参阅第 148 页上的 “LAN 
Configuration 对话框”以了解有关从仪器前面板配置 LAN 设置的信息。

3. 使用 Keysight IO Libraries Suite 的 Connection Expert 实用程序添加 B2900 并
验证连接。要添加仪器，您可以请求 Connection Expert 查找此仪器。如果未
找到仪器，则可使用仪器的主机名或 IP 地址添加仪器。

如果找不到，请参阅连接指南 中的故障排除部分。

 (NIC)

 LAN 

PC

LAN 

 LAN
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4. 现在可以使用 Connection Expert 中的 Interactive IO 与仪器通信，或使用各种
编程环境对仪器进行编程。还可以使用计算机上的 Web 浏览器连接仪器，如
第 97 页上的 “使用图形 Web 界面”中所述。

查看活动 LAN 状态

要查看当前活动的 LAN 设置，请按 More 功能键，然后按 I/O > LAN > Status 软
键。将显示 LAN status 对话框。

请注意， IP 地址、子网掩码和默认网关等当前活动的 LAN 设置可能与在 LAN 
Configuration 对话框中指定的设置不同，这取决于网络配置。如果两者的设置不
同，是因为网络已自动分配自己的设置。

修改 LAN 设置

B2900 在出厂时预配置的设置对于大多数 LAN 环境应该都是有效的。如果需要
手动配置这些设置，请按 More 功能键，然后按 I/O > LAN > Config 软键。将显示 
LAN Configuration 对话框。

更改主机名后必须重新启动 B2900。

对于 LAN 设置参数，请参阅第 148 页上的 “LAN Configuration 对话框”。
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通过 LAN 通信

使用图形 Web 界面

Keysight B2900 源 / 测量单元有内置的图形 Web 界面，可用于从计算机上的 
Web 浏览器直接控制它。只允许一台计算机进行多个同时连接。如果连接增加，
性能将会降低。不允许多台计算机进行多个连接。

通过图形 Web 界面，您可以访问前面板控制功能，包括 LAN 配置参数。这样可
以方便地和 B2900 进行通讯，而无需使用 I/O 库或驱动程序。

内置图形 Web 界面只能通过 LAN 界面工作。它需要使用 Internet Explorer 6+ 或 
Firefox 2+。还需要 Java 插件。它包括在 Java 运行时环境中。请访问 Java 网站。

仪器出厂时已启用了图形 Web 界面。
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 启动图形 Web 界面：

1. 在计算机上打开 Web 浏览器。

2. 在浏览器的 “地址”字段中输入仪器的主机名或 IP 地址以启动图形 Web 界
面。将显示 B2900 主页。

3. 单击左侧导航栏中的 Browser Web Control 按钮，即可开始控制仪器。

4. 有关任何页面的更多帮助，请单击 “此页面的帮助”。

如果需要，可使用密码保护控制对图形 Web 界面的访问。密码在出厂时设置为 
Keysight 或 keysight。要更改密码，请单击 “查看和修改配置”按钮。有关设置
密码的其他信息，请参考联机帮助。

使用 Telnet
Telnet 实用程序（以及套接口）是不使用 I/O 库或驱动程序而与 B2900 通讯的另
一种方法。如前所述，在所有情况下都必须首先建立从计算机到 B2900 的 LAN 
连接。

在 MS-DOS 命令提示框中，输入 “telnet hostname 5024”，其中 hostname 是 
B2900 的主机名或 IP 地址， 5024 是仪器的 telnet 端口。您应看到 Telnet 会话
框，其中的标题指示您已连接到 B2900。在提示符下键入 SCPI 命令。

使用套接字

Keysight B2900 允许同时建立最多四个数据套接口、控制套接口或 telnet 连接的
任意组合。

Keysight 仪器统一将端口 5025 用于 SCPI 套接口服务。此端口上的数据套接字可
用于发送和接收 ASCII/SCPI 命令、查询和查询响应。所有命令必须以包含要分
析的消息的新行终止。所有查询响应也以新行终止。
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套接口编程接口还允许控制套接口连接。客户端可使用控制套接口发送设备清除
以及接收服务请求。与使用固定端口号的数据套接字不同，控制套接字的端口号
会改变，必须通过将以下 SCPI 查询发送到数据套接字来获取端口号：
SYSTem:COMMunicate:TCPip:CONTrol?

获取端口号之后，可打开控制套接口连接。与数据套接口相同，发送到控制套接
口的所有命令必须以新行终止，在控制套接口上返回的所有查询响应将以新行 
终止。

要发送设备清除请求，可向控制套接口发送字符串 “DCL”。在 B2900 完成设备
清除后，它会将字符串 “DCL”返回到控制套接口。

可使用服务请求启用寄存器为控制套接口启用服务请求。启用服务请求后，客户
端程序可在控制连接上侦听。如果 SRQ 变为真，仪器将字符串 “SRQ +nn”发
送到客户机。“nn”是状态字节值，客户端可以使用该值确定服务请求的电源。
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使用 Digital I/O

B2900 具有 Digital I/O 连接器，它是 D-sub 25 针母接头，适用于通用输入 / 输
出 (GPIO)。它可用于：

• 触发输入

• 触发输出

• 数字信号输入 / 输出

• 数字信号输入

• 测试开始 (SOT) 输入 （用于组件处理程序）

• 忙状态输出 （用于组件处理程序）

• 测试结束 (EOT) 输出 （用于组件处理程序）

• 联锁控制

• 高电压状态输出 （与数字信号输入 / 输出 DIO 14 共享）

Digital I/O 连接器的针脚分配如表 3-1 所示。可以将针脚 DIO 1 到 DIO 14 指定 
给上面的函数，但联锁控制除外。要设置 DIO 功能，请按 More 功能键，然后 
按 I/O > DIO > Config 软键。有关详细信息，请参见第 149 页上的 “DIO 
Configuration 对话框”。

图 3-14 显示在内部连接到 Digital I/O 连接器的每个针脚的输入 / 输出电路。

有关可用的附件，请参见第 102 页上的 “Digital I/O 连接器的附件”。

图 3-14 Digital I/O 内部电路
Vcc

 Digital I/O

R1

R2

Vcc: +5 V
R1: 5 kohm
R2: 100 ohm
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表 3-1 Digital I/O 针脚分配

说明 针脚编号 描述

5 V a

a. 电流限值：600 mA（针脚 22、23 和 25 的总电流）

25 13 DIO 13 （位 13）

联锁控制 b

b. 用于正逻辑。已连接到负逻辑的针脚 25。

24 12 DIO 12 （位 12）

5 V a 23 11 DIO 11 （位 11）

5 V a 22 10 DIO 10 （位 10）

GND 21 9 DIO 9 （位 9）

GND 20 8 DIO 8 （位 8）

GND 19 7 DIO 7 （位 7）

GND 18 6 DIO 6 （位 6）

GND 17 5 DIO 5 （位 5）

联锁控制 c

c. 用于负逻辑。已连接到正逻辑的针脚 17。

16 4 DIO 4 （位 4）

GND 15 3 DIO 3 （位 3）

DIO 14 （位 14）或高电压

状态

14 2 DIO 2 （位 2）

1 DIO 1 （位 1）
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Digital I/O 连接器的附件

以下附件可用于 Digital I/O 连接器。

• Keysight N1294A-031 GPIO-BNC 触发适配器

此适配器用于将 Digital I/O 连接器更改为触发输入 / 输出 BNC 连接器。BNC 
连接器已内部连接到 DIO 针脚 9 和 10。

此适配器可以直接连接到 Digital I/O 连接器。

图 3-15 N1294A-031 GPIO-BNC 触发适配器

联锁端子

如果 N1294A-031 适配器连接到 Digital I/O 连接器，则会打开联锁端子。这样会
将仪器的输出电压限制为 42 V。

要使用联锁功能，请参见第 90 页上的 “安装联锁电路”并扩展 Interlock 端子。
可以通过打开适配器顶盖，从适配器内板扩展这些端子。

N1294A Opt 031
GPIO-BNC Trigger Adapter

DIO 10 DIO 9
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如果未正确执行测量，请检查触发设置。必须将触发类型设置为 AUTO，或者必
须正确地设置触发计数 (Count)。请参见第 118 页上的“触发参数”。
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硬键和旋钮

待机开关 开启或关闭仪器。接通电源后，开关下方的 LED 指示灯会变为绿色。 

Trigger 启动单次 （一次）输出 / 测量或启动触发系统。如果正在进行重复测量，需停止
进行。

对为通道设置的 DC 偏置输出、阶梯扫描输出、脉冲偏压输出、脉冲扫描输出执
行单次测量。对于 B2900 （B2901BL 除外），单次测量最多可以包含 100000 个
测量点，对于 B2901BL，最多可以包含 10000 个测量点。

单次测量启动后，即会清除数据缓冲区，并且将最后的单次测量结果存储在缓冲
区中。 B2900 （B2901BL 除外）的最大数据缓冲区为 100000， B2901BL 的最 
大数据缓冲区为 10000。测量结果会显示在 Single 视图、Dual 视图、Graph 视图
或 Roll 视图上。最后的单次测量结果还可以列在和显示在 Measure Result 对话
框上。

Auto 启动重复 （连续）测量。如果正在进行重复测量，需停止进行。对 Source 值的 
DC 偏置输出进行重复测量。测量结果会显示在 Single 视图、Dual 视图或 Roll 视
图上。重复测量结果不会存储在缓冲区中。

使用以下触发设置执行重复测量。将忽略 “触发参数” 的设置。 

• 采集触发 （测量触发）：Initiate

• ARM 采集计数：无限

• ARM 采集源：AUTO （内部自动）

• TRIGger 采集计数 （测量计数） 100

• TRIGger 采集源 （测量触发）：AUTO （内部自动）

• TRIGger 采集定时器周期 （测量周期）：10 ms （如果未完成测量，则自动延
长此时间。）

• 触发延迟 （电源延迟 = 测量延迟）：0 s

• 触发输出：禁用

View 更改显示模式。请参见第 107 页上的 “显示屏和辅助键”。
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Cancel/Local 如果仪器处于本地状态，则取消设置操作。如果仪器处于远程状态，则使其返回
本地状态。

On/Off 用于启用或禁用 SMU 通道。如果通道处于输出状态，则将其关闭，即使它处于
远程状态也是如此。单通道型号上有一个开关，双通道型号上有两个开关。

如果通道已启用，开关将变为绿色。

如果通道处于高电压状态，开关将变为红色。

数字 / 字母键 用于输入设置参数的值，如字段指针指定的源输出值、限值 （合规性值）和消
息。如果字段指针处于 EDIT （绿色）状态，则可以更改该值。

旋钮 如果字段指针处于 MOVE （蓝色）状态，转动旋钮可移动指针。按旋钮可固定指
针位置，并使指针状态变为 EDIT （绿色）。

如果字段指针处于 EDIT （绿色）状态，转动旋钮可更改由指针指定的设置参数
的值。按旋钮可固定该值，并使指针状态变为 MOVE （蓝色）。

如果在除 Source 字段和 Limit（合规性）字段以外的设置字段中，字段指针处于 
EDIT （绿色）状态，转动旋钮可更改设置值。按下旋钮可应用该值。

如果 Source 或 Limit 字段上的字段指针处于 EDIT （绿色）状态，则转动旋钮会
更改显示值并实时更新源通道输出。当然，如果有数字指针可用，则源通道的操
作取决于实时更新的设置 （Immediate V/I Update by Knob 字段的设置）。关于 
Immediate V/I Update by Knob 字段，请参见第 152 页上的 “Display Preference 
对话框”。

如果数字指针在数值输入字段的数字上，转动旋钮可更改该数字的值。请注意，
将值从 9 更改为 0 或从 0 更改为 9 将会更改下一个数字的值。

当数字指针在数值输入字段的小数点上时，如果 Immediate V/I Update by Knob 
设置为 OFF，则转动旋钮可移动小数点。
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向左和向右键 如果字段指针处于 MOVE （蓝色）状态，按这些键可移动指针。

如果字段指针处于 EDIT （绿色）状态，按下该键可更改由指针指定的设置参数
的值。

如果字段指针在数值输入字段中处于 EDIT （绿色）状态，按下该键可将指针更
改为数字指针。

如果数字指针在数值输入字段的数字上，按下该键可移动数字上的指针。
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显示屏和辅助键

Keysight B2900 提供了几种显示模式，具体取决于型号，如下所示。可使用 View 
键更改显示模式按该键可更改模式，如下所示。

• B2901BL、 B2910BL 和 B2901B

Single  Graph （返回 Single）

• B2902B

Dual  Single （对于通道 1） Single （对于通道 2） Graph （返回 
Dual）

• B2911B

Single  Graph  Roll （返回 Single）

• B2912B

Dual  Single （对于通道 1） Single （对于通道 2） Graph  Roll 
（返回 Dual）

对于每种显示模式，可使用显示屏右侧的 5 个辅助键。它们已指定给多个软键，
如 Mode、 Source、 Limit、 Measure 和 More。软键指定取决于显示模式。

对于每个显示模式和辅助键的详细信息，请参加以下各部分。

• “Dual 视图”

• “Single 视图”

• “Graph 视图”

• “Roll 视图”

• “状态信息”

状态信息对于所有显示模式是通用的。它显示在与功能键相关的底部软键上方。
此显示区域也可用于显示系统消息和错误消息。
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Dual 视图

在 B2902B 和 B2912B 上提供。上半部分适用于通道 1。下半部分适用于通道 2。
每个区域都显示测量结果，源和测量设置以及通道状态。可在此显示中编辑大部
分设置参数。

显示区域 1. 通道编号。 1 或 2。

2. 最新测量数据

3. 过电压 / 过电流状态指示灯 （OV 或 OC，红色）

4. 高电容模式指示器 (HC)

5. 远程感应 （四线制连接）状态指示器

6. 源功能。 VOLTS 或 AMPS。

7. 源形状指示器。 DC、脉冲、扫描或脉冲扫描。 DC 不显示指示器。

8. 电源输出值，读数分辨率在 B2902B 上为 5½，在 B2912B 上为 6½

9. Limit (Compliance) 值。关于如何设置 V/I Limit for Each Polarity，请参见 
第 152 页上的 “Display Preference 对话框”。

D1。主测量数据。在数据超过限值时变为橙色。

D2。辅助测量数据。在数据超过限值时变为橙色。

对于限值测试， D2 显示 PASS 或 FAIL 而非测量数据。

1 2 4 5 6 7 8 9

D1

D2

D1

D2

3
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辅助键 在以下说明中， Ch n 表示 Ch 1 或 Ch 2。

Ch n Mode 将辅助键更改为 VOLTS (V) 和 AMPS (I)，以用于选择源功能。

VOLTS (V) 设置电压源。

AMPS (I) 设置电流源。

Ch n Source 将辅助键更改为单元键，如下所示。

对于电压源，为 V、 mV 和 V

对于电流源，为 pA、 nA、 A、 mA 和 A

首先，通过使用数字 / 字母键、旋钮和箭头键来输入或设置输
出值。然后按其中一个单元键来应用值。

Ch n Limit 将辅助键更改为单元键，如下所示。

对于电流合规性，为 pA、 nA、 A、 mA 和 A

对于电压合规性，为 V、 mV 和 V

首先，通过使用数字 / 字母键、旋钮和箭头键来输入或设置限
值。然后按其中一个单元键来应用值。

Ch n Measure 将辅助键更改为 AMPS (I)、 VOLTS (V)、 OHMS (R) 和 WATTS 
(P)，以用于选择测量功能。

AMPS (I) 设置电流测量。

VOLTS (V) 设置电压测量。

OHMS (R) 设置电阻测量。

WATTS (P) 设置功率测量。

电阻数据根据 Resistance = Vmeas/Imeas 得出。

功率数据根据 Power = VmeasImeas 算出。

在上面的公式中，Vmeas 是电压测量数据， Imeas 是电流测量
数据。

有关使用电阻补偿的详细信息，请参见第 205 页上的 “电阻
补偿”。

More... 将辅助键更改为 Ch 1 辅助键或 Ch 2 辅助键。 Ch 1 辅助键对通
道 1 有效。 Ch 2 辅助键对通道 2 有效。
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Single 视图

显示测量结果，源和测量设置以及通道状态。可在此显示中编辑大部分设置参
数。显示屏下半部分将显示由辅助键 2 选择的设置参数。

显示区域 1. 通道编号。 1 或 2。

2. 最新测量数据

3. 过电压 / 过电流状态指示灯 （OV 或 OC，红色）

4. 高电容模式指示器 (HC)

5. 远程感应 （四线制连接）状态指示器

6. 源功能。 VOLTS 或 AMPS。

7. 源形状指示器。 DC、脉冲、扫描或脉冲扫描。 DC 不显示指示器。脉冲和脉
冲扫描不适用于 B2901BL 和 B2910BL。

8. 源输出值，读数分辨率在 B2901BL、 B2910BL、 B2901B 和 B2902B 上为 
5½，在 B2911B 和 B2912B 上为 6½

9. Limit (Compliance) 值。关于如何设置 V/I Limit for Each Polarity，请参见 
第 152 页上的 “Display Preference 对话框”。

10.测量速度。 AUTO、 SHORT、 MEDIUM、 NORMAL、 LONG 或 MANUAL。

11.孔径时间以秒或 PLC （电源线周期，每次测量的电源线周期数）为单位。仅
适用于 MANUAL 速度。

D1。主测量数据。在数据超过限值时变为橙色。

D2。辅助测量数据。在数据超过限值时变为橙色。

1 2 4 5 6 7

10 11

D1

D2

3 98
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对于限值测试， D2 显示 PASS 或 FAIL 而非测量数据。 B2901BL 不能进行限值 
测试。

辅助键 1 Mode 将辅助键更改为 VOLTS (V) 和 AMPS (I)，以用于选择源功能。

VOLTS (V) 设置电压源。

AMPS (I) 设置电流源。

Source 将辅助键更改为单元键，如下所示。

对于电压源，为 V、 mV 和 V

对于电流源，为 pA、 nA、 A、 mA 和 A

首先，通过使用数字 / 字母键、旋钮和箭头键来输入或设置输
出值。然后按其中一个单元键来应用值。

Limit 将辅助键更改为单元键，如下所示。

对于电流合规性，为 pA、 nA、 A、 mA 和 A

对于电压合规性，为 V、 mV 和 V

首先，通过使用数字 / 字母键、旋钮和箭头键来输入或设置限
值。然后按其中一个单元键来应用值。

测量 将辅助键更改为 AMPS (I)、 VOLTS (V)、 OHMS (R) 和 WATTS 
(P)，以用于选择测量功能。

AMPS (I) 设置电流测量。

VOLTS (V) 设置电压测量。

OHMS (R) 设置电阻测量。

WATTS (P) 设置功率测量。

电阻数据根据 Resistance = Vmeas/Imeas 得出。

功率数据根据 Power = VmeasImeas 算出。

在上面的公式中，Vmeas 是电压测量数据， Imeas 是电流测量
数据。

有关使用电阻补偿的详细信息，请参见第 205 页上的 “电阻
补偿”。

More... 将辅助键更改为辅助键 2。
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辅助键 2 速度 将辅助键更改为 AUTO （对于 10 nA 和 100 nA 量程为 1 PLC，
对于其他量程为 0.01 PLC）、 SHORT (0.01 PLC)、 MEDIUM 
(0.1 PLC)、NORMAL (1 PLC)、LONG (10 PLC) 或 MANUAL，以
用于选择测量速度。孔径时间自动设置为上面括号中的值。对
于孔径时间，请参阅第 194 页上的 “测量时间”。

对于 MANUAL 速度，孔径时间必须设置到正确的字段，以秒
或 PLC （电源线周期，每次测量的电源线周期数）为单位。
使用箭头键或旋钮移动字段指针，然后按旋钮将指针设置为 
EDIT 模式。使用数字 / 字母键、旋钮或箭头键输入或设置值，
然后按下旋钮或单位键之一应用该值。设置秒值时，可使用以
下单位键作为辅助键。

S、 ms 和 s

Show Sweep 显示扫描设置参数，如第 114 页上的 “扫描参数”中所示，
并将软键标签更改为 Hide Sweep。

Hide Sweep 显示量程设置参数，如第 113 页上的 “量程参数”中所示，
并将软键标签更改为 Show Sweep。

Show Pulse 显示脉冲设置参数，如第 117 页上的 “脉冲参数”中所示，
并将软键标签更改为 Hide Pulse。脉冲不适用于 B2901BL 和 
B2910BL。

Hide Pulse 显示量程设置参数，如第 113 页上的 “量程参数”中所示，
并将软键标签更改为 Show Pulse。脉冲不适用于 B2901BL 和 
B2910BL。

Show Trigger 显示触发设置参数，如第 118 页上的 “触发参数”中所示，
并将软键标签更改为 Hide Trigger。

Hide Trigger 显示量程设置参数，如第 113 页上的 “量程参数”中所示，
并将软键标签更改为 Show Trigger。

More... 将辅助键更改为辅助键 1。

按下该键可切换软键标签 Show XXXX 和 Hide XXXX。
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量程参数

可使用以下设置参数。 Source 或 Measure XXXX 由电源设置确定。

Source Volts: 
Spot 用于电压源。对于恒定电压输出和源端电压测量，将量程操作

选择为 AUTO （自动量程调整）或 FIXED （固定量程）。

Measure Amps 用于电压源。对电流测量选择量程操作 AUTO 或 FIXED。

Source Amps: 
Spot 用于电流源。对恒定电流输出和源端电流测量选择量程操作 

AUTO 或 FIXED。

Measure Volts 用于电流源。对电压测量选择量程操作 AUTO 或 FIXED。

右侧字段用于为 FIXED 量程操作设置量程值，或为 AUTO 量程操作设置最小量程
值。有关可用的量程值，请参阅第 51 页上的 “输出和测量量程”。

如果量程操作模式为 AUTO，则通道将自动使用会为源输出值或测量值提供最佳
分辨率的量程。 

如果脉冲输出为 ON 且量程操作为 AUTO，则测量通道将使用覆盖限值 （合规性
值）的最小量程。

Measure Ohms 将电阻测量操作选择为 AUTO、 FIXED 或 V/I。 

右侧字段用于为 FIXED 操作设置电阻测量量程值，或为 AUTO 操作设置最小和最
大量程。有关可用的量程值，请参阅第 58 页上的表  2-9。此设置字段不适用于 
V/I 操作。

对于 AUTO 和 FIXED，通道使用由电阻测量量程设置自动设置的电流源和电压测
量条件来执行电阻测量。 

对于 V/I，通道使用当前源 / 测量条件来执行测量，电阻值根据 V/I 计算得出。
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扫描参数

B2900 可以用作扫描源，并支持以下扫描操作。可使用当字段指针在 Sweep 
Parameters 字段中处于 EDIT （绿色）状态时所显示的辅助键来选择该操作。

• LINEAR SINGLE：以线性增量步长从起点扫描到终点。

• LINEAR DOUBLE：以线性增量步长从起点扫描到终点再到起点。

• LOG SINGLE：以对数增量步长从起点扫描到终点。

• LOG DOUBLE：以对数增量步长从起点扫描到终点再到起点。

• LIST：扫描在列表扫描设置列表中定义的值。请参见第 114 页上的 “列表扫
描设置”。

可使用以下设置参数。

Start 设置扫描开始值。

Stop 设置扫描结束值。

Points 设置扫描步长数。

Step 设置扫描步长值 （增量步长值）。不适用于 LOG 和 LIST 扫描
操作。

当字段指针在输入字段中处于 EDIT （绿色）状态时，辅助键将更改为单元键，
如下所示。

• pA、 nA、 A、 mA 和 A （电流扫描）

• V、 mV 和 V （电压扫描）

有关扫描源的量程操作，请参阅第 130 页上的 “Sweep 对话框”。量程参数 
Source Volt: Spot 和 Source Amps: Spot 对于扫描源的 AUTO 和 BEST 量程操作无效。
它们对恒定源和扫描源的 FIXED 量程操作有效。

列表扫描设置 当字段指针在 LIST 扫描 Start/Stop/Points 字段中处于 EDIT （绿色）状态时，可
使用以下辅助键设置列表扫描源。

Edit 打开用于设置列表扫描源的 List Sweep 对话框。

Load 打开 Load List Sweep Data 对话框，以从连接到前面板 USB-A 
连接器的 USB 存储器加载列表扫描数据。
114 Keysight B2900B/BL 系列用户指南，第 2 版



前面板参考
显示屏和辅助键
• “列表扫描”对话框

此对话框提供用于设置列表扫描源的以下字段。列表完成后，按 OK 以应用数
据并关闭对话框。

（数据图形） 显示列表扫描输出的形状

（数据列表） 列出左侧单元格中的数据索引和右侧单元格中的输出值。

当指针处于 MOVE 状态时，指针可以横向移动。按下旋钮
会将状态更改为 EDIT。

当右侧单元格处于 EDIT 状态时，可以将输出值输入该单 
元格。

当左侧单元格处于 EDIT 状态时，可使用以下辅助键创建和
滚动列表。这时指针可以纵向移动。按下旋钮会将状态更
改为 MOVE。

Append 在下面添加一行。右侧单元格中会输入相同
的输出值。 

Insert 在上面添加一行。右侧单元格中会输入相同
的输出值。

Delete 删除相应行。

Scroll -100 将指针移动到上面最多 100 个点。

Scroll +100 将指针移动到下面最多 100 个点。

Type 数据类型 V （电压）或 I （电流）

CH 通道编号 1 或 2，仅在双通道型号上

Points 数据点数

Max 最大值

Min 最小值
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• Load List Sweep Data 对话框

此对话框提供以下字段，以从存储在 USB 存储器中的文件调用列表扫描数
据。突出显示某文件并按 OK 可调用数据并关闭对话框。

（数据图形） 显示由文件列表选择的列表扫描数据的形状

（文件列表） 列表扫描数据文件的列表

Path 用于保存列表扫描数据文件的文件夹。

Points 数据点数

Max 最大值

Min 最小值

以下数据可作为列表扫描数据调用。

• 逗号分隔值格式，文件扩展名为 csv

例如，

0.0,0.1,0.2,0.3

• 回车符或换行符分隔值格式，文件扩展名为 txt

例如，

0.0
0.1
0.2
0.3

• 行中空格分隔值格式，文件扩展名为 prn

例如，

0.0 0.1 0.2 0.3
116 Keysight B2900B/BL 系列用户指南，第 2 版



前面板参考
显示屏和辅助键
脉冲参数

B2900 （B2901BL 和 B2910BL 除外）可用作脉冲源，并支持脉冲输出和测量。
可使用当字段指针在 Pulse 字段中处于 EDIT （绿色）状态时所显示的辅助键来
选择脉冲 ON 或 OFF。

可使用以下设置参数。

Peak 设置脉冲峰值。不适用于将扫描输出值设置为脉冲峰值的扫 
描源。 

脉冲基值由显示区域上半部分中的 Source 字段设置。请参见
第 110 页上的 “Single 视图”。

Delay 设置脉冲延迟时间。在触发延迟之后的延迟时间过后，脉冲源
将输出电平从基值更改为峰值。

Width 设置脉冲宽度。

当字段指针在输入字段中处于 EDIT （绿色）状态时，辅助键将更改为单元键，
如下所示。

pA、 nA、 A、 mA 和 A （峰值电流）

V、 mV 和 V （峰值电压）

S、 ms、 s 和 ks （延迟和宽度）

通过触发执行的通道操作

如果某通道设置为 Pulse: On，则通道会在收到触发时向 Peak、 Delay 和 Width 
字段输出脉冲设置。

如果某通道设置为 Pulse: OFF，则通道会在收到触发时向 Peak 字段应用偏置设
置。 Delay 和 Width 字段的设置将被忽略。

Peak 字段对应于 [:SOUR]:<CURR|VOLT>[:LEV]:TRIG[:AMPL] 命令。 
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触发参数

B2900 支持以下触发类型以进行触发源输出和测量。使用它们可以轻松而有效地
设置触发。

可使用当字段指针在 Trigger 字段中处于 EDIT （绿色）状态时所显示的辅助键来
选择触发类型。有关触发类型和设置参数，请参阅表 4-1。 

AUTO 自动触发类型

SYNC 同步触发类型

TIMER 定时器触发类型

MANUAL 手动触发类型

可使用 Source 列通过以下设置参数设置源输出触发 （瞬时操作），并使用 
Measure 列设置测量触发 （采集操作）。

Count 触发计数 （触发数）。 1 至 100000 或 INF. （无限），对于 
B2901B、B2902B、B2911B 和 B2912B ； 1 至 100000，对于 
B2910BL ；以及 1 至 10000，对于 B2901BL。触发类型为 
AUTO 时，会自动设置此值。对于其他触发类型，请正确设置
每个源输出和测量所需的触发数目。例如，对于 10 个步骤的
扫描测量，设置 Source Count = Measure Count = 10

Delay 设置触发延时。

Period 设置触发周期。

Trigger 通过使用辅助键 AUTO、BUS、TIMER、 INTm（仅适用于双通
道型号）、LAN 或 EXTn 选择触发源，其中 m 是整数 1 或 2，n 
是介于 1 和 14 之间的整数。有关触发源，请参阅表 4-1。

当字段指针在 Delay 或 Period 字段中处于 EDIT （绿色）状态时，辅助键将更改
为单位键：s、 ms、 s 和 ks。
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表 4-1 触发类型和设置参数

Trigger = AUTO，通过使用内部算法，自动选择最适合当前操作模式的触发源。 

Trigger = BUS，使用远程接口触发命令，如 GET、 TRIGger 和 *TRG。 

Trigger = TIMER，使用在每个间隔处由内部生成的信号，该间隔由 Period 参数 
设置。 

Trigger = INT1 或 INT2，分别使用来自内部总线 1 或 2 的信号。

Trigger = LAN，使用 LXI 触发。

Trigger = EXTn，使用来自 DIO 针脚 n 的信号，这是后面板上 Digital I/O D-sub 
连接器的输出端口， n = 1 至 14。

详细设置触发参数

有关触发系统的详细信息，请参阅第 218 页上的图 6-8。

Single 视图提供轻松而有效地设置触发的触发类型和参数。如果要详细设置触发
参数，可选择 MANUAL 触发类型并使用通过按 Trigger > Config 功能键打开的 
Trigger Configuration 对话框。请参见第 138 页上的 “Trigger 键组”。

Single 视图不包含用于接通层的设置参数，但包含用于触发层的设置参数。在 
Trigger Configuration 对话框中， Single 视图设置的优先级高于触发层设置。因
此，将忽略该对话框中重叠的参数值。

Type Count Delay Period Trigger

AUTO 自动设置 0 秒 不适用 AUTO

SYNC 输入的值 输入的值 不适用 AUTO

TIMER 输入的值 输入的值 输入的值 TIMER

MANUAL 输入的值 输入的值 输入的值 选定的值
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Graph 视图

显示绘制通道 1 和 / 或 2 测量或数学运算结果的图形。 Graph 视图最多可绘制 
5000 条数据。

显示区域 1. Graph 显示状态 ON 或 OFF。仅在双通道型号上。 [n] 表示通道 n。

2. Y 轴数据类型 I (A)、 V (V)、 R ()、 P (W) 或 MATH （请参见表 4-2）

3. Y 轴定标 LINEAR 或 LOG 

4. X 轴数据类型 I (A)、V (V)、R ()、P (W)、MATH、 t (s)、V1 或 V2（请参见 
表 4-2）

5. X 轴定标 LINEAR 或 LOG 

6. 图形最大值 

7. 图形最小值 

8. 通道 1 和 / 或 2 源输出值、限值或无 （由 Ch n Source、 Ch n 或 Hide Ch n 
辅助键控制）

9. 活动 X 光标位置处的通道 1 和 / 或 2 Y 轴数据对于无数据 位置显示 ----.----。

10.光标数据 （由 Show Cursors 或 Hide Cursors 辅助键控制）

第一行 Y 光标 1 和 2 的位置和距离 （例如 I1、 I2、 A）

第二行 X 光标 1 和 2 的位置和距离 （例如 t1、 t2、 t）

1 2 3 4 5

6

7

8

9

10
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表 4-2 Graph 视图的 X 和 Y 轴数据类型

辅助键 Auto Scale 更改图形定标以自动适合图形中的迹线。

Dump Screen 打开 File Selection (Dump Screen) 对话框，该对话框用于将屏
幕转储保存到 JPEG 文件。

可将该文件保存到已与前面板 USB-A 连接器连接的 USB 存储
器中。可用指定的名称保存该文件。如果未指定文件扩展名，
则自动添加 “.jpg”。

Show Cursors 显示光标（Y 光标 1 和 2、 X 光标 1 和 2 以及光标数据）并将
软键标签更改为 Hide Cursors。

Hide Cursors 隐藏光标并将软键标签更改为 Show Cursors。

Ch n Source 显示通道 n 源输出值，并将软键标签更改为 Ch n Limit。

Ch n Limit 隐藏通道 n 源输出值并显示限值，还会将软键标签更改为 Hide 
Ch n。

Hide Ch n 隐藏通道 n 限值，并将软键标签更改为 Ch n Source。

在以上说明中， Ch n 表示 Ch 1 或 Ch 2。

数据类型 辅助键 描述

I (A) AMPS (I) 电流测量数据

V (V) VOLTS (V) 电压测量数据

R () OHMS (R) 电阻测量数据

P (W) WATTS (P) 功率测量数据

MATH MATH 数学运算结果数据

t (s) TIME (t) 时间数据。仅适用于 X 轴数据。

V1 Ch 1 V (V1) 仅在双通道型号上。通道 1 或 2 的电压数据。

仅适用于 X 轴数据。V2 Ch 2 V (V2)
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如果数据的条数超出 5000

如果测量数据的条数超出 5000，则 Graph 视图和 Roll 视图会绘制以下数据。其
中， n 是从 1 至 5000 的整数。

数据的条数为 5001 至 10000：第 [2*(n-1)+1] 条数据

数据的条数为 10001 至 25000：第 [5*(n-1)+1] 条数据

数据的条数为 25001 至 50000：第 [10*(n-1)+1] 条数据

数据的条数为 50001 至 100000：第 [20*(n-1)+1] 条数据

Roll 视图

适用于 B2911B 和 B2912B。显示时域图，用于绘制通道 1 和 / 或 2 测量数据。
有关 Y 轴数据类型，请参阅表 4-3。 Roll 视图最多可绘制 5000 条数据。

1 2 3 4

5 6 7

8

9

10
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显示区域 1. 在 B2911B 上，显示状态 ON 或 OFF

对于 B2912B，显示状态 Ch 1、 Ch 2 或 OFF

可在图中显示两行。 [1] 表示行 1 的图形设置。 [2] 表示行 2 的图形设置。

2. Y 轴数据类型 I、 V、 R 或 P。

3. 每格的 Y 轴定标 A/div.、 /div. 或 W/div.

4. 每格 X 轴定标 s/div.

5. X 轴最小值 （最小时间戳）

6. 行 1 和 2 的 Y 轴偏移值

7. X 轴最大值 （最大时间戳）

8. 通道 1 和 / 或 2 源输出值、限值或无（由 Ch n Source、Ch n 或 Hide Ch n 辅
助键控制）

9. 活动 X 光标位置处的通道 1 和 / 或 2 Y 轴数据对于无数据 位置显示 ----.----。

10.光标数据 （由 Line 1 Cursors、 Line 2 Cursors 或 Hide Cursors 辅助键控制）

第一行 Y 光标 1 和 2 的位置和距离 （例如 I1、 I2、 A）

第二行 X 光标 1 和 2 的位置和距离 （例如 t1、 t2、 t）

表 4-3 Roll 视图的 Y 轴数据类型

数据类型 辅助键 描述

I AMPS (I) 电流测量数据

V VOLTS (V) 电压测量数据

R OHMS () 电阻测量数据

P WATTS (P) 功率测量数据
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辅助键 Auto Scale 更改图形定标以自动适合图形中的迹线。

Dump Screen 打开 File Selection (Dump Screen) 对话框，该对话框用于将屏
幕转储保存到 JPEG 文件。

可将该文件保存到已与前面板 USB-A 连接器连接的 USB 存储
器中。可用指定的名称保存该文件。如果未指定文件扩展名，
则自动添加 “.jpg”。

Line 1 Cursors 显示行 1 的光标 （Y 光标 1 和 2、 X 光标 1 和 2 以及光标数
据）并将软键标签更改为 Line 2 Cursors。

Line 2 Cursors 显示行 2 的光标 （Y 光标 1 和 2、 X 光标 1 和 2 以及光标数
据）并将软键标签更改为 Hide Cursors。

Hide Cursors 隐藏光标并将软键标签更改为 Line 1 Cursors。

Ch n Source 显示通道 n 源输出值，并将软键标签更改为 Ch n Limit。

Ch n Limit 隐藏通道 n 源输出值并显示限值，还会将软键标签更改为 Hide 
Ch n。

Hide Ch n 隐藏通道 n 限值，并将软键标签更改为 Ch n Source。

在以上说明中， Ch n 表示 Ch 1 或 Ch 2。
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状态信息

状态信息对于所有显示模式是通用的。它显示在与功能键相关的底部软键上方。

表 4-4 状态指示器

标签 颜色 描述

AUTO 白色 触发自动。当前启用了自动触发。

ARM 白色 触发活动。触发系统当前处于活动状态。

HV 黄色 高电压。输出电压设置超过 42 V。

通道 1 浮动状态。通道 1 未接地。

通道 2 浮动状态。通道 2 未接地。

REM 白色 远程。仪器处于远程状态。

本地锁定。 
仪器处于本地锁定 (LLO) 状态。

ERR 白色 错误。至少检测到一个错误。

EDIT 绿色 编辑模式。可编辑由指针指定的字段。未处于移动 
模式。

MOVE 蓝色 移动模式。可移动字段指针。未处于编辑模式。

LAN 绿色或
红色

LXI LAN 状态指示器。绿色表示 LAN 状态正常。红色表

示状态异常。闪烁表示 LAN 标识状态。

D 白色 显示屏模式：Dual 视图

1 白色 显示屏模式：通道 1 的 Single 视图

2 白色 显示屏模式：通道 2 的 Single 视图

G 白色 显示屏模式：Graph 视图

R 白色 显示屏模式：Roll 视图
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功能键

Keysight B2900 的前面板显示屏下方有 6 个功能键，并提供以下软键。

功能键 1 Config SMU 配置设置。显示用于设置 SMU 的多个功能的软键。请参
见第 127 页上的 “Config 键组”。

Function 数学运算、限值测试和迹线功能设置。显示用于设置这些功能
的软键。请参见第 133 页上的 “Function 键组”。

Trigger 触发配置和控制。显示用于设置和控制触发系统的软键。请参
见第 138 页上的 “Trigger 键组”。

Result 测量、限值测试和迹线结果显示。显示用于显示这些结果的软
键。请参见第 141 页上的 “Result 键组”。

File 文件操作。显示用于保存和加载文件的软键。请参见第 144 页
上的 “File 键组”。

More... 将功能键更改为功能键 2。

功能键 2 Program 对配置和控制编程。显示用于设置和控制程序存储器的软键。
请参见第 145 页上的 “Program 键组”。

I/O I/O 设置。显示用于设置 I/O 接口的软键。请参见第 146 页上
的 “I/O 键组”。

显示屏 显示设置。显示用于设置显示功能的软键。请参见第 151 页上
的 “Display 键组”。

System 系统设置。显示用于多个系统设置的软键。请参见第 153 页上
的 “System 键组”。

LED 演示 用于演示。如果 LED 连接在 High Force 和 Low Force 端子之
间，则按下 OK 将启动 LED IV 测量演示。

More... 将功能键更改为功能键 1。
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Config 键组

按 Config 键可显示用于设置 SMU 多种功能的以下软键。

Source 显示用于设置 SMU 源操作的以下软键。

Connection 通道操作和连接设置。请参见第 129 页上的 “Output 
Connection 对话框”。

Filter 输出滤波器设置。请参见第 128 页上的 “Output Filter 对话
框”。

Sweep 扫描源详细设置。请参见第 130 页上的 “Sweep 对话框”。

测量 显示用于设置 SMU 测量操作的以下软键。

R Compen 电阻补偿 ON 或 OFF。请参见第 205 页上的 “电阻补偿”。

在单通道型号上，按下该键可显示用于将电阻补偿设置为打开
或关闭的 ON 和 OFF 键。

在双通道型号上，按下该键可显示 ALL、 Ch 1 和 Ch 2 键。可
使用这些键指定用于开启或关闭电阻补偿的通道。

ALL 可指定通道 1 和 2。

Ch 1 仅指定通道 1。

Ch 2 仅指定通道 2。

Ranging 测量量程详细设置。请参见第 131 页上的 “Ranging 对话
框”。

Common 显示用于设置 SMU 其他功能的以下软键。

Wait 源和测量等待时间设置。请参见第 132 页上的 “Wait Control 
对话框”。

Group 仅在双通道型号上。通道分组 ON 或 OFF。如果此功能为 
ON，则通道将执行同步通道操作。当前设置由软键标签上的
星号指示。
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Save、 Recall 保存 / 调用 B2900 的所有设置信息。内置的非易失性存储器 (NVRAM) 中有五个
用于此目的的存储区域。

按 Save 或 Recall 软键可显示用于选择存储区域的软键 #1、 #2、 #3、 #4 和 #5。
按软键可保存或调用设置信息。

Output Filter 对话框

此对话框提供用于设置输出滤波器的以下参数。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Filter State 输出滤波器 ON 或 OFF

将滤波器设置为 ON 可获取干净的源输出，没有尖峰和过冲。
但请注意，使用滤波器可能会使 SMU 的稳定时间延长。

Automatic Filter 自动滤波器 ON 或 OFF

将该功能设置为 ON 以自动设置输出滤波器，该滤波器可提供
最佳滤波器特征和截止频率。

时间常数 滤波器时间常数， 5 s 至 500 s
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Output Connection 对话框

此对话框提供用于设置通道操作和连接的以下参数。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Sensing Type 二线制连接 (2-WIRE) 或四线制连接 (4-WIRE)。为远程感应设
置 4-WIRE。

低电平端子 
状态 Low Sense 端子连接。接地 (GROUND) 或浮动 (FLOAT)

高电容模式 高电容模式 ON 或 OFF

将此模式设置为 ON 可执行高容量负载测量。请参见第 204 页
上的 “高电容模式”。

过电压 / 电流 
保护 过电压或电流保护 ON 或 OFF

将该功能设置为 ON，以在通道输出达到其合规性时立即自动
关闭。

输出关闭状态 高阻抗 (HIGH Z)、正常 (NORMAL) 或零伏 (ZERO)

这是输出关闭后的源设置条件。请参见第 202 页上的表  6-1。

Auto Output-On 自动输出打开功能 ON 或 OFF

将该功能设置为 ON 时，可在 SCPI 命令而不是前面板操作启
动触发系统之前自动打开通道输出。

Auto Output-Off 自动输出关闭功能 ON 或 OFF

将该功能设置为 ON 时，可在所有触发系统的状态从忙变为空
闲时，立即自动关闭通道输出。
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Sweep 对话框

此对话框提供以下用于设置扫描源操作的详细信息的参数。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Sweep Ranging 用于扫描源操作的量程调整模式。 BEST、 AUTO 或 FIXED。 
请参见第 130 页上的表  4-5。

Sweep Direction UP （开始到停止方向）或 DOWN （停止到开始方向）

扫描后输出 源通道完成扫描输出后应用的值

START VALUE (START)：源通道将在应用扫描输出开始值之前
将输出更改为 DC 输出值。

END VALUE (END)：源通道在扫描输出停止时保持输出值。

表 4-5 用于扫描源操作的量程调整模式

描述

BEST 在线性扫描模式中，扫描源通道会自动使用覆盖整个扫描输
出的最小量程。

在日志扫描模式中，扫描源通道会自动使用为每个扫描步骤
输出提供最佳分辨率的量程。

AUTO 扫描源通道自动更改并设置量程，它提供为每个扫描步长应
用源输出的最佳分辨率。

FIXED 扫描源通道设置由量程参数 Source Volts: Spot 或 Source Amps: 
Spot 指定的量程。请参见第 113 页上的 “量程参数”。
130 Keysight B2900B/BL 系列用户指南，第 2 版



前面板参考
Config 键组 
Ranging 对话框

此对话框提供用于设置测量的自动量程调整操作的详细信息的以下参数。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Current 
Auto Ranging 电流测量自动量程操作。 NORMAL、 SPEED 或 RESOLUTION 

(RESOLN)。请参见表 4-6。

Voltage 
Auto Ranging 电压测量自动量程操作。 NORMAL、 SPEED 或 RESOLUTION 

(RESOLN)。请参见表 4-6。

Threshold 设置以下所示公式的比率 值。

表 4-6 测量自动量程操作

• 基本操作

通道会自动设置可使执行的测量具有最佳分辨率的量程。

• 向上更改操作

如果测量的数据  value1，则量程会在测量之后向上更改。

value1 = 测量量程  比率 / 100

• 向下更改操作

如果测量的数据  value2，则量程将立即向下更改。

value2 = 测量量程  比率 / 1000

描述

NORMAL 支持如下所述的基本操作和向下更改操作

SPEED 支持如下所述的基本操作和向上及向下更改操作

RESOLN 支持如下所述的基本操作和向上更改操作
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Wait Control 对话框

此对话框提供用于设置源和测量等待时间的以下参数。

源等待时间定义为源通道在开始 DC 输出或脉冲的后沿之后无法更改输出值的时
间。

测量等待时间定义为测量通道在开始 DC 输出或脉冲的后沿之后无法开始测量的
时间。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

State 等待时间， ON 或 OFF

Automatic 自动等待时间， ON 或 OFF

Gain and Offset 用于计算等待时间的参数。请参阅以下公式。

• 如果 State = ON 并且 Automatic = ON：

等待时间 = Gain  初始等待时间 + Offset

• 如果 State = ON 并且 Automatic = OFF：

等待时间 = Offset

• 如果 State = OFF：

等待时间 = 0

初始等待时间由仪器自动设置，不能更改。 
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Function 键组

按 Function 键可显示用于设置数学运算、限值测试和迹线功能的以下软键。

Math 数学运算功能设置。请参见第 133 页上的 “Math Expression 对话框”。

Limit Test 显示用于设置限值测试功能的以下软键。 B2901BL 不能进行限值测试。

Composite 复合限值测试设置。请参见第 134 页上的 “Composite Limit 
Test Setup 对话框”。

Limits 限值测试设置。请参见第 135 页上的 “Limit Test Setup 对话
框”。

Trace 迹线功能设置。请参见第 136 页上的 “Trace Buffer Setup 对话框”。

Math Expression 对话框

此对话框提供用于设置数学运算功能的以下参数。如果数学运算功能为 ON，则
可使用指定的数学表达式计算测量数据。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Status 数学运算功能 ON 或 OFF

Unit String 用于数学表达式的计算结果的单位

可用的数学表达式列在 Unit String 字段下方的区域中。可使用此区域为进行数据
计算选择数学表达式。要选择数学表达式，请在此区域中突出显示其名称。

数据计算对在使用此对话框设置了数学计算功能后测量的数据有效。计算结果可
显示在使用 Result 键组打开的对话框中。请参见第 141 页上的 “Result 键组”。

当 B2900 处于远程模式时，可使用 SCPI 命令定义数学表达式。 

有关预定义的数学表达式，请参阅第 206 页上的 “预定义的数学表达式”。
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Composite Limit Test Setup 对话框

此对话框提供用于设置限值测试的以下参数。 B2901BL 不能进行限值测试。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Limit Test 复合限值测试 ON 或 OFF

Mode 操作模式。 GRADING (GRADE) 或 SORTING (SORT)

GRADING：分级模式。有关操作，请参阅图 6-5。

SORTING：排序模式。有关操作，请参阅图 6-6。

Auto Clear 自动清除复合限值测试结果 ON 或 OFF

如果此参数为 ON，则自动清除复合限值测试结果和 DIO 行。

Update 仅用于 GRADING 模式。测试结果输出时间， IMMEDIATE 
(IMM.) 或 END。请参见图 6-5 中所示的 “立即？”

IMMEDIATE：每次测试后输出 (Immediate? Yes)

END：最后一次测试后输出 (Immediate? No)

Offset Cancel 偏移通道 ON 或 OFF

如果此参数为 ON，则限值测试判断的数据如下。

用于判断的数据 = 测量数据 - 偏移值

Offset 用于偏移取消的偏移值， -9.999999E+20 至 +9.999999E+20

Pass Pattern 限值测试 pass 状态的位模式。用于 GRADING 模式。

Fail Pattern 限值测试 fail 状态的位模式。用于 SORTING 模式。

GPIO Pins 显示为位模式输出分配的 DIO 针脚。要设置针脚，请使用 
:CALC:DIG:BIT 命令。

/BUSY 为 BUSY （忙）信号输出分配的 DIO 针脚

/SOT 为 SOT （测试开始）信号输出分配的 DIO 针脚

/EOT 为 EOT （测试结束）信号输出分配的 DIO 针脚

关于 DIO 针脚分配，请参见第 100 页上的 “使用 Digital I/O”。

必须通过使用 DIO Configuration 对话框，将分配给 GPIO 针脚 /BUSY、 /SOT 或 
/EOT 的 DIO 针脚设置为 DIGITAL I/O 功能。
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GPIO 针脚、 /BUSY、 /SOT 和 /EOT 的值

0 至 14 （整数）。数字 1 至 14 分别表示 DIO 针脚 1 至 14。 0 表示未使用针脚。

对于 GPIO 针脚，分配了多个连续针脚。例如，“1、 2、 3、 4”表示分配了 DIO 
针脚 1 至 4。因此， LSB 是 DIO 针脚 1。

Limit Test Setup 对话框

此对话框提供用于设置作为复合限值测试一部分的限值测试的以下参数。
B2901BL 不能进行限值测试。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Feed Data 用于判断限值测试通过 / 失败的数据的类型。MATH、VOLTS、
AMPS 或 OHMS。

MATH：数学表达式的计算结果数据

VOLTS：电压测量数据 (Vmeas)

AMPS：电流测量数据 (Imeas)

OHMS：电阻数据 (= Vmeas/Imeas)

有关使用电阻补偿的详细信息，请参见第 205 页上的 “电阻
补偿”。

Test Index 限值测试的索引。编号 1 至 12。

索引编号 1 至 12 与二进制编号 1 至 12 相关联。请参见 
第 142 页上的 “Limit Test Result 对话框”。

Limit Test 限值测试 ON 或 OFF

Function 测试模式。 COMPLIANCE (COMP.) 或 LIMIT

COMPLIANCE：合规性检查

LIMIT：限值测试

Pass Pattern 限值测试 pass 状态的位模式。用于 SORTING 模式。

Fail on 仅适用于合规性检查。 OUT 或 IN。

如果通道转为合规性状态，则 Fail on=IN 将判断限值测试 
失败。
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如果通道不处于合规性状态，则 Fail on=OUT 将判断限值测试
失败。

Fail Pattern 仅适用于合规性检查。限值测试 fail 状态的位模式。

Up Pattern 不适用于合规性检查。 Failed-by-exceeding-upper-limit 状态的位
模式。用于 GRADING 模式。

Up Limit 不适用于合规性检查。通过 / 失败判断的上限。用于 
GRADING 模式。

Low Pattern 仅适用于限值测试。 Failed-by-exceeding-lower-limit 状态的位模
式。用于 GRADING 模式。

下限值 仅适用于限值测试。通过 / 失败判断的下限。用于 GRADING 
模式。

位模式会发送至通过 Composite Limit Test Setup 对话框上的 GPIO Pins 字段指定
的 DIO 针脚。

Trace Buffer Setup 对话框

此对话框提供用于设置迹线功能的以下参数。如果 Buffer Control 参数是 NEXT，
可将由 Feed Data 参数指定的数据存储在迹线缓冲区中。最大数据大小由 Buffer 
Size 参数指定。有关迹线缓冲区，请参阅第  213 页上的图 6-7。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Feed Data 迹线缓冲区中放置的数据的类型。 SENSE、 MATH 或 LIMIT

SENSE：测量结果数据

MATH：数学表达式的计算结果数据

LIMIT：限值测试数据

该数据包含通过使用 I/O 键组的 Format 键选定的电压测量数
据、电流测量数据、电阻测量数据、源输出设置数据、计算结
果数据、限值测试数据、时间数据或状态数据。请参见第 146 
页上的 “I/O 键组”。

Buffer Control 迹线缓冲区控制模式。 NEVER 或 NEXT

NEVER：禁用对迹线缓冲区的写保护。

NEXT：启用写保护，直到缓冲区变满为止。

缓冲区已满后，会将模式更改为 NEVER。
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Buffer Size 迹线缓冲区的大小。对于 B2910BL、 B2901B、 B2902B、
B2911B 和 B2912B 为 1 至 100000 条数据；对于 B2901BL 为 
1 至 10000 条数据。
Keysight B2900B/BL 系列用户指南，第 2 版 137



前面板参考
Trigger 键组
Trigger 键组

按 Trigger 键可显示用于设置详细触发参数及控制触发系统的以下软键。请参见
第  218 页上的图 6-8。

Config 打开对话框。请参见第 139 页上的 “Trigger Configuration 对话框”。

Initiate 显示用于选择要启动 （以转到触发系统的接通层）的设备操作的软键。请参见 
表 4-7。 

Abort 显示用于选择要中止 （以返回到触发系统的空闲层）的设备操作的软键。请参见
表 4-7。

Immediate 显示用于选择接通层或触发层以发送立即触发命令的以下软键。

Trigger 选择触发层。

Arm 选择接通层。

选择层以显示用于选择要发送立即触发命令的设备操作的软键。请参见表 4-7。

表 4-7 用于选择设备操作和通道的软键

软键标签 描述

ALL 选择瞬时和采集设备操作。

Trans. 仅选择瞬时 （源输出）设备操作。

Acq. 仅选择采集 （测量）设备操作。

在单通道型号上，选择设备操作将对指定的设备操作执行 Initiate、 Abort 或 
Immediate。

在双通道型号上，选择设备操作将显示以下用于选择通道的以下软键。

ALL 选择通道 1 和 2。

Ch 1 仅选择通道 1。

Ch 2 仅选择通道 2。

选择通道将对指定通道的指定设备操作执行 Initiate、 Abort 或 Immediate。
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Trigger Configuration 对话框

此对话框用于设置详细触发参数。请注意，将忽略重叠参数值，并将其替换为在 
Single 视图中指定的设置。请参见第 118 页上的 “触发参数”。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Layer 指定由此对话框设置的层或设备操作。

ARM：接通层

TRIGGER：触发层

ACTION：设备操作

对于 ACTION，可用的参数包括 Ch、Layer、Action 和 Trigger 
Output。

Action 指定由此对话框设置的设备操作类型。

TRANS.：瞬时（源输出）设备操作

ACQ.：采集 （测量）设备操作

Count 由 Ch、Layer 和 Action 参数指定的操作的计数。1 至 100000 
或 INF. （无限），对于 B2901B、 B2902B、 B2911B 和 
B2912B ； 1 至 10000，对于 B2901BL ；以及 1 至 100000，
对于 B2910BL。

Bypass Bypass ON 或 OFF

Bypass=ON，仅对由 Ch、 Layer 和 Action 参数指定的操作的
事件监视器的第一个通道启用旁路。

Bypass=OFF，禁用旁路。

触发源 由 Ch、 Layer 和 Action 参数指定的操作的事件。 AUTO、
BUS、 TIMER、 INT1、 INT2、 LAN、 EXT1、 EXT2、 EXT3、
EXT4、EXT5、EXT6、EXT7、EXT8、EXT9、EXT10、EXT11、
EXT12、 EXT13 或 EXT14。请参见表 4-8。 

Period 仅适用于 TIMER 事件。

由 Ch、 Layer 和 Action 参数指定的操作的 TIMER 事件的间
隔。对于 B2901B 和 B2902B 为 20 s 到 100000 s ；对于 
B2911B 和 B2912B 为 10 s 到 100000 s ；对于 B2901BL 为 
200 s 到 100000 s ；对于 B2910BL 为 50 s 到 100000 s。
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Trigger Delay 由 Ch、Layer 和 Action 参数指定的操作的延迟时间，范围是 0 
至 100000 s

Trigger Output 触发输出 ON 或 OFF

触发输出端子。内部总线 (INT1, INT2)、LAN 端口 (LAN) 或 I/O 
针脚 EXTn （n = 1 到 14）

如果此参数是 On，则 B2900 将在更改由 Ch、Layer 和 Action 
参数指定的操作的触发状态时发送输出触发。请参见第 218 页
上的图 6-8。

使用数字 I/O 针脚时，需要设置针脚的功能、输出触发极性、
类型、脉冲宽度等。请参见第 149 页上的“DIO Configuration 
对话框”和第 100 页上的 “使用 Digital I/O”。

表 4-8 触发源

触发源 描述

AUTO 最适合当前操作模式的触发源由内部算法自动选择。 

BUS 远程接口触发命令，例如 GET、 TRIGger 和 *TRG

TIMER 在 Period 字段设置的每个间隔内在内部生成信号

INT1 或 INT2 来自内部总线 1 或 2 的信号

LAN LXI 触发由 :ARM[:ACQ|:TRAN]:SOUR:LAN 和 
:TRIG[:ACQ|:TRAN]:SOUR:LAN 命令指定

EXTn 来自 DIO 针脚 n 的信号，它是后面板上的 Digital I/O D-sub 
连接器的 I/O 端口， n = 1 至 14
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Result 键组

按 Result 键可显示用于显示测量、限值测试和迹线结果的以下软键。

测量 显示测量结果。请参见第 141 页上的 “Measure Result 对话框”。

Limit Test 显示限值测试结果。请参见第 142 页上的 “Limit Test Result 对话框”。
B2901BL 不能进行限值测试。

Trace 显示迹线结果。请参见第 143 页上的 “Trace Statistical Result 对话框”。

Measure Result 对话框

此对话框用于显示在数据缓冲区中存储的最后的单次 （一次）测量结果。对于 
B2900 （B2901BL 除外）最多可有 100000 条数据，对于 B2901BL 最多可有 
10000 条数据。

此对话框提供用于显示测量结果的以下 GUI。结果数据显示在 Type 字段的索引
和数据表下方。此外，还会在 Points 字段上方的图形区域中绘制数据。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定要显示的数据的通道。

Type 要显示的数据的类型。 AMPS、 VOLTS、 OHMS、 WATTS、
MATH 或 TIME

AMPS：电流测量数据

VOLTS：电压测量数据

OHMS：电阻数据根据 Resistance = Vmeas/Imeas 得出

WATTS：功率数据根据 Power = VmeasImeas 得出

MATH：数学表达式的计算结果数据

TIME：时间数据

在上面的公式中，Vmeas 是电压测量数据， Imeas 是电流测量
数据。

有关使用电阻补偿的详细信息，请参见第 205 页上的 “电阻
补偿”。
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Points 数据点数

图形的 Y 轴最大值

图形的 Y 轴最小值

Limit Test Result 对话框

此对话框提供用于显示限值测试结果的以下 GUI。结果数据显示在 Length 字段
下方的数据列表区域中。 B2901BL 不能进行限值测试。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定要显示的数据的通道。

Length 数据长度

限值测试数据包含以下信息。

(aaaaa) BIN: bb  DATA: +c.ccccccE+dd

(aaaaa) 数据索引 aaaaa

BIN： 二进制编号 bb（01 至 12）

二进制编号 1 至 12 与索引编号 1 至 12 相关联。请参见第 135 
页上的 “Limit Test Setup 对话框”。

如果限值测试数据超出二进制编号范围，则对 GRADING 模式
设置 00，对 SORTING 模式设置 15。

DATA： 限值测试数据 +c.ccccccE+dd
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Trace Statistical Result 对话框

此对话框提供用于显示迹线统计结果的以下 GUI。结果数据显示在 Mean、
Std.Dev.、 Min. 和 Max. 字段。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定要显示的数据的通道。

Feed 始终为 SENSE

Element 要显示的数据的类型。 AMPS、 VOLTS 或 OHMS

AMPS：电流测量数据

VOLTS：电压测量数据

OHMS：电阻数据根据 Resistance = Vmeas/Imeas 得出

在上面的公式中，Vmeas 是电压测量数据， Imeas 是电流测量
数据。

有关使用电阻补偿的详细信息，请参见第 205 页上的 “电阻
补偿”。

Length 数据长度

Mean 平均值

Std.Dev. 标准差

图形的 最小值

图形的 最大值
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File 键组

按 File 键将显示用于将文件保存到连接到前面板 USB-A 连接器的 USB 存储器并
从该存储器加载文件的以下软键。

Save 显示用于保存文件的以下软键。按某个软键可显示 File Selection 对话框。请参见
第 144 页上的 “File Selection 对话框”。

测量 保存测量数据文件。

Math 保存数学运算结果数据文件。

Limit Test 保存限值测试结果数据文件。

Trace 保存迹线缓冲区数据文件。

Config 保存系统设置数据文件。

Load 显示用于加载文件的以下软键。按下该软键可显示 File Selection 对话框。请参见
第 144 页上的 “File Selection 对话框”。

Config 调用系统设置数据文件。

License 加载许可证文件。

许可证文件用于启用受许可证保护的功能。 

File Selection 对话框

此对话框提供用于保存或加载文件的以下 GUI。

Path 用于保存或加载文件的文件夹名称。

File Name 要保存或加载的文件名。

保存在指定文件夹中的文件和文件夹列在 Path 字段和 File Name 字段之间的区域
中。可在此区域中通过突出显示文件名来选择文件。

保存系统设置文件时，如果未指定文件扩展名，则将自动添加 “.sta”。保存其
他数据文件时，将自动添加 “.csv”。
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Program 键组

按 Program 键将显示用于设置和控制程序存储器的以下软键。

当 B2900 处于远程模式时，可使用 SCPI 命令定义程序存储器。 

Catalog 显示 Program Catalog 对话框，其中列出保存在程序存储器中的程序。还可以使
用此对话框指定要使用的存储器程序。要选择存储器程序，请在此列表中突出显
示其名称。

View 显示 Program View 对话框，其中显示指定程序的程序代码。 

Variable 显示 Variable 对话框，其中列出存储器程序中使用的变量。可用索引是 1 至 
100。

Control 显示用于控制程序存储器操作的以下软键。

Run 启动指定的存储器程序。

Pause 暂停执行存储器程序。

Step 启动指定存储器程序的步骤执行。

Stop 停止执行存储器程序。

Continue 继续执行当前暂停的存储器程序。
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I/O 键组

按 I/O 键将显示用于设置 I/O 接口的以下软键。

Format 显示用于设置数据输出格式的软键。请参见第 147 页上的 “数据输入格式”。

LAN 显示用于管理 LAN 接口的以下软键。

Config 显示 LAN Configuration 对话框，用于设置 LAN 接口的配置。
请参见第 148 页上的 “LAN Configuration 对话框”。

Status 显示 LAN Status 对话框，其中显示 LAN 接口的状态。

Reset 重置所有 LAN 连接。

Defaults 将 LAN 设置设置为出厂默认设置。

按 Reset 软键或 Default 软键可显示确认对话框。按 OK 软键可确认指定的操作，
或按 Cancel/Local 键可取消此操作。

USB 显示 USB Status 对话框。 

Easy File Access 文件访问功能设置 ON （启用）或 OFF （禁用）。 
当设置为 ON 时，重新启动本仪器。使用此功能时，请使用 
USB 电缆将本仪器连接到 PC。请参见第 222 页上的 “文件访
问功能 (Easy File Access)”。此功能不适用于 B2901BL 和 
B2910BL。

Text display field 显示 VISA USB 连接字符串。

例如： USB0::10893::38145::MY12345678::0::INSTR

GPIB 显示 “GPIB Configuration”（GPIB 配置）对话框，以用于设置 B2900 的 GPIB 
地址。此对话框还显示 VISA GPIB 连接字符串。 

例如： GPIB0::23::INSTR

DIO 显示用于管理 Digital I/O 接口的以下软键。

Config 显示 DIO Configuration 对话框，用于设置 Digital I/O 接口的配
置。请参见第 149 页上的 “DIO Configuration 对话框”。

R/W 显示 DIO Read/Write 对话框，用于读取或写入设置到 Digital I/O 
接口的值。请参见第 150 页上的 “DIO Read/Write 对话框”。
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数据输入格式

按 Format 软键将显示用于设置输出数据的格式和元素的以下软键。

测量 显示 Format (Measure) 对话框，以用于设置测量数据输出的元
素。请参见第 147 页上的 “Format (Measure) 对话框”。

Math/Limit 显示 “Format (Math/Limit)”（格式 （数学运算 / 限值））对
话框，以用于设置数学运算结果数据输出和限值测试结果数据
输出的元素。请参见第 148 页上的 “Format (Math/Limit) 对
话框”。

Trace 显示 Format (Trace) 对话框，以用于设置迹线数据输出的元
素。请参见第 148 页上的 “Format (Trace) 对话框”。

Data Type 显示用于指定数据输出格式的以下软键。当前设置由软键标签
上的星号指示。

ASCII ASCII 格式

REAL32 IEEE-754 单精度格式， 4 字节

REAL64 IEEE-754 双精度格式， 8 字节

Data Swap 显示用于启用或禁用 IEEE-754 精度格式数据输出的字节交换
的以下软键。当前设置由软键标签上的星号指示。

OFF 禁用字节交换。正常字节顺序。

ON 启用字节交换。反转字节顺序。

如果 Data Swap=ON，则反转字节顺序。对于 IEEE-754 单精度格式，将按字节 4 
到字节 1 的顺序发送字节 1 到字节 4，对于 IEEE-754 双精度格式，将按字节 8 
到字节 1 的顺序发送字节 1 到字节 8。

Format (Measure) 对话框

此对话框提供用于设置测量数据输出的元素的以下参数。

电压 电压数据输出 ON 或 OFF

电流 电流数据输出 ON 或 OFF

电阻 电阻数据输出 ON 或 OFF

Source 源数据输出 ON 或 OFF

Time 时间数据输出 ON 或 OFF

Status 状态数据输出 ON 或 OFF
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Format (Math/Limit) 对话框

此对话框提供用于设置数学运算结果数据输出和限值测试结果数据输出的元素的
以下参数。

Data 结果数据输出 ON 或 OFF

Time 时间数据输出 ON 或 OFF

Status 状态数据输出 ON 或 OFF

Format (Trace) 对话框

此对话框提供用于设置迹线统计数据输出的元素的以下参数。

Ch 仅在双通道型号上。通道 1 (Ch 1) 或 2 (Ch 2)

此字段指定由该对话框设置的通道。

Data 迹线数据。从以下数据元素选择一个。

MEAN 平均值

STD.DEV. 标准差

MIN. 最小值

MAX. 最大值

PK-PK 峰峰值

Timestamp 时间戳数据格式。可选择以下选项之一。

ABSOLUTE 绝对值 (ABS.)。返回第一个时间戳数据的增
量值。

DELTA 差值 (DELTA)。返回上一个时间戳数据的增
量值。

LAN Configuration 对话框

此对话框提供用于设置 LAN 接口配置的以下参数。

mDNS mDNS （多播 DNS）状态 ON 或 OFF

IP Address 
Config. IP 地址配置。 AUTO 或 MANUAL

AUTO 配置使用 DHCP 服务器。

IP 地址 此仪器的 IP 地址，用于配置 MANUAL IP 地址

Subnet 子网掩码，用于配置 MANUAL IP 地址
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Gateway 网关的 IP 地址，用于配置 MANUAL IP 地址

DNS Server 
Config. DNS 服务器配置。 AUTO 或 MANUAL

DNS Server DNS 服务器的 IP 地址，主要和辅助，用于配置 MANUAL DNS 
服务器

Hostname 此仪器的主机名

WINS Server WINS 服务器的 IP 地址，主要和辅助

DIO Configuration 对话框

此对话框提供用于设置 Digital I/O 接口配置的以下参数。

Pin # Digital I/O 针脚号， 1 至 14

此字段指定由该对话框设置的针脚。

Function Digital I/O 接口、数字信号输入 / 输出 (DIGITAL I/O)、数字信
号输入 (DIGITAL IN)、触发输出 (TRIGGER OUT)、触发输入 
(TRIGGER IN) 或高电压状态 （HIGH VOLTAGE LAMP、
HI-VOLT LAMP，仅限针脚 14）的指定针脚的功能。

如果 Funciton 设置为 HIGH VOLTAGE LAMP，则将忽略此对话
框中的其他设置参数。

Polarity 输入 / 输出功能的极性。正极 （POSITIVE， POS.）或负极
（NEGATIVE， NEG.）

Output Trigger 
Type 输出触发的类型，边沿 (EDGE) 或电平 (LEVEL)

Output Trigger 
Timing 输出触发的定时，之后操作 （接通、触发和设备操作）

(AFTER)，之前操作 (BEFORE) 或两者 (BOTH)

Output Pulse 
Width 输出触发的脉冲宽度， 10 s 至 10 ms

有关触发功能的详细信息，请参见第 138 页上的 “Trigger 键组”。
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DIO Read/Write 对话框

此对话框提供用于读取或写入设置到 Digital I/O 接口的值的以下参数。

Format 设置到 Mask Value 字段和 Value 字段的值的格式，二进制 
(BIN)、十进制 (DEC) 或十六进制 (HEX)

Mask Value 掩码值，表示 Digital I/O 接口的未使用位的码型。

READ 辅助键用于读取当前设置到 Digital I/O 接口的掩码值。

WRITE 辅助键用于将指定的掩码值设置到 Digital I/O 接口。

Value 设置到 Digital I/O 接口的值

READ 辅助键用于读取当前设置到 Digital I/O 接口的值。

WRITE 辅助键用于将指定的值写入 Digital I/O 接口。
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Display 键组

按 Display 键将显示用于设置显示功能的以下软键。当前设置由软键标签上的星
号指示。

远程 显示以下软键，当 B2900 处于远程模式时，用于启用或禁用前面板显示屏。

OFF 禁用前面板显示屏。对快速操作有效。

ON 启用前面板显示屏。

Color 显示用于指定显示颜色集的以下软键。

Set 1 设置颜色集 1。

Set 2 设置颜色集 2。

Zoom 显示用于启用或禁用显示屏缩放的以下软键。

OFF 禁用缩放。正常显示。

ON 启用缩放。仅显示测量的数据。

按 Zoom Out 辅助键可取消放大操作。

在放大状态下，不会显示设置信息，将缩放测量结果。然后，

• Dual 视图以大字体显示主要测量数据，以小字体显示每个通道的辅助测量 
数据。

• Single 视图使用大字体显示主要和次要测量数据。

Digits 显示用于指定数据显示分辨率的以下软键。

4 设置 3½ 数字分辨率。

5 设置 4½ 数字分辨率。

6 设置 5½ 数字分辨率。

7 设置 6½ 数字分辨率。

Pref. 显示 Display Preference 对话框请参见第 152 页上的“Display Preference 对话
框”。
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Display Preference 对话框

此对话框用于设置以下参数。这些设置保存到非易失性存储器中。

• V/I Limit for Each Polarity

选择 Limit (Compliance) 设置操作。

ON 分别设置 ON

可以分别设置正负限制。

OFF 分别设置 OFF

设置 ± 限值。

• Immediate V/I Update by Knob

选择使用数字指针和旋钮更改 Source 值或 Limit (Compliance) 值时的通道 
操作。

ON 实时更新 ON

转动旋钮会改变显示值并实时更新通道输出。

OFF 实时更新 OFF

转动旋钮只是改变显示值。按下旋钮可将值应用到通道 
输出。

• Restore Trigger Mode on Local

存储进入 GP-IB 远程状态时的触发模式设置， ON 或 OFF。

ON 进入 GPIB 远程状态时将触发模式设置保存在非易失性存 
储器中，并在返回 GPIB 本地模式时恢复保存的触发模式 
设置。

OFF 禁用此功能。
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System 键组

按 System 键将显示用于多种系统设置的以下软键。

错误 显示用于查看或清除错误的以下软键。

Log 显示 Error Log 对话框，其中显示 SCPI 错误。

Clear 立即清除错误缓冲区。

Reset 初始化 B2900。

按 Reset 软键可显示确认对话框，然后可按以下软键之一执行初始化。要取消初
始化并关闭确认对话框，请按 Cancel/Local 键。

显示屏 初始化显示设置。

H/W 初始化硬件设置。

ALL 初始化所有设置。

Cal/Test 显示用于执行自我校准或自检的以下软键。

Self-Cal 执行自我校准。

自检 执行自检。

按下该软键可显示确认对话框。按 OK 软键可开始自我校准或自检，或按 
Cancel/Local 键取消。

PLC 显示用于指定电源线频率的以下软键。当前设置由软键标签上的星号指示。

50 Hz 指定电源线频率为 50 Hz。

60 Hz 指定电源线频率为 60 Hz。

Timestamp 显示用于清除时间戳的以下软键。

Clear 清除时间戳。按该软键将显示确认对话框。按 OK 软键可清除
时间戳，或按 Cancel/Local 键取消。
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Auto CLR 显示用于设置时间戳自动清除的以下软键。当前设置由软键标
签上的星号指示。

OFF 禁用自动清除时间戳。

ON 启用自动清除时间戳。

Start-up 显示 System Start-up 对话框，其中提供以下设置参数。

Power-on State RST、 RCL0、 RCL1、 RCL2、 RCL3 或 RCL4

上电状态可从出厂默认重置条件 (RST) 和用户条件 RCL0、
RCL1、 RCL2、 RCL3 和 RCL4 中选择，当 B2900 处于远程模
式时，可使用 *SAV 0、 *SAV 1、 *SAV 2、 *SAV 3、和 *SAV 4 
命令分别定义这些用户条件。 

Power-on 
Program 上电程序执行， ON 或 OFF

如果此参数是 ON，则在打开 B2900 时，上电程序将自动 
执行。

当 B2900 处于远程模式时，可使用 :PROG:PON:COPY 命令定
义上电程序。 

Sound 显示用于启用或禁用蜂鸣器和声音的以下软键。当前设置由软键标签上的星号 
指示。

OFF 禁用蜂鸣器和声音。

ON 启用蜂鸣器和声音。

语言 显示用于指定 B2900 远程控制命令集的以下软键。当前设置由软键标签上的星号
指示。

Default 指定支持 B2900 所有功能的默认命令集。

2400 指定为所有现有程序设计的常规命令集，创建这些程序是为 
了控制现有的仪器，如 Keithley Instruments, Inc. 的 2400 系 
列等。

Script 无效。

默认命令集和常规命令集都可以使用。
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Info. 显示以下软键。

Revision 显示 “Revision”（修订版）对话框，其中显示 B2900 的型
号、序列号和固件修订版。

Date/Time 显示用于查看或设置日期和时间的 Date and Time 对话框。

Update 用于固件更新。

Demo. 进行演示。按下此软键可显示确认对话框。按 OK 软键将开始
演示，或按 Cancel/Local 键取消。

Factory 将 B2900 恢复到出厂时的状态。按下此软键可显示确认对话框。按 OK 软键将开
始初始化，或按 Cancel/Local 键取消。
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System 键组
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Keysight B2900B/BL 系列 精密源 / 测量单元
用户指南
5 前面板操作

基本操作    159
使用测量以外的功能    161
设置源输出    168
执行测量    178
使用数学运算功能    183
执行限值测试    184
使用迹线缓冲区    188
使用程序存储器    190

本章介绍如何使用 Keysight B2900。 

打开或关闭仪器

按待机开关。接通电源后，开关下方的 LED 指示灯会变为绿色。 

将仪器设置为本地模式

按 Cancel/Local 键。 

仪器处于本地模式时，前面板按键处于可用状态。 

启用或禁用通道

按 On/Off 开关。 

通道状态由开关的亮起状态指示，具体如下。 

Off：通道已被禁用。 

绿色：通道已启用。 

红色：通道处于高电压状态。 



前面板操作
启动测量

按 Trigger 键。根据设置状态，对 DC 偏置输出、阶梯扫描输出、脉冲偏置输出
或脉冲扫描输出进行单次测量 （一次击中）。 

按 Auto 键。对 Source 值的 DC 偏置输出进行重复 （连续）测量。 
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基本操作

使用字段指针在设置屏幕中指定设置字段。字段指针可具有以下状态。在设置 
B2900 的过程中，请根据需要更改状态。 

MOVE 状态 以蓝色突出显示。可以在字段间移动指针。 

EDIT 状态 以绿色突出显示。可以更改当前字段的值。 

更改字段中的设置

1. 如果字段指针处于 EDIT 状态，请按此旋钮。指针状态将变为 MOVE。 

2. 旋转旋钮或按箭头键移动字段指针。 

3. 将字段指针移动到要更改的项目上，然后按此旋钮。指针状态将变为 EDIT。 

4. 可通过按数字 / 字母键、旋转旋钮或按箭头键来输入值或字符。按此旋钮以
固定该设置值。指针状态将变为 MOVE。 

或者按与设置值对应的辅助键以固定该设置值。指针状态将变为 MOVE。 

数字指针

在诸如 Source 和 Limit (Compliance) 字段的数值输入字段中，只能指定一个数字
来更改其值。 

当字段指针处于 EDIT 状态时 （即输入字段中的所有数字都以绿色突出显示），
按箭头键将指针更改为数字指针，该指针只指向输入字段中的一个数字。在此状
态下，可进行以下操作。 

使用箭头键移动指针。 

使用数字 / 字母键和旋钮更改指针所指示数字的值。 

当指针在小数点上时，如果实时更新 (Immediate V/I Update by Knob) 为 OFF，
则转动旋钮将移动小数点。 
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使用旋钮时的通道操作

如果在 Source 字段或 Limit (Compliance) 字段中，字段指针处于 EDIT （绿色）
状态，则转动旋钮可实时更改 / 更新源通道的设置值。

使用旋钮和数字指针时的通道操作取决于实时更新 (Immediate V/I Update by 
Knob) 的设置。

• 实时更新 ON

设置值立即应用于通道。

• 实时更新 OFF

不立即应用设置值，要将其应用于通道，需要按下旋钮。

更改对话框中的设置

1. 按第 159 页上的 “更改字段中的设置”中所述的相同方法设置对话框中的 
项目。

2. 要应用设置，按 Apply。 

要应用所有设置并关闭此对话框，请按 OK。 

要取消设置更改，请按 Cancel/Local 键，而非 Apply。 
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使用测量以外的功能

本节介绍源输出和测量功能以外的以下其他操作。 

• “设置电源线频率”

• “恢复出厂状态”

• “应用初始设置”

• “设置蜂鸣器”

• “设置日期和时间”

• “执行自检”

• “执行自我校准”

• “设置开机时的操作”

• “显示错误消息”

• “清除错误缓存”

• “清除时间戳”

• “设置自动清除时间戳”

• “显示固件版本”

• “显示许可证信息”

• “设置 GPIB 地址”

• “设置遥控命令集”

• “设置远程显示模式”

• “保存 / 调用所有设置信息”

• “启用 / 禁用用于 Easy File Access 的媒体传输协议”

• “启用 / 禁用恢复本地状态的触发模式设置的功能”

• “使用数字指针和旋钮启用 / 禁用 Source/Limit 实时更新”
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设置电源线频率

1. 按 More > System > PLC 功能键。 

2. 按 50 Hz 或 60 Hz。要取消设置更改，请按 Cancel/Local 键。 

恢复出厂状态

1. 按 More > System > More > Factory 功能键。 

2. 按 OK 进行应用。要取消此操作，请按 Cancel/Local 键。 

应用初始设置

1. 按 More > System > Reset 功能键。 

将出现 Confirmation 对话框和以下功能键。 

显示屏 初始化显示设置。

H/W 初始化硬件设置。

ALL 初始化所有设置。

2. 按上述键之一。要取消此操作，请按 Cancel/Local 键。 

设置蜂鸣器

1. 按 More > System > More > Sound 功能键。 

2. 要启用蜂鸣器，请按 ON。要将其禁用，请按 OFF。要取消设置更改，请按 
Cancel/Local 键。 

设置日期和时间

1. 按 More > System > More > Info. 功能键。 

2. 按 Date/Time。 

即会打开 Date and Time 对话框。 

3. 设置日期和时间。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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执行自检

1. 按 On/Off 开关，并确认开关已关闭。 

2. 从通道端子断开测试引线和电缆连接。 

3. 按 More > System > Cal/Test > Self-Test 功能键。 

即会打开 Confirmation 对话框。 

4. 按 OK 执行自检。要取消此操作，请按 Cancel/Local 键。 

执行自我校准

自校准必须在预热 60 分钟后执行。

1. 按 On/Off 开关，并确认开关已关闭。 

2. 从通道端子断开测试引线和电缆连接。 

3. 按 More > System > Cal/Test > Self-Cal 功能键。 

即会打开 Confirmation 对话框。 

4. 按 OK 执行自校准。要取消此操作，请按 Cancel/Local 键。 

设置开机时的操作

1. 按 More > System > More > Start-up 功能键。 

即会打开 System Start-up 对话框。 

2. 请参见第 154 页上的 “Start-up”来设置每个参数。 

显示错误消息

1. 按 More > System > Error 功能键。 

2. 按 Log。 

错误消息即显示在 Error Log 对话框中。 

3. 按 OK 关闭对话框。 
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清除错误缓存 
1. 按 More > System > Error 功能键。 

2. 要清除错误缓存，请按 Clear。要取消此操作，请按 Cancel/Local 键。 

清除时间戳 
1. 按 More > System > Timestamp 功能键。 

2. 按 Clear。即会打开 Confirmation 对话框。 

3. 要执行此操作，请按 OK。要取消此操作，请按 Cancel/Local 键。 

设置自动清除时间戳

1. 按 More > System > Timestamp 功能键。 

2. 按 Auto CLR。 

3. 要启用自动清除，请按 ON。要将其禁用，请按 OFF。要取消设置更改，请按 
Cancel/Local 键。 

显示固件版本

1. 按 More > System > More > Info. 功能键。 

2. 按 Revision。 

修订版信息会显示在 Revision 对话框中。 

按 OK 关闭对话框。 

显示许可证信息

执行以下步骤可显示应用于 B2900 的许可证。

1. 按 More > System > More > Info. 功能键。

2. 按 Revision。 

修订版信息会显示在 Revision 对话框中。

按 OK 关闭对话框。

要使用许可证保护的功能，每台仪器 （每个序列号）都需要许可证。
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设置 GPIB 地址

1. 按 More > I/O 功能键。 

2. 按 GPIB。 

将打开 GPIB Configuration 对话框。 

3. 设置 GPIB 地址。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置遥控命令集

1. 按 More > System > More > Language 功能键。 

2. 要使用默认命令集，请按 Default。要使用传统命令集，请按 2400。 

3. 如果命令集发生更改，则会打开 Confirmation 对话框。要应用设置更改，按 
OK。要取消设置更改，请按 Cancel/Local 键。

设置远程显示模式

1. 按 More > Display 功能键。 

2. 按 Remote。 

3. 要在远程模式下启用屏幕显示，请按 ON。要将其禁用，请按 OFF。要取消设
置更改，请按 Cancel/Local 键。
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保存 / 调用所有设置信息

此功能可保存 / 调用 B2900 的所有设置信息。为实现此功能，在内置非易失性存
储器 (NVRAM) 中设置了五个存储区。

要保存设置信息，请执行以下操作。

1. 按 Config > Save 功能键。

2. 按与存储区对应的键 #1、 #2、 #3、 #4 或 #5。

要调用设置信息，请执行以下操作。

1. 按 Config > Recall 功能键。

2. 按与存有要调用的设置信息的存储区对应的键 #1、 #2、 #3、 #4 或 #5。

启用 / 禁用用于 Easy File Access 的媒体传输协议

有关此功能的详细信息，请参见第 222 页上的 “文件访问功能 (Easy File 
Access)”。此功能不适用于 B2901BL 和 B2910BL。

1. 按 More > I/O > USB 功能键。即会打开 USB Status 对话框。

2. 将 Easy File Access 字段设置为 ON 或 OFF。

3. 要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

更改设置需要重新启动 B2900。

启用 / 禁用恢复本地状态的触发模式设置的功能

有关此功能的详细信息，请参见第 152 页上的 “Display Preference 对话框”。

1. 按 More > Display > Pref. 功能键。即会打开 Display Preference 对话框。

2. 将 Restore Trigger Mode on Local 字段设置为 ON 或 OFF。

3. 要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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使用数字指针和旋钮启用 / 禁用 Source/Limit 实时更新

有关此功能的详细信息，请参见第 152 页上的 “Display Preference 对话框”。

1. 按 More > Display > Pref. 功能键。即会打开 Display Preference 对话框。

2. 将 Immediate V/I Update by Knob 字段设置为 ON 或 OFF。

3. 要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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设置源输出

本节介绍以下源输出操作。 

• “设置源输出模式”

• “施加 DC 电压 / 电流”

• “停止源输出”

• “设置 Limit (Compliance) 值”

• “设置输出量程”

• “设置脉冲输出”

• “设置扫描输出”

• “设置列表扫描输出”

• “设置源输出触发参数”

• “设置源等待时间”

• “设置输出滤波器”

• “设置连接类型”

• “设置低电平端子状态”

• “启用或禁用高电容模式”

• “启用或禁用过电压 / 电流保护”

• “指定输出关闭状态”

• “启用或禁用自动输出打开功能”

• “启用或禁用自动输出关闭功能”

• “设置扫描源的量程模式”

• “设置扫描方向”

• “设置扫描后的源输出值”
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设置源输出模式

1. 对于 Single 视图，请按 Mode 辅助键。对于 Dual 视图，请按 Ch1 Mode 或 
Ch2 Mode 辅助键。 

字段指针将移动到 Source 模式设置字段。 

2. 按 VOLTS (V) 设置为电压输出，或者按 AMPS (I) 设置为电流输出。 

施加 DC 电压 / 电流

1. 对于 Single 视图，请按 Source 辅助键。对于 Dual 视图，请按 Ch1 Source 或 
Ch2 Source 辅助键。 

字段指针将移动到 Source 值设置字段。 

2. 通过使用数字 / 字母键、旋钮和箭头键来输入输出值。 

3. 按此旋钮或辅助键以固定该设置值。 

4. 按通道 1 或通道 2 （Ch 1 或 Ch 2）的 On/Off 开关。 

通道即开始输出指定的电压 / 电流。开关变为绿色，通道继续输出并在值更
改时立即更改。 

停止源输出

1. 按通道 1 或通道 2 （Ch 1 或 Ch 2）的 On/Off 开关。 

输出和测量停止，并关闭开关。 

设置 Limit (Compliance) 值
有关此功能的详细信息，请参见第 192 页上的 “限值 / 合规性”。 

1. 对于 Single 视图，请按 Limit 辅助键。对于 Dual 视图，请按 Ch1 Limit 或 
Ch2 Limit 辅助键。 

字段指针将移动到 Limit (Compliance) 字段。 

2. 使用数字 / 字母键、旋钮和箭头键输入限值。 

3. 按此旋钮或辅助键以固定该设置值。 

通过在 Display Preference 对话框中，将 V/I Limit for Each Polarity 字段设置为 
ON，可以分别将 Limit (Compliance) 值设置为正值和负值。请参见第 152 页上的
“Display Preference 对话框”。
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设置输出量程

有关此功能的详细信息，请参见第 193 页上的 “调整量程模式”和第 113 页上
的 “量程参数”。 

1. 按 View 键以显示 Single 视图。如果未显示 Range 参数，请按 Hide XXXX 辅
助键。 

2. 将字段指针移动到 Source Volts: Spot （电压源量程）或 Source Amps: Spot
（电流源量程）字段。 

3. 按此旋钮可使指针状态变为 EDIT。 

4. 按 AUTO 设置自动量程操作，或者按 FIXED 设置固定量程操作。指针状态将
变为 MOVE。 

5. 将字段指针移动到量程值设置字段 （位于 Source Volts: Spot 或 Source 
Amps: Spot 字段的右侧）。 

6. 按此旋钮可使指针状态变为 EDIT。 

7. 按辅助键设置以下值。 

对于自动量程操作：量程操作的最小量程

对于固定量程操作：用于源输出的量程

设置脉冲输出

有关此功能的详细信息，请参见第 196 页上的 “脉冲输出”。此功能不适用于 
B2901BL 和 B2910BL。

1. 按 View 键以显示 Single 视图。 

2. 按 Show Pulse 辅助键以显示 Pulse 参数。有关这些参数的详细信息，请参见
第 117 页上的 “脉冲参数”。 

3. 将字段指针移动到 Pulse 字段。 

4. 按此旋钮可使指针状态变为 EDIT。 

5. 按 ON 辅助键。指针状态将变为 MOVE。 

6. 将字段指针移动到脉冲参数设置字段 （Peak、 Delay 或 Width）。 

7. 按此旋钮可使指针状态变为 EDIT。 

8. 输入脉冲峰值 (Peak)、延迟时间 (Delay) 或脉冲宽度 (Width)。 

9. 按此旋钮或辅助键以固定该设置值。 
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10.对所有参数重复步骤 6 至 9。 

施加脉冲电压 / 电流

按 On/Off 开关可开始输出 Source 值。可将 Source 值用作脉冲基准值。 

按 Trigger 键以执行指定的脉冲输出和测量。 

设置扫描输出

有关扫描输出功能的详细信息，请参见第 114 页上的 “扫描参数”和第 198 页
上的 “扫描输出”。

可使用以下步骤设置阶梯扫描输出。 

要设置脉冲扫描输出，必须设置阶梯扫描输出和脉冲输出。有关设置脉冲输出的
详细信息，请参见第 170 页上的“设置脉冲输出”。脉冲输出不适用于 B2901BL 
和 B2910BL。

1. 按 View 键以显示 Single 视图。 

2. 按 Show Sweep 辅助键以显示 Sweep 参数。

3. 将字段指针移动到 Sweep Parameters 字段。 

4. 按此旋钮可使指针状态变为 EDIT。 

5. 按 LINEAR SINGLE、 LINEAR DOUBLE、 LOG SINGLE 或 LOG DOUBLE 辅助
键，选择相关的扫描操作。指针状态将变为 MOVE。 

6. 将字段指针移动到扫描参数设置字段 （Start、 Stop、 Points 或 Step）。 

7. 按此旋钮可使指针状态变为 EDIT。 

8. 输入扫描开始值 (Start)、扫描停止值 (Stop)、扫描步骤数 (Points) 或扫描步骤
值 (Step)。 

9. 按此旋钮或辅助键以固定该设置值。 

10.对所有参数重复步骤 6 至 9。 

施加扫描电压 / 电流

按 On/Off 开关可开始输出 Source 值。 

按 Trigger 键以执行指定的扫描输出和测量。 
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设置列表扫描输出

有关此功能的详细信息，请参见第 199 页上的 “列表扫描”。

1. 按 View 键以显示 Single 视图。 

2. 按 Show Sweep 辅助键以显示 Sweep 参数。 

3. 将字段指针移动到 Sweep Parameters 字段。 

4. 按此旋钮可使指针状态变为 EDIT。 

5. 按 LIST 辅助键。指针状态将变为 MOVE。 

6. 将字段指针移动到扫描参数设置字段 （Start、 Stop 或 Points）。 

7. 按此旋钮可使指针状态变为 EDIT。 

8. 按 Edit 辅助键。即会打开 List Sweep 对话框。 

9. 使用 List Sweep 对话框设置列表扫描源。有关详细信息，请参见第 114 页上
的 “列表扫描设置”。 

10.要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

Load 辅助键

如果在步骤 8 中按 Load 辅助键，而非 Edit 辅助键，则会显示 Load List Sweep 
Data 对话框，以便您从 USB 内存加载列表扫描数据。 

有关详细信息，请参见第 114 页上的 “列表扫描设置”。 

施加列表扫描电压 / 电流

按 On/Off 开关可开始输出 Source 值。 

按 Trigger 键以执行指定的列表扫描输出和测量。 
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设置源输出触发参数

有关此功能的详细信息，请参见第 216 页上的 “触发系统”和第 118 页上的
“触发参数”。 

1. 按 View 键以显示 Single 视图。 

2. 按 Show Trigger 辅助键以显示 Trigger 参数。

3. 将字段指针移动到 Trigger 字段。 

4. 按此旋钮可使指针状态变为 EDIT。 

5. 按 AUTO、SYNC、TIMER 或 MANUAL 辅助键以设置触发类型。指针状态将变
为 MOVE。 

6. 将字段指针移动到触发参数设置字段（Source 列中的 Count、Delay、Period 
或 Trigger）。 

7. 按此旋钮可使指针状态变为 EDIT。 

8. 输入触发计数 (Count)、触发延迟时间 (Delay)、触发周期 (Period) 或触发源 
(Trigger)。 

9. 按此旋钮或辅助键以固定该设置值。 

10.对所有参数重复步骤 6 至 9。 

如果要详细设置触发参数，可选择 MANUAL 触发类型并使用通过按 Trigger > 
Config 功能键打开的 Trigger Configuration 对话框。请参见第 138 页上的
“Trigger 键组”。

设置源等待时间

有关此功能的详细信息，请参见第 194 页上的 “测量时间”和第 132 页上的
“Wait Control 对话框”。 

1. 按 Config > Common > Wait 功能键。 

即会打开 Wait Control 对话框。 

2. 设置 Source 列中的每个参数。

3. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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设置输出滤波器

有关此功能的详细信息，请参见第 200 页上的 “输出滤波器”和第 128 页上的
“Output Filter 对话框”。 

1. 按 Config > Source > Filter 功能键。 

即会打开 Output Filter 对话框。 

2. 设置每个参数。

3. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置连接类型

有关此功能的详细信息，请参见第 81 页上的 “二线制连接或四线制连接”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Sensing Type 字段中设置 2-WIRE 或 4-WIRE。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置低电平端子状态

有关此功能的详细信息，请参见第 82 页上的 “浮动”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Low Terminal State 字段中设置 GROUNDED 或 FLOATING。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
174 Keysight B2900B/BL 系列用户指南，第 2 版



前面板操作
设置源输出
启用或禁用高电容模式

有关此功能的详细信息，请参见第 204 页上的 “高电容模式”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 High Capacitance Mode 字段中设置 ON （启用）或 OFF （禁用）。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

启用或禁用过电压 / 电流保护

有关此功能的详细信息，请参见第 201 页上的 “过电压 / 电流保护”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Over Voltage/Current Protection 字段中设置 ON （启用）或 OFF （禁用）。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

指定输出关闭状态

有关此功能的详细信息，请参见第 202 页上的 “输出关闭状态”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Output-Off State 对话框中设置 HIGH Z（高阻抗）、 NORMAL（正常）或 
ZERO （零伏）。 

4. 要应用设置，按 Apply。 
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要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

启用或禁用自动输出打开功能

有关此功能的详细信息，请参见第 203 页上的 “自动输出打开 / 关闭功能”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Auto Output-On 字段中设置 ON （启用）或 OFF （禁用）。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

启用或禁用自动输出关闭功能

有关此功能的详细信息，请参见第 203 页上的 “自动输出打开 / 关闭功能”。

1. 按 Config > Source > Connection 功能键。 

即会打开 Output Connection 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Auto Output-Off 字段中设置 ON （启用）或 OFF （禁用）。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置扫描源的量程模式

有关此功能的详细信息，请参见第 193 页上的 “调整量程模式”。 

1. 按 Config > Source > Sweep 功能键。 

即会打开 Sweep 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 
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3. 在 Sweep Ranging 字段中设置 BEST、 AUTO 或 FIXED。有关详细信息，请参
见第 130 页上的 “Sweep 对话框”。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置扫描方向

1. 按 Config > Source > Sweep 功能键。 

即会打开 Sweep 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Sweep Direction 字段中设置 UP 或 DOWN。有关详细信息，请参见第 130 
页上的 “Sweep 对话框”。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置扫描后的源输出值

1. 按 Config > Source > Sweep 功能键。 

即会打开 Sweep 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Output after Sweep 字段中设置 START VALUE 或 END VALUE。有关详细信
息，请参见第 130 页上的 “Sweep 对话框”。 

4. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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执行测量

本节介绍以下测量操作。 

• “启用电阻测量”

• “设置测量模式”

• “执行点测量”

• “停止测量”

• “设置测量时间”

• “设置测量量程”

• “执行扫描测量”

• “设置测量触发参数”

• “设置测量等待时间”

• “设置测量自动量程操作”

• “启用或禁用电阻补偿”

启用电阻测量

1. 按 View 键以显示 Single 视图。如果未显示 Range 参数，请按 Hide XXXX 辅
助键。

2. 将字段指针移动到 Measure Ohms （电阻测量量程）字段。如果此字段设置
为 OFF，则已启用电阻测量。

3. 按此旋钮可使指针状态变为 EDIT。

4. 按 AUTO、 FIXED 或 V/I 辅助键可设置电阻测量操作。指针状态将变为 
MOVE。

有关电阻测量操作的详细信息，请参见第 113 页上的 “量程参数”。

要不间断地设置测量量程，请参见第 180 页上的 “设置测量量程”。
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设置测量模式

1. 对于 Single 视图，请按 Measure 辅助键。对于 Dual 视图，请按 Ch1 Measure 
或 Ch2 Measure 辅助键。 

2. 要测量电流、电压、电阻或功率，请分别按 AMPS (I)、VOLTS (V)、OHMS (R) 
或 WATTS (P)。 

执行点测量

1. 设置测量模式 （请参见第 179 页上的 “设置测量模式”）。 

2. 设置输出电压或电流 （请参见第 169 页上的 “施加 DC 电压 / 电流”）。

3. 按通道 1 或通道 2 （Ch1 或 Ch2）的 On/Off 开关。 

通道即开始输出指定的电压 / 电流。开关变为绿色，通道继续输出并在值更
改时立即更改。 

4. 按 Trigger 键。 

随即执行单点测量。 

要更改 Limit 值，请参见第 169 页上的 “设置 Limit (Compliance) 值”。 

停止测量

1. 按通道 1 或通道 2 （Ch1 或 Ch2）的 On/Off 开关，关闭开关。 

相应通道即会停止源输出和测量。

设置测量时间

有关此功能的详细信息，请参见第 194 页上的 “测量时间”和第 112 页上的
“速度”。 

1. 按 View 键以显示 Single 视图。 

2. 按 Speed 辅助键。 

3. 按 AUTO、 SHORT、 MEDIUM、 NORMAL、 LONG 或 MANUAL 辅助键以设置
测量时间。

4. 指定 MANUAL 时，会显示孔径时间设置字段和 PLC 设置字段。在任一字段中
输入并固定一个值，以设置测量时间。
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设置测量量程

有关此功能的详细信息，请参见第 193 页上的 “调整量程模式”和第 113 页上
的 “量程参数”。

1. 按 View 键以显示 Single 视图。如果未显示 Range 参数，请按 Hide XXXX 辅
助键。

2. 将字段指针移动到 Measure Volts （电压测量量程）、 Measure Amps （电流
测量量程）或 Measure Ohms （电阻测量量程）字段。 

3. 按此旋钮可使指针状态变为 EDIT。 

4. 按 AUTO 设置自动量程操作，或者按 FIXED 设置固定量程操作。指针状态将
变为 MOVE。 

5. 将字段指针移动到量程值设置字段（位于 Measure Volts、 Measure Amps 或 
Measure Ohms 字段的右侧）。 

6. 按此旋钮可使指针状态变为 EDIT。 

7. 按辅助键设置以下值。 

对于自动量程操作：量程操作的最小量程

对于固定量程操作：用于测量的量程

执行扫描测量

有关此功能的详细信息，请参见第 198 页上的 “扫描输出”。

1. 按 View 键以显示 Single 视图。 

2. 设置源功能 （请参见第 169 页上的 “设置源输出模式”）。 

3. 设置 Source 值和 Limit (Compliance) 值 （请参见 “施加 DC 电压 / 电流”和
第 169 页上的 “设置 Limit (Compliance) 值”）。 

4. 设置测量模式 （请参见第 179 页上的 “设置测量模式”）。 

5. 设置扫描源 （请参见第 171 页上的 “设置扫描输出”）。 

6. 按 View 键以显示 Graph 视图。 

7. 按通道 1 或通道 2 （Ch1 或 Ch2）的 On/Off 开关。 

通道即开始输出指定的电压 / 电流。开关变为绿色，通道继续输出并在值更
改时立即更改。 
180 Keysight B2900B/BL 系列用户指南，第 2 版



前面板操作
执行测量
8. 按 Trigger 键。 

即会执行扫描测量，测量结果将显示在图形上。 

设置测量触发参数

有关此功能的详细信息，请参见第 216 页上的 “触发系统”和第 118 页上的
“触发参数”。 

1. 按 View 键以显示 Single 视图。 

2. 按 Show Trigger 辅助键以显示 Trigger 参数。

3. 将字段指针移动到 Trigger 字段。 

4. 按此旋钮可使指针状态变为 EDIT。 

5. 按 AUTO、SYNC、TIMER 或 MANUAL 辅助键以设置触发类型。指针状态将变
为 MOVE。 

6. 将字段指针移动到触发参数设置字段 （Measure 列中的 Count、 Delay、
Period 或 Trigger）。 

7. 按此旋钮可使指针状态变为 EDIT。 

8. 输入触发计数 (Count)、触发延迟时间 (Delay)、触发周期 (Period) 或触发源 
(Trigger)。 

9. 按此旋钮或辅助键以固定该设置值。 

10.对所有参数重复步骤 6 至 9。 

如果要详细设置触发参数，可选择 MANUAL 触发类型并使用通过按 Trigger > 
Config 功能键打开的 Trigger Configuration 对话框。请参见第 138 页上的
“Trigger 键组”。

设置测量等待时间

有关此功能的详细信息，请参见第 194 页上的 “测量时间”和第 132 页上的
“Wait Control 对话框”。 

1. 按 Config > Common > Wait 功能键。 

即会打开 Wait Control 对话框。 

2. 设置 Measure 列中的每个参数。
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3. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置测量自动量程操作

有关此功能的详细信息，请参见第 131 页上的 “Ranging 对话框”。

1. 按 Config > Measure > Ranging 功能键。

即会打开 Ranging 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Current Auto Ranging 字段中，设置电流测量自动量程操作 （NORMAL、
SPEED 或 RESOLN）。 

另外，在 Threshold 字段中，设置自动量程操作的阈值。 

4. 在 Voltage Auto Ranging 字段中，设置电压测量自动量程操作 （NORMAL、
SPEED 或 RESOLN）。 

另外，在 Threshold 字段中，设置自动量程操作的阈值。 

5. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

启用或禁用电阻补偿

1. 按 Config > Measure > R Compen 功能键。 

2. 对于 2 通道型号，使用以下功能键指定要应用设置更改的通道。 

ALL：通道 1 和 2 （Ch 1 和 Ch 2）

Ch 1：仅通道 1 (Ch 1)

Ch 2：仅通道 2 (Ch 2)

3. 要启用电阻补偿，请按 ON。 
要将其禁用，请按 OFF。 
要取消设置更改，请按 Cancel/Local 键。
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使用数学运算功能

此部分介绍如何使用数学功能。有关此功能的详细信息，请参见第 206 页上的
“数学表达式”。另外，有关这些设置参数的详细信息，请参见第 133 页上的
“Math Expression 对话框”。 

1. 按 Function > Math 功能键。 

即会打开 Math Expression 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Status 字段中，将数学函数设置为 ON 或 OFF。 

4. 在 Unit String 字段中，输入计算结果数据的单位。 

要输入字母，请按 ABC 辅助键，然后按数字 / 字母键。 

要输入数字，请按 123 辅助键，然后按数字 / 字母键。 

要删除某个字符，突出显示要删除的字符，然后按 Delete 功能键。 

要插入某个字符，请突出显示位于字符插入位置的字符，然后按 Insert 功 
能键。 

5. 选择要使用的数学表达式。 

要选择数学表达式，在 Unit String 字段下方的列表区中突出显示数学表达式
的名称。 

6. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 
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执行限值测试

此部分介绍如何设置限值测试以及如何显示限值测试的结果。有关此功能的详细
信息，请参见第 209 页上的 “Limit Test”。 B2901BL 不能进行限值测试。

要执行限值测试，请设置复合限值测试、单项限值测试和源输出及测量条件，然
后按 Trigger 键。 

• “设置复合限值测试”

• “设置单项限值测试”

• “显示限值测试结果”

设置复合限值测试

有关这些设置参数的详细信息，请参见第 134 页上的 “Composite Limit Test 
Setup 对话框”。 

1. 按 Function > Limit Test > Composite 功能键。 

即会打开 Composite Limit Test 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Limit Test 字段中，将复合限值测试设置为 ON 或 OFF。 

4. 在 Mode 字段中，将操作模式设置为 GRADING 或 SORTING。 

5. 在 Auto Clear 字段中，将自动清除复合限值测试结果设置为 ON 或 OFF。 

6. 当操作模式为 GRADING 时，在 Update 字段中将测试结果输出时间设置为 
IMMEDIATE （每次测试后）或 END （最后一次测试后）。 

7. 在 Offset Cancel 字段中，将偏移取消设置为 ON 或 OFF。 

8. 在 Offset 字段中，设置用于偏移取消的偏移值。 

9. 当操作模式是 GRADING 时，在 Pass Pattern 字中设置表示限值测试通过状态 
(Pass) 的位模式。 

10.当操作模式是 SORTING 时，在 Fail Pattern 字中设置表示限值测试失败状态 
(Fail) 的位模式。 

11.在 /BUSY 字段中，设置用于 BUSY 信号输出的 DIO 针脚号。 

12.在 /SOT 字段中，设置用于测试开始 (SOT) 信号输出的 DIO 针脚号。 
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13.在 /EOT 字段中，设置用于测试结束 (EOT) 信号输出的 DIO 针脚号。 

14.要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

设置单项限值测试

有关这些设置参数的详细信息，请参见第 135 页上的 “Limit Test Setup 对话
框”。

1. 按 Function > Limit Test > Limits 功能键。 

即会打开 Limit Test Setup 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Feed Data 字段中，设置用于判断限值测试通过 / 失败的数据类型。 

MATH：数学表达式的计算结果数据

VOLTS：电压测量数据 (Vmeas)

AMPS：电流测量数据 (Imeas)

OHMS：电阻数据 (= Vmeas/Imeas)

4. 在 Test Index 字段中，在编号 1 和 12 之间设置限值测试的索引。 

索引编号 1 至 12 与二进制编号 1 至 12 相关联。请参见第 187 页上的 “显示
限值测试结果”。 

5. 在 Limit Test 字段中，将由 Test Index 标识的测试的限值测试设置为 ON 或 
OFF。 

6. 在 Function 字段中，将测试模式设置为 COMPLIANCE （合规性检查）或 
LIMIT （限值测试）。 

7. 当操作模式是 SORTING 时，在 Pass Pattern 字中设置表示限值测试通过状态 
(Pass) 的位模式。 

8. 当测试模式是 COMPLIANCE 时，配置以下设置：

• 在 Fail on 字段中，将失败判断方法设置为 IN 或 OUT。 

IN：如果通道进入合规状态，则失败。 

OUT：如果通道退出合规状态，则失败。 
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• 在 Fail Pattern 字段中，设置表示限值测试失败状态 (Fail) 的位模式。 

9. 当测试模式是 LIMIT，并且操作模式是 GRADING 时，请配置以下设置：

• 在 Up Pattern 字段中，设置表示 failed-by-exceeding-upper-limit （超出
上限而失败）状态的位模式。 

• 在 Low Pattern 字段中，设置表示 failed-by-exceeding-lower-limit （超出
下限而失败）状态的位模式。 

• 在 Up Limit 字段中，设置通过 / 失败判断的上限。 

• 在 Low Limit 字段中，设置通过 / 失败判断的下限。 

10.要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

有关在限值测试的通过 / 失败判断中使用 MATH 的信息，请参见第 183 页上的
“使用数学运算功能”。 

要使用电阻补偿，请参见第 182 页上的 “启用或禁用电阻补偿”。 
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显示限值测试结果

有关这些设置参数的详细信息，请参见第 142 页上的 “Limit Test Result 对话
框”。

1. 按 Result > Limit Test 功能键。 

即会打开 Limit Test Result 对话框。 

2. 在 Ch 字段中，为要显示的数据设置通道。 

限值测试结果显示在 Length 字段下方的区域中。 

3. 按 OK 关闭对话框。 

Length 字段显示数据的条数。 

在 Length 字段下方的区域中，按以下格式显示限值测试结果： 

(aaaaa) BIN: bb  DATA: +c.ccccccE+ddd

(aaaaa) 数据索引 aaaaa

BIN： 二进制编号 bb（01 至 12）

二进制编号 1 至 12 与索引编号 1 至 12 相关联。请参见第 185 
页上的 “设置单项限值测试”。 

如果限值测试数据超出二进制编号范围，则对 GRADING 模式
设置 00，对 SORTING 模式设置 15。 

DATA： 限值测试数据 +c.ccccccE+ddd
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使用迹线缓冲区

此部分介绍如何设置迹线缓冲区和如何显示统计数据。有关此功能的详细信息，
请参见第 212 页上的 “迹线缓冲区”。 

要使用迹线缓冲区，请设置迹线缓冲区及源输出和测量条件，然后按 Trigger 键。 

• “设置迹线缓冲区”

• “显示统计数据”

设置迹线缓冲区

有关这些设置参数的详细信息，请参见第 136 页上的 “Trace Buffer Setup 对话
框”。

1. 按 Function > Trace 功能键。 

即会打开 Trace Buffer Setup 对话框。 

2. 在 Ch 字段中，设置要应用设置更改的通道。 

3. 在 Feed Data 字段中，设置 SENSE （采集测量结果数据）、 MATH （采集计
算结果数据）或 LIMIT （采集限值结果数据）。 

4. 在 Buffer Control 字段中，设置 NEXT （为迹线缓冲区启用写操作）或 NEVER
（为迹线缓冲区禁用写操作）。 

5. 在 Buffer Size 字段中，设置迹线缓冲区的大小 （对于 2901BL 以外的型号为 
1 至 100000，或者对于 B2901BL 为 1 至 10000）。 

6. 要应用设置，按 Apply。 

要应用这些设置并关闭对话框，按 OK。 

要取消设置更改，请按 Cancel/Local 键。 

要指定要采集的测量结果数据 (SENSE)，请使用第 147 页上的 “Format 
(Measure) 对话框”。 

要指定要采集的计算结果数据 (MATH) 或限值测试结果数据 (LIMIT)，请使用第 
148 页上的 “Format (Math/Limit) 对话框”。 
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要更改要在迹线缓冲区中保存的统计数据，请使用第 148 页上的 “Format 
(Trace) 对话框”。 

显示统计数据

有关这些设置参数的详细信息，请参见第 143 页上的 “Trace Statistical Result 
对话框”。

1. 按 Result > Trace 功能键。 

即会打开 Trace Statistical Result 对话框。 

2. 在 Ch 字段中，为要显示的数据设置通道。 

3. 在 Element 字段中，将统计计算的数据类型设置 SOURCE （源输出数据）、
VOLTS （电压测量数据）、 AMPS （电流测量数据）、 OHMS （电阻测量 
数据）。 

在此指定的数据的统计数据显示在 Length 字段下方的区域中。 

4. 按 OK 关闭对话框。 

Length 字段显示数据的条数。 

统计数据显示在以下字段中： 

Mean：平均值

Std.Dev.：标准差

Min.：最小值

Max.：最大值
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使用程序存储器

此部分介绍如何选择和运行存储器程序。有关此功能的详细信息，请参见 
第 214 页上的 “程序存储器”。 

另请参见第 145 页上的 “Program 键组”。 

• “选择程序”

• “操作程序操作”

选择程序

1. 按 More > Program > Catalog 功能键。 

即会打开 Program Catalog 对话框。 

2. 突出显示要运行的存储器程序的名称。 

3. 按 OK。 

要为存储器程序中使用的变量设置一个值，请使用 Variable 对话框。有关详细信
息，请参见第 145 页上的 “Program 键组”。 

操作程序操作

1. 按 More > Program > Control 功能键。 

2. 使用以下键来控制存储器程序的操作。 

Run 开始执行指定的存储器程序。 

Pause 暂停执行存储器程序。 

Step 启动指定存储器程序的步骤执行。 

Stop 停止执行存储器程序。 

Continue 继续执行当前暂停的存储器程序。 
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限值 / 合规性
限值 / 合规性 

限值 / 合规性是输出限制器，可防止由于过电流或过电压对测试设备造成损坏。
电压合规性用于电流输出通道，电流合规性用于电压输出通道。

当通道达到合规性时，通道将作为恒定电压源或恒定电流源。在达到合规性时，
此通道可保留输出值。

可使用与输出电流或输出电压相同的分辨率和精度来设置合规性。

设置合规性

在设置合规性时，必须注意以下几点。

• 最小合规性值受到如下限制。

• 电流合规性

量程的 1% （在 100 nA 量程中）

1 nA （在 10 nA 量程中）

• 电压合规性

20 mV （在 0.2 V 量程中）

• 如果电流合规性值太低，则 SMU 将需要较长的稳定时间。

• 正负合规性值可以单独设置。请参见第 152 页上的 “Display Preference 对话
框”。
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调整量程模式

可将以下调整量程模式用于执行源输出或测量。

• FIXED （固定量程）

通道仅使用指定的量程。

• AUTO （自动量程）

通道自动使用为源输出值或测量值提供最佳分辨率的量程。可使用它为自动
量程操作指定有效的最小量程。

• BEST （最佳，仅适用于扫描源通道）

在线性扫描模式中，通道会自动使用覆盖整个扫描输出的最小量程。

在日志扫描模式中，通道会自动使用为每个扫描步骤输出提供最佳分辨率的
量程。

设置调整量程模式

在设置调整量程模式时，必须注意以下几点。

• 测量通道不使用高于覆盖 Limit (Compliance) 值的最小量程的量程。

• 脉冲源通道使用固定量程进行测量。如果设置了 FIXED 以外的量程调整模
式，则通道自动使用覆盖 Limit (Compliance) 值的最小量程。

• 对于源端测量，通道使用当前输出量程。

• 要设置 DC （恒定）源或测量通道的调整量程模式，请参阅第 113 页上的
“量程参数”。

• 要设置扫描源通道的调整量程模式，请参阅第 130 页上的 “Sweep 对话
框”。

• 要设置用于测量的自动调整量程操作的详细信息，请参阅第 131 页上的
“Ranging 对话框”。
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测量时间 

测量时间取决于孔径时间、测量量程和其他测量条件，可使用以下公式表示：

测量时间 = 孔径时间 + 额外时间

孔径时间是测量所需的时间，不包括如量程更改或数据补偿等因素，这些是额外
时间。

孔径时间

孔径时间是采集测量数据所需的时间。要进行精确而可靠的测量，必须增加孔径
时间。

可使用 Single 视图中的 Measure Speed 参数设置孔径时间。请参见第 112 页上
的 “速度”。

额外时间

额外时间是改变量程等所需的时间。此时间取决于测量条件，无法指定。额外时
间的主要元素包括：

• 测量过程中的量程更改时间 （当测量调整量程模式设置为 AUTO 时）

• 测量开始时量程更改时间 （当测量量程小于合规性值时）

控制源 / 测量定时

可使用以下参数控制源输出和测量定时。请参见图 6-1。此图显示扫描输出的示
例。对于偏置输出，仅关注扫描步骤的形状。 

1. Source delay

源延迟时间定义为从触发到源输出开始的时间。
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2. Measure delay

测量源延迟时间定义为从触发到测量开始的时间。

3. Source wait

源等待时间定义为源通道在开始输出之后无法更改输出值的时间。

4. Measure wait

测量等待时间定义为测量通道在开始输出之后无法开始测量的时间。

5. Period

周期是触发间隔。可针对 TIMER 或 MANUAL 触发类型 （触发源）和源输出
和测量操作分别定义它。

图 6-1 源输出和测量定时，扫描输出示例

要设置延迟时间和周期，请参阅第 118 页上的 “触发参数”。

要设置等待时间，请参阅第 132 页上的 “Wait Control 对话框”。

有关触发设置的详细信息，请参阅第 138 页上的 “Trigger 键组”。

Voltage or current

Start value

Previous value

Trigger

:  
Time

Stop value

Source wait (3)

Measure wait (4)

Trigger Trigger

Source delay (1)

Period (5)

(2) (2)

(4)

(3)

(1) (1)

(4)

(3)

(5)

Measure delay (2)
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脉冲输出

源 / 测量单元 SMU 可施加脉冲电压或电流。图 6-2 显示脉冲扫描输出示例。对
于脉冲偏置输出，仅关注脉冲形状。脉冲输出不适用于 B2901BL 和 B2910BL。

控制脉冲输出 / 测量定时

可使用以下参数控制脉冲输出和测量定时。请参见图 6-2。

1. Source delay

源延迟时间定义为从触发到源输出开始的时间。

2. Measure delay

测量源延迟时间定义为从触发到测量开始的时间。

3. 脉冲延迟

脉冲延迟时间定义为从源输出开始到脉冲 （峰）输出开始的时间。

4. Source wait

源等待时间定义为源通道在脉冲的后沿之后无法更改输出值的时间。

5. Measure wait

测量等待时间定义为测量通道在脉冲的后沿之后无法开始测量的时间。

6. 脉冲宽度

脉冲宽度是从脉冲输出开始到脉冲 （峰）输出结束的时间。然而，它严格定
义为从前沿的 10% 的峰值电平到后沿的 90% 的峰值电平的时间。可用值为 
50 s 至 100000 s。
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图 6-2 脉冲输出和测量定时，扫描输出示例

要设置延迟时间，请参阅第 118 页上的 “触发参数”。

要设置脉冲延迟时间和脉冲宽度，请参阅第 117 页上的 “脉冲参数”。

要设置等待时间，请参阅第 132 页上的 “Wait Control 对话框”。

有关触发设置的详细信息，请参阅第 138 页上的 “Trigger 键组”。

设置脉冲输出

在设置脉冲输出时，必须注意以下几点。

• 脉冲基值由 Single 或 Dual 视图中的 Source 值设置。

• 脉冲峰值由 Single 视图设置。

为脉冲偏置输出设置第 117 页上的 “脉冲参数”的峰值。

或为脉冲扫描输出设置第 114 页上的 “扫描参数”开始、停止和点值。

Voltage or current

Previous value

Trigger

:  
Time

Stop value

 (3)

Trigger

Pulse width (6)

Trigger

Start value

Source delay (1)

Source wait (4)

(1)

(2)

(3)

(6)

(1)

(3)

(6)

(2)

Measure wait (5)

Measure delay (2)

(4)

(5)

(4)

(5)
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扫描输出

源 / 测量单元 SMU 可施加扫描电压或电流。它支持多种扫描输出形状，如图 6-3 
所示。 SMU 不仅执行扫描输出，而且还为图 6-1 和 6-2 所示的每个扫描步骤执
行测量。

图 6-3 扫描输出的多样化

设置扫描输出

在设置扫描输出时，必须注意以下几点。

• 要设置阶梯扫描源，请参阅第 114 页上的 “扫描参数”。 

• 要设置扫描源的调整量程模式，请参阅第 130 页上的 “Sweep 对话框”。 

• 要设置扫描方向，请参阅第 130 页上的 “Sweep 对话框”。 

• 要设置扫描之后的输出条件，请参阅第 130 页上的 “Sweep 对话框”。 

• 要设置脉冲延迟时间和脉冲宽度，请参阅第 117 页上的 “脉冲参数”。 

• 要设置列表扫描源，请参阅第 114 页上的 “列表扫描设置”。 

DC 

DC 

DC 

DC 
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列表扫描

列表扫描功能可有效地执行任意波形输出。源 / 测量单元 SMU 可应用如图 6-4 
所示的波形，并测量每个输出值处的电压或电流。可按以下最小间隔执行源输出
和测量。

• B2901BL： 200 s

• B2910BL：50 s

• B2901B 和 B2902B：20 s

• B2911B 和 B2912B：10 s

源输出和测量定时由触发系统控制。如果触发类型设置为 TIMER，则可将间隔设
置为常数值。 

要设置这些触发参数，请参阅第 118 页上的 “触发参数”。间隔可由 Period 参
数设置。输出值的数量可由 Count 参数设置。

要设置源输出值，请使用 List Sweep 对话框。请参见第 114 页上的 “列表扫描
设置”。

图 6-4 显示了 List Sweep 对话框的示例设置以及输出波形图像。

图 6-4 List Sweep 对话框
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输出滤波器 

该滤波器安装在源 / 测量单元 (SMU) 中。它假定源输出很干净，没有任何尖峰、
噪音或过冲。然而，所有滤波器可能会增加 SMU 稳定时间。

要设置滤波器，请参见第 128 页上的 “Output Filter 对话框”。
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过电压 / 电流保护

过电压 / 电流保护功能可有效地防止由于过电流或过电压而对测试设备造成损
坏。如果启用此功能，则源 / 测量单元 (SMU) 会将输出设置为 0 V，并在它达到
合规性状态时立即自动将输出开关设置为关闭。

要设置过电压 / 电流保护，请参阅第 129 页上的 “Output Connection 对话框”。
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输出关闭状态

输出关闭状态是在源 / 测量单元 (SMU) 输出关闭之后立即自动设置到它的条件。
必须在启用源输出之前指定该状态。可用条件如表 6-1 所示。

要设置输出关闭状态，请参见第 129 页上的 “Output Connection 对话框”。

表 6-1 输出关闭状态

此设置不会应用于由过电压 / 电流保护、联锁打开和过高温度保护等紧急情况触
发的输出关闭过程。这种情况下，会立即将输出电压设置为 0 V，并将输出开关
设置为关闭。 

名称 输出关闭之后的条件

HIGH Z，
高阻抗

• 输出继电器：关闭 （打开或断开）

• 如果源施加 40 V 或更小的电压，则不更改电压源设置。

• 如果源使用 100 mA 量程或更低量程，则不更改电流源 

设置。

NORMAL • 源功能：电压源

• 输出电压：0 V

• 电流合规性：100 A （在 100 A 量程时）

• 输出继电器：关闭 （打开或断开）

ZERO • 源功能：电压源

• 输出电压：0 V

• 电流合规性：100 A （在 100 A 量程时）
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自动输出打开 / 关闭功能

自动输出打开 / 关闭功能定义当触发系统更改状态时，源通道的输出 ON/OFF 
操作。

• 自动打开功能

如果启用此功能，源 / 测量单元 (SMU) 可在 SCPI 命令而不是前面板操作启动
触发系统之前自动打开通道输出。

• 自动关闭功能

如果启用此功能，则 SMU 会在所有触发系统的状态从忙变为空闲时，立即自
动关闭通道输出。

要设置自动输出 ON/OFF 功能，请参阅第 129 页上的 “Output Connection 对话
框”。
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高电容模式

高电容模式可有效地测量大于 0.01 F 的电容负载。 

如果测量结果数据不稳定，则将此功能设置为 ON。测量数据可能稳定。此功能
可有效地测量高达 50 F 的电容设备。 

高电容模式适用于以下源 / 测量条件。

• 操作模式：电压源 (Source Volts) 和电流测量 (Measure Amps)

• 测量调整量程模式：FIXED

• 测量范围：1 A 至 10 A

要设置高电容模式，请参阅第 129 页上的 “Output Connection 对话框”。
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电阻测量

B2900 支持电阻测量。如果测量参数设置为电阻 OHMS (R)，则源 / 测量单元 
(SMU) 将自动设置电流源和电压测量操作，以执行电阻测量。

为了执行准确测量， B2900 提供了补偿功能。 

启用电阻测量

必须指定电阻测量操作。请参见第 113 页上的 “量程参数”和第 178 页上的
“启用电阻测量”。

在初始设置中，电阻测量操作设置为 OFF。

电阻补偿

电阻补偿 (R Compen) 可精确有效地用于执行电阻测量。如果 R Compen 设置为 
ON，此通道将执行两次测量，并返回由以下公式指定的补偿测量结果。此技术
可有效地减小热 EMF。

Rcompen = (V2-V1)/(I2-I1)

其中， V1 是 0 A 源状态下的测量结果， I1 是 0 V 源状态下的测量结果。

要启用电阻补偿，请按 Config > Measure > R Compen > ON 功能键（对于单通道
型号），或按 Config > Measure > R Compen > ALL 或 Ch 1 or Ch2 > ON 功能键
（对于双通道型号）。

要禁用电阻补偿，请按 Config > Measure > R Compen > OFF 功能键 （对于单通
道型号），或按 Config > Measure > R Compen > ALL 或 Ch 1 或 Ch2 > OFF 功能
键 （对于双通道型号）。
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数学表达式

B2900 提供了数学计算功能，以便使用测量结果数据进行计算。将显示计算结
果，并将其用于限值测试和迹线统计信息。

有关预定义的数学表达式，请参阅第 206 页上的 “预定义的数学表达式”。

要定义数学表达式，请参阅 Keysight B2900 SCPI 命令参考。可使用 
:CALC:MATH 命令定义数学表达式。有关可用于表达式的有效资源，请参见 
第 207 页上的 “表达式中使用的资源”。 

要使用数学运算功能，请参阅第 133 页上的 “Math Expression 对话框”。

要显示计算结果，请参阅第 120 页上的 “Graph 视图”和第 141 页上的
“Measure Result 对话框”。

预定义的数学表达式

以下是 B2900 中已定义的数学表达式。预定义的数学表达式不会因为电源关闭和
打开操作而清除。

• 功率 (POWER)

• 偏移补偿欧姆 (OFFCOMPOHM)

• 变阻器 Alpha (VARALPHA)

• 电压系数 (VOLTCOEF)

在以下公式中， [c] 指定用于进行测量的通道 （1 或 2）。

POWER 使用以下公式计算功率。

POWER = VOLT[c] * CURR[c]

OFFCOMPOHM 使用以下公式计算便宜补偿欧姆 （电阻）。

OFFCOMPOHM = (VOLT[c][1]-VOLT[c][0]) / (CURR[c][1]-CURR[c][0])

其中， VOLT[c][0] 和 CURR[c][0] 是使用电流输出电平测得的数据， VOLT[c][1] 和 
CURR[c][1] 是使用不同的电流输出电平或零输出测得的数据。

此功能可有效地减小低电阻测量中的测量误差。
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VARALPHA 使用以下公式计算变阻器 alpha。

VARALPHA = log(CURR[c][1] / CURR[c][0]) / log(VOLT[c][1] / VOLT[c][0])

其中， CURR[c][0] 和 VOLT[c][0] 是变阻器的非线性 I-V 特性曲线上一个点的测量
数据， CURR[c][1] 和 VOLT[c][1] 是另一个点的数据。

VOLTCOEF 使用以下公式计算电压系数。

VOLTCOEF = (RES[c][1]-RES[c][0]) / (RES[c][1] * (VOLT[c][1]-VOLT[c][0])) * 100 %

其中， RES[c][0] 和 RES[c][1] 分别是第一个和第二个测量点的电阻测量数据，
VOLT[c][0] 和 VOLT[c][1] 分别是第一个和第二个测量点的电压测量数据。

电压系数是电阻随着电压变化的电阻器的分数变化的比率。

表达式中使用的资源

以下资源可用于用户定义的数学表达式中。

• 保留变量

表 6-2 中列出的变量是保留用于读取通道输出或测量数据的变量。 

标量变量用于点测量数据。 

矢量 （数组）变量用于扫描测量数据。

• 数学运算符

可使用以下运算符。

• 算术运算符：+、 -、 *、 /、 ^，请参见表 6-3。

• 初等函数：ln、 log、 sin、 cos、 tan、 exp

函数 log 和 ln 在计算绝对值之后执行运算。因此，如果指定负值，它们不会
产生错误，但将其作为正值计算。例如， log(-10) 得到的结果是 log(10)=1。

表 6-2 保留变量

保留变量 a

描述

标量 矢量 

SOUR[c] SOUR[c][] 源输出设置数据

VOLT[c] VOLT[c][] 电压测量数据
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表 6-3 算术和一元运算符

CURR[c] CURR[c][] 电流测量数据

RES[c] RES[c][] 电阻测量数据

TIME[c] TIME[c][] 时间 （时间戳）数据

a. 数字后缀 [c] 用于指定通道。例如，使用 CURR2 读取通道 2 的电流点测量数据。

任务优先级 运算符 描述

高
:
:
:
:
:

低

( ) 括号

+ 和 - 一元加运算符和一元减运算符

^ 取幂运算符

* 和 / 乘运算符和除运算符

+ 和 - 加运算符和减运算符

保留变量 a

描述

标量 矢量 
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Limit Test

限值测试是对由通道获取的测量数据或数学运算结果数据进行的通过 / 失败判
断。如果单个限值测试和复合限值测试都设置为 ON，则可以执行限值测试。最
多可定义 12 个限值测试，并将其用于复合限值测试的二进制。 B2901BL 不能进
行限值测试。

复合限值测试支持以下两种操作模式。

• 分级模式

对最多 12 个测试限值 （二进制）执行限值测试，直到检测到失败为止。有
关示例流程图，请参见图 6-5。

• 排序模式

对最多 12 个测试限值 （二进制）执行限值测试，直到检测到通过为止。有
关示例流程图，请参见图 6-6。

在图中，SOT 表示由通过 Digital I/O 连接器连接到 B2900 的元器件处理程序发送
的测试开始选通脉冲。

要设置复合限值测试，请参阅第 134 页上的 “Composite Limit Test Setup 对话
框”。

要设置单个限值测试，请参见第 135 页上的 “Limit Test Setup 对话框”。

复合限值测试结果 Pass 或 Fail 和测量结果数据一起显示在 Single 或 Dual 视图中。
要显示限值测试结果日志，请参阅第 142 页上的 “Limit Test Result 对话框”。

数学运算结果的限值测试

如果数学表达式引用多个通道的测量结果数据，则通道的采集触发计数必须相同。

如果数学表达式包含矢量运算，则采集触发计数必须等于或大于矢量的最大数。
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图 6-5 分级模式的复合限值测试流程图示例

 SOT

Source  Sense

 X

“PASS”

“FAIL”

Single Dual 

 Zoom  ON  PASS 
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图 6-6 排序模式的复合限值测试流程图示例

 SOT

Source  Sense

 X

“PASS”“FAIL”

Single 

Dual 

 Zoom  ON  PASS 
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迹线缓冲区

迹线缓冲区将收集测试结果数据，直到检测到缓冲区已满为止。对于 B2900
（B2901BL 除外），最大数据大小是每个通道 100,000 块。对于 B2901BL，最大
数据大小是 10,000 块。数据流如图 6-7 所示。一个数据块可以包含多个数据，
如电压测量数据、电流测量数据、电阻测量数据、源输出数据、计算结果数据、
限值测试数据、时间数据和状态数据。可使用 I/O 键组的 Format 键选择这些数
据。请参见第 146 页上的 “I/O 键组”。

有关设置迹线缓冲区，请参阅第 136 页上的 “Trace Buffer Setup 对话框”。

在图 6-7 中，变量表示以下数据。

• VOLT：电压测量数据

• CURR：电流测量数据

• RES：电阻测量数据

• TIME：时间数据 （测量启动触发的时间戳）

• STAT：状态数据或限值测试状态

• SOUR：源输出数据

• CALC：数学 （计算）结果数据或限值测试数据 （= 原始数据 - 偏移数据）

如果数据存储在迹线缓冲区中，则可以计算其统计数据。可计算的统计数据 
如下。

• MEAN：平均值

• SDEV：标准差

• MIN：最小值

• MAX：最大值

• PKPK：峰峰值

VOLT、 CURR 或 RES 数据的统计数据 （PKPK 除外）可以显示在 Trace 
Statistical Result 对话框上。有关显示的数据，请参阅第 143 页上的 “Trace 
Statistical Result 对话框”。

使用外部计算机显示无法在 B2900 屏幕上显示的数据。数据可以保存在连接到前
面板 USB-A 连接器的 USB 存储器中，也可以使用 SCPI 命令读取。
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应在关闭 B2900 之前保存或读取数据。关闭仪器后，迹线缓冲区将被清除。

图 6-7 每个通道的迹线缓冲区的数据流

Sense

 *

MATH

Trace

VOLT
CURR
RES
TIME
STAT
SOUR

CALC
TIME
STAT Offset

CALC
TIME
STAT

VOLT
CURR
RES

CALC
TIME
STAT
SOUR

MEAN
SDEV
MIN
MAX
PKPK

Result > Trace
File > Save > Trace

File >Save > Math

File >Save > Meas
Result > Meas

Result > Meas

File >Save > Limit

Result > Limit

(WATT, MATH)

*  B2901BL
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程序存储器

程序存储器可临时存储命令串。可使用前面板键或在打开 B2900 时自动执行存储
的程序。请参见第 145 页上的 “Program 键组”和第 154 页上的 “Start-up”。
用于控制程序存储器的键显示在表 6-4 中。该表还显示通过按程序控制键更改的
状态。

程序存储器可省去程序执行中的多个过程，如传输命令、检查命令语法以及将命
令转换为内部代码。因此，使用程序存储器可加快程序执行的速度。如果将常用
命令串存储在程序存储器中，则会减少接口 / 计算机活动。

在 B2900 处于远程模式时，可使用 SCPI 命令定义程序存储器。请参阅 Keysight 
B2900 系列 SCPI 命令参考。

• 保存在存储器中的程序的数量：100

• 用于启动自动执行的程序的数量：1

• 存储器总大小：100 KB

• 行的最大长度：256 字节

• 程序名称的最大字符数：32 个，包括字母、数字、连字符和下划线

表 6-4 程序控制键 （功能键）和状态更改

控制键
当前执行状态

正在运行 已暂停 已停止

Run 错误 变为 “正在运行” 变为 “正在运行”

Pause 变为
“已暂停”

已暂停 已停止

Step 错误 变为 “正在运行”
再变为 “已暂停”

变为 “正在运行”
再变为 “已暂停”

Stop 变为
“已停止”

变为 “已停止” 已停止

Continue 错误 变为 “正在运行” 错误
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通道分组

此部分仅适用于双通道型号。此功能用于自动控制通道输出定时，以使该通道在
其他通道执行测量时保持输出。

分组的通道按通道编号的顺序启动源输出，然后同时启动测量，并保持输出，直
到测量完成为止。如果设置了延迟时间和等待时间，则按这些值对此进行调整。

如果解除分组，则通道会独立工作，与其他通道的情况无关。

要启用通道分组，请按 Config > Common > Group > ON 功能键。

要禁用通道分组，请按 Config > Common > Group > OFF 功能键。 

进行通道分组的条件：

• 触发源 （Trigger 值）必须相同。

• 如果触发源设置为 TIMER，则源输出触发 （瞬时操作）的触发周期 （Period 
值）必须相同。如果触发计数 （Count 值）设置为 1，则此条件不适用。

关于等待时间

如果设置了等待时间，则在达到等待时间之前，通道无法开始测量或源输出更
改。有关等待时间，请参见第 132 页上的 “Wait Control 对话框”。

对于分组通道，等待时间从最后源输出通道最后一次更改输出 （DC 输出更改或
从峰值到基极的脉冲电平转换）时开始。
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触发系统

B2900 支持 1999 SCPI 命令参考 中说明的 ARM-TRIGGER 型号。此触发模型的操
作概要如下所述。另请参见图 6-8。

触发系统可以通过按下前面板上的 Trigger 键来启动。

关于触发设置参数，请参见第 118 页上的 “触发参数”和第 139 页上的
“Trigger Configuration 对话框”。

1. 如果触发系统已启动，则移动到 ARM 层。

2. 等待来自 ARM 触发源的 ARM 信号事件。

3. 如果检测到 ARM 事件并且经过 ARM 延迟时间，则移动到 TRIGGER 层。

4. 等待来自 TRIGGER 触发源的 TRIGGER 信号事件。

5. 如果检测到 TRIGGER 事件并且经过 TRIGGER 延迟时间，则执行设备操作。

6. 重复 4 和 5，直到 TRIGGER 计数达到指定计数。然后移动到 ARM 层。

7. 重复 2 到 6，直到 ARM 计数达到指定计数。然后移动到 Idle 层。

此触发模式独立应用于两个设备操作，瞬时 （源输出）和采集 （测量）。这两个
操作可以同时或分别开始。

同样，对于双通道型号，两个通道也可以执行同步操作或异步操作。
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Auto 键

Auto 键将触发系统的操作设置为 AUTO 或关闭。

在 AUTO 状态下，处于 DC 输出状态 （On/Off 开关为 ON）的通道在预定义的触
发条件下执行重复测量 （采集设备操作）。不执行瞬时设备操作。

有关预定义的触发条件，请参见第 -104 页上的 “Auto”。
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图 6-8 B2900 触发系统
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TRIGGER 
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触发源

B2900 支持以下触发源。触发源必须分别设置为 ARM 事件和 TRIGGER 事件。

• AUTO （自动内部， AINT）：最适合当前操作模式的触发源由内部算法自动 
选择。 

• BUS: 远程接口触发命令，例如 GET、 TRIGger 和 *TRG 

• TIMER ( 定时器 , TIMer): 在 Period 字段设置的每个间隔内在内部生成信号

• INT1 或 INT2 （内部）：来自内部总线 1 或 2 的信号

• EXT1、EXT2、EXT3、EXT4、EXT5、EXT6、EXT7、EXT8、EXT9、EXT10、
EXT11、EXT12、EXT13 或 EXT14（外部）：来自 DIO 针脚 n 的信号，它是后
面板上的 Digital I/O D-sub 连接器的 I/O 端口， n=1 至 14

• LAN：LXI 触发

设备操作

B2900 支持以下设备操作。另请参见图 6-9。

• 瞬时设备操作 （源输出）

如果检测到 TRIGGER 事件并且源延迟时间已过，则源通道将启动源输出以应
用一个输出值。

• 采集设备操作 （测量）

如果检测到 TRIGGER 事件并且 Measure 延迟时间已过，则测量通道开始测量
以获取一个测量数据。

同步通道操作 （2 通道型号）

如果按如下所示设置通道，则设备操作将同时启动。

• 同步源输出：

• 触发源设置为相同模式。

• 延迟时间设置为相同值。

• 源触发调整量程模式设置为固定模式。

• 源等待时间控制设置为 OFF。

• 测量等待时间控制设置为 OFF。
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• 测量调整量程模式设置为固定模式。

• 同步测量：

• 触发源设置为相同模式。

• 延迟时间设置为相同值。

• 测量等待时间控制设置为 OFF。

• 测量调整量程模式设置为固定模式。

图 6-9 瞬时和采集设备操作

- -

Source delay

- -

Trigger

Source delay

Measure delay Measure delay

Trigger Trigger

Trigger
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Trigger Output

B2900 可按图 6-8 中所示的触发输出 时间输出触发。可从以下端子中选择触发输
出端子。

• 内部总线、 INT1、 INT2

• LAN 端口

• 数字 I/O 针脚、 EXT1、 EXT2、 EXT3、 EXT4、 EXT5、 EXT6、 EXT7、 EXT8、
EXT9、 EXT10、 EXT11、 EXT12、 EXT13、 EXT14

可使用第 139 页上的 “Trigger Configuration 对话框”来设置触发输出。触发输
出时间和设置参数如表 6-5 所示。

表 6-5 触发输出定时和设置参数

要使用数字 I/O 针脚，需要设置针脚的功能、输出触发极性、类型、脉冲宽度和 
Output Trigger Timing 参数。请参见第 149 页上的 “DIO Configuration 对话框”
和第 100 页上的 “使用 Digital I/O”。

触发输出定时 Layer Action
Trigger 
Output

输出触发
定时

开始 ARM 循环 ARM TRANS. （对

于瞬时操
作）或者 

ACQ. （对于

采集操作）

ON BEFORE

结束 ARM 循环 ARM ON AFTER

开始 TRIGGER 循环 TRIGGER ON BEFORE

结束 TRIGGER 循环 TRIGGER ON AFTER

开始瞬时设备操作 ACTION TRANS. ON BEFORE

结束瞬时设备操作 ACTION TRANS. ON AFTER

开始采集设备操作 ACTION ACQ. ON BEFORE

结束采集设备操作 ACTION ACQ. ON AFTER
Keysight B2900B/BL 系列用户指南，第 2 版 221



功能详细信息
文件访问功能 (Easy File Access)
文件访问功能 (Easy File Access)

文件访问功能使用 MTP （媒体传输协议）将 B2900 文件 （测量数据、仪器设置
和屏幕图像）轻松下载到您的 PC。此功能不适用于 B2901BL 和 B2910BL。

要使用此功能，请执行下列步骤。

1. 在通过按 More > IO > USB 打开的 USB Status 对话框中，将 Easy File Access 
字段设置为 ON。 

更改设置需要重新启动 B2900。

2. 使用配备的 USB 线缆将 B2900 连接至您的 PC。

第一次执行此操作时，会安装驱动程序。对于后续插件，您的 PC 屏幕上将弹
出一个 AutoPlay 对话框，然后您就能够打开设备以访问存储在 B2900 内部存
储器以及连接到 B2900 的 USB 存储器中的文件。在您 PC 的文件系统上，
B2900 将显示为可读写驱动器，内部存储器和外部 USB 存储器将显示为该驱
动器的子设备。

有关详细信息，请参阅内存根文件夹中的 Readme.html。

要使用 PC 控制 B2900，必须安装 Keysight IO Libraries Suite 或等同产品。当然，
如果您不进行远程控制，或者如果您以手动方式使用文件访问功能，则不需要。
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联锁功能

联锁功能设计为防止用户在接触测量端子时发生电击。如果联锁端子已打开，则
最大输出限制为 42 V。

要执行超过 42 V 的高电压测量，请将联锁端子连接到测试夹具或屏蔽盒的联锁
电路。联锁电路必须有一个 LED 和两个机械开关连接在一起，并安装在屏蔽盒开
门附近。有关安装联锁电路的详细信息，请参见第 90 页上的 “安装联锁电路”。

联锁功能的工作原理如下所述。

• 联锁端子打开时，最大输出限制为 42 V。

• 联锁端子短接时，源通道可应用其最大输出值。

• 如果在大于 42 V 的高压状态下打开联锁端子，则将输出电压立即设置为 0，
并将输出开关设置为关闭。 

当源 / 测量端子可接触或打开时，打开联锁端子， SMU 便无法施加危险电压。

Ouvrir la borne de verrouillage afin que le délivreur de tension ne puisse pas 
appliquer de tension dangereuse lorsque la borne source/de mesure est à portée 
de main ou ouverte.
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过温保护

过温保护将生效，防止通道由于过温而受到损坏。如果在温度超过 30 C 的环境
中使用 B2900，则通道输出将限制为小于最大值的值。如果通道输出达到此限
值，所有通道会立即自动将输出设置 0 V 并将输出开关设置为关闭。并且会自动
锁定空闲通道。

要解除通道锁定，必须执行自检。如果自检没有报告任何问题，则很快可以使用
通道。要执行自检，请参见第 78 页上的“自检”。

超过 30 C 的条件下，最大输出小于在 23 C  5 C 的指定条件下的最大输出。
使用以下公式可计算出通道的输出限值。

DCMAX  ( [ ( PCS + 30 - TAMB) - |VOAB  IB| ] / |VOAP  IP| )2  100

参数说明如下。

• DCMAX：以百分比表示的允许的最大占空比，对于 DC 偏置输出为 0

• PCS：最大功率， 64 W

• TAMB：环境温度，以 C 表示

• VOAB = 250 V，对于 |IB|  105 mA

VOAB = 39 V，对于 |IB| > 105 mA 和 |VB| > 6V

VOAB = 21 V，对于 |IB| > 105 mA 和 |VB|  6V

VB：脉冲基本电压设定值，或 DC 偏置电压设定值，以 V 表示

• IB：脉冲基线处的电流或 DC 电流，以 A 表示

• VOAP = 250 V，对于 |IP|  105 mA

VOAP = 39 V，对于 |IP| > 105 mA 和 |VP| > 6V

VOAP = 21 V，对于 |IP| > 105 mA 和 |VP|  6V

VP：脉冲峰值电压设定值，以 V 表示

• IP：脉冲峰值处的电流，以 A 表示
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初始设置 

B2900 可通过打开 B2900、 *RST 命令或设备清除来进行初始化。此部分介绍了 
B2900 的、初始设置。

表 6-6 系统初始设置

设置项目 电源开启 Reset

GPIO 功能 DIGITAL IN

GPIO 功能 (D14) HIGH VOLTAGE LAMP

GPIO 极性 NEGATIVE

GPIO 输出触发类型 EDGE

GPIO 输出触发定时 BOTH

GPIO 输出触发脉冲宽度 100 s

显示数位 7

缩放的显示 OFF 未更改

显示图像格式 JPG

用户消息启用 禁用

用户消息 “”

字节交换 （测量数据） Normal

数据格式 （测量数据） ASCII

数据格式 （GPIO 数据） ASCII

数据格式 （状态寄存器） ASCII

数据元素 （测量数据） All (V/I/R/S/T/Stat)

数据元素 （计算） CALC

自动时间戳重置 ON
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表 6-7 SMU 初始设置

海量存储目录 （根目录）

程序变量 无 未更改

程序选择 无

程序状态 空闲

设置项目 电源开启 Reset

低端子状态 GROUNDED 未更改

输出状态 OFF

输出自动滤波器启用 ON

输出滤波器启用 ON

输出滤波器时间常数 5 s

输出滤波器频率 31.8309886 kHz

输出 OFF 状态 NORMAL

输出保护 OFF

源模式 VOLTS

源形状 DC

自动输出打开 ON

自动输出关闭 OFF

电压源 0 V

电压保护电平 2 V

电压源自动调整量程 ON

电压源量程 2 V

电压源量程下限 0.2 V

设置项目 电源开启 Reset
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电压源模式 恒定电压

电压扫描点数 1

电压扫描开始 0 V

电压扫描停止 0 V

电压列表点数 1

电压列表值 0 V

电流源 100 A

电流保护电平 100 A

电流源自动调整量程 ON

电流源量程 100 A

电流源量程下限 1 A

电流源模式 恒定电流

电流扫描点数 1

电流扫描开始 0 A

电流扫描停止 0 A

电流列表点数 1

电流列表值 0 A

扫描方向 UP

双扫描 OFF

扫描调整量程 BEST

连续触发源 ON

脉冲延迟 0 s

脉冲宽度 50 s

自动稳定时间 ON

设置项目 电源开启 Reset
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表 6-8 触发系统初始设置

稳定时间 0 s

测量功能 电流测量

自动孔径 ON

孔径时间 0.1 PLC

电压测量量程模式 AUTO

电压测量量程限值 0.2 V

电压测量量程 2 V

电流测量量程模式 AUTO

电流测量量程限值 1 A

电流测量量程 100 A

电阻测量模式 MAN

电阻量程 2 

电阻量程限值 （低） 2 

电阻量程限值 （高） 200 M

电阻测量补偿 OFF

远程感应 OFF

测量自动量程操作 NORMAL

测量自动量程阈值 90

设置项目 电源开启 Reset

ARM 计数 1

ARM 源 AINT

设置项目 电源开启 Reset
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ARM 定时器 200 s，对于 B2901BL
50 s，对于 B2910BL
20 s，对于 B2901B/02B
10 s，对于 B2911B/12B

ARM 延迟时间 0 s

ARM 旁路 OFF

触发计数 1

触发源 AINT

触发计时器 200 s，对于 B2901BL
50 s，对于 B2910BL
20 s，对于 B2901B/02B
10 s，对于 B2911B/12B

触发延迟时间 0 s

触发旁路 OFF

外触发输出 EXT1

外触发输出 (LAN) LAN0-7 （所有）

外触发输出启用 OFF

设置项目 电源开启 Reset
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表 6-9 LXI 触发事件初始设置

设置项目 电源开启 Reset

时间域 0

LAN 事件 “WaitingForAcquireArm1”
“WaitingForTransitionArm1”
“WaitingForAcquireTrigger1”
“WaitingForTransitionTrigger1”
“Measuring1”  
“Settling1”
“WaitingForAcquireArm2”
“WaitingForTransitionArm2” 
“WaitingForAcquireTrigger2”
“WaitingForTransitionTrigger2”
“Measuring2”
“Settling2”

延迟时间 0

输入 / 输出滤波器 

字符串

“ALL:5044”

输入 / 输出状态 OFF

输入检测 RISE

输出驱动器 OFF

输出斜率 正

输出源 “”

输出时间戳差值 0

事件记录 ON

循环事件记录 ON

事件日志大小 100
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表 6-10 计算功能初始设置

设置项目 电源开启 Reset

复合限值测试结果传输定时 IMM

复合限值测试结果自动清除 ON

复合限值测试失败位码型 全部为 0

复合限值测试通过位码型 全部为 0

复合限值测试模式 GRADing

用于位模式输出的 DIO 针脚 无

用于 BUSY 信号输出的 DIO 针脚 无

用于 EOT 信号输出的 DIO 针脚 无

用于 SOT 信号输入的 DIO 针脚 无

限值测试馈送源 VOLTage

合规性检查失败位码型 全部为 0

合规性检查失败条件 IN

限值测试功能 LIM

上限值 +1.0

下限值 -1.0

上限位码型 全部为 0

通过位码型 全部为 0

下限位码型 全部为 0

限值测试启用 OFF

数学函数启用 OFF

数学函数表达式 (VOLT*CURR)

数学函数表达式名称 “POWER”
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表 6-11 非易失性通讯设置

数学函数目录 “POWER” “OFFCOMPOHM”
“VOLTCOEF”
“VARALPHA”

数学函数单位名称 “W”

测试的偏移值 0

偏移值启用 OFF

迹线馈送源 SENSe

迹线控制 NEVer

迹线点数 100000，对于 B2901BL 之外的型号 

10000，对于 B2901BL

迹线统计格式 MEAN

迹线时间戳格式 ABS

设置项目 出厂默认设置

DHCP 已启用

IP 地址 169.254.5.2

子网掩码 255.255.0.0

默认网关 0.0.0.0

从 DHCP 获取 DNS 服务器 已启用

DNS 服务器 0.0.0.0

WINS 服务器 0.0.0.0

Hostname K-B29xxB-nnnnn  或 
K-B29xxBL-nnnnn
B29xxB, B29xxBL：型号编号 

nnnnn：序列号的后缀。

所需的主机名

所需的服务名

设置项目 电源开启 Reset
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表 6-12 其他非易失性设置

mDNS 已启用

使用 DNS 命名服务 已启用

使用 NetBIOS 命名服务 已启用

域名 未设置

GPIB 地址 23

LXI 标识 禁用

GPIB 命令接口 已启用

USB 命令接口 已启用

VXI-11 命令接口 已启用

SCPI telnet 命令接口 已启用

SCPI 套接口命令接口 已启用

SCPI HiSLIP 命令接口 已启用

Web 界面 已启用

Telnet 会话的命令提示 B2900B>

Telnet 会话的欢迎信息 Welcome to Keysight B2900B Series

设置项目 出厂默认设置

通道分组 “1”表示单通道型号

“1-2”表示双通道型号

远程显示 已启用

显示屏颜色集 1

蜂鸣器 已启用

设置项目 出厂默认设置
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图形 Web 界面 （Web 服务器） 已启用

SCPI 语言模式 Default

上电程序 未设置

线路频率 50 Hz

风扇控制模式 Normal

V/I Limit for Each Polarity OFF

Immediate V/I Update by Knob OFF

Restore Trigger Mode on Local OFF

设置项目 出厂默认设置
234 Keysight B2900B/BL 系列用户指南，第 2 版





本信息如有更改，恕不另行通知。
© 是德科技 2023  

第 2 版，2023 年 10 月     

*B2910-92110*
B2910-92110

www.keysight.com


	用户指南
	入门指南
	应用 DC 输出
	执行单点测量
	执行扫描测量
	操作提示
	操作摘要

	简介
	Keysight B2900 系列
	前视图
	后视图
	源/测量单元
	测量参数
	限值/合规性
	输出和测量量程

	操作和功能
	前面板接口
	易于进行键操作
	易于访问源/测量功能

	源/测量功能
	扫描测量
	数字化/采样测量
	数据缓冲区

	程序和接口功能
	编程语言
	程序存储器
	LXI
	USB 文件系统
	Digital I/O 接口


	软件和驱动程序
	附件
	附件
	可用附件

	选件

	安装
	检查装运物品
	检查 Keysight B2900 的运行情况
	检查错误

	安装 Keysight B2900
	安全注意事项
	环境
	连接电源线
	设置电源线频率
	设置日期和时间
	工作台安装
	机架安装
	卸下减震器
	卸下手柄。


	维护
	清洁
	自检
	自我校准
	校准

	连接 DUT
	二线制连接或四线制连接
	浮动
	使用测试引线
	使用 N1295A 测试夹具
	使用 16442B 测试夹具
	保护
	执行低电流测量

	安装联锁电路
	连接到接口
	GPIB/USB 接口
	LAN 接口
	连接到站点 LAN
	查看活动 LAN 状态
	修改 LAN 设置


	通过 LAN 通信
	使用图形 Web 界面
	使用 Telnet
	使用套接字

	使用 Digital I/O
	Digital I/O 连接器的附件


	前面板参考
	硬键和旋钮
	显示屏和辅助键
	Dual 视图
	Single 视图
	量程参数
	扫描参数
	脉冲参数
	触发参数

	Graph 视图
	Roll 视图
	状态信息

	功能键
	Config 键组
	Output Filter 对话框
	Output Connection 对话框
	Sweep 对话框
	Ranging 对话框
	Wait Control 对话框

	Function 键组
	Math Expression 对话框
	Composite Limit Test Setup 对话框
	Limit Test Setup 对话框
	Trace Buffer Setup 对话框

	Trigger 键组
	Trigger Configuration 对话框

	Result 键组
	Measure Result 对话框
	Limit Test Result 对话框
	Trace Statistical Result 对话框

	File 键组
	File Selection 对话框

	Program 键组
	I/O 键组
	数据输入格式
	Format (Measure) 对话框
	Format (Math/Limit) 对话框
	Format (Trace) 对话框
	LAN Configuration 对话框
	DIO Configuration 对话框
	DIO Read/Write 对话框

	Display 键组
	Display Preference 对话框

	System 键组

	前面板操作
	基本操作
	更改字段中的设置
	更改对话框中的设置

	使用测量以外的功能
	设置电源线频率
	恢复出厂状态
	应用初始设置
	设置蜂鸣器
	设置日期和时间
	执行自检
	执行自我校准
	设置开机时的操作
	显示错误消息
	清除错误缓存
	清除时间戳
	设置自动清除时间戳
	显示固件版本
	显示许可证信息
	设置 GPIB 地址
	设置遥控命令集
	设置远程显示模式
	保存/调用所有设置信息
	启用/禁用用于 Easy File Access 的媒体传输协议
	启用/禁用恢复本地状态的触发模式设置的功能
	使用数字指针和旋钮启用/禁用 Source/Limit 实时更新

	设置源输出
	设置源输出模式
	施加 DC 电压/电流
	停止源输出
	设置 Limit (Compliance) 值
	设置输出量程
	设置脉冲输出
	设置扫描输出
	设置列表扫描输出
	设置源输出触发参数
	设置源等待时间
	设置输出滤波器
	设置连接类型
	设置低电平端子状态
	启用或禁用高电容模式
	启用或禁用过电压/电流保护
	指定输出关闭状态
	启用或禁用自动输出打开功能
	启用或禁用自动输出关闭功能
	设置扫描源的量程模式
	设置扫描方向
	设置扫描后的源输出值

	执行测量
	启用电阻测量
	设置测量模式
	执行点测量
	停止测量
	设置测量时间
	设置测量量程
	执行扫描测量
	设置测量触发参数
	设置测量等待时间
	设置测量自动量程操作
	启用或禁用电阻补偿

	使用数学运算功能
	执行限值测试
	设置复合限值测试
	设置单项限值测试
	显示限值测试结果

	使用迹线缓冲区
	设置迹线缓冲区
	显示统计数据

	使用程序存储器
	选择程序
	操作程序操作


	功能详细信息
	限值/合规性
	设置合规性

	调整量程模式
	设置调整量程模式

	测量时间
	孔径时间
	额外时间
	控制源/测量定时

	脉冲输出
	控制脉冲输出/测量定时
	设置脉冲输出

	扫描输出
	设置扫描输出

	列表扫描
	输出滤波器
	过电压/电流保护
	输出关闭状态
	自动输出打开/关闭功能
	高电容模式
	电阻测量
	电阻补偿

	数学表达式
	预定义的数学表达式
	表达式中使用的资源

	Limit Test
	迹线缓冲区
	程序存储器
	通道分组
	触发系统
	触发源
	设备操作
	Trigger Output

	文件访问功能 (Easy File Access)
	联锁功能
	过温保护
	初始设置




